Installation Guide

Installation Guide – SAP NetWeaver Composition Environment 7.1 SP3 on Windows: MaxDB

Productive Edition

Target Audience

- System Administrators
- Technical Consultants

Document version: 1.0 – 11/05/2007
Document History

⚠️ Caution

Before you start the implementation, make sure you have the latest version of this document. You can find the latest version at the following location: [http://www.sdn.sap.com](http://www.sdn.sap.com) > SAP NetWeaver > Composition Environment.

The following table provides an overview of the most important document changes.

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>11/5/2007</td>
<td>Initial Version</td>
</tr>
</tbody>
</table>

2/148 PUBLIC 11/05/2007
# Table of Contents

*Chapter 1*

1. Introduction .................................................. 7
1.1 New Features ................................................. 7
1.2 SAP Notes for the Installation ............................ 9
1.3 Information Available on SAP Service Marketplace ...... 10
1.4 Naming Conventions .......................................... 11

*Chapter 2*

2. Planning ......................................................... 13
2.1 Installation Options Covered by this Guide .............. 13
2.1.1 Standard System ......................................... 14
2.1.2 Distributed System ..................................... 15
2.1.3 High Availability System ................................. 15
2.1.4 Additional Application Server Instance ............... 16
2.1.5 Standalone Host Agent ................................. 17
2.2 Distribution of Components to Disks .................... 18
2.3 SAP System Transport Host ................................ 21
2.4 Running Adobe Document Services on Non-Supported Platforms ........................................ 21
2.5 Installation of Multiple Components in One Database . . . . 22

*Chapter 3*

3. Preparation ....................................................... 25
3.1 Basic SAP System Parameters .............................. 26
3.2 Hardware and Software Requirements .................... 32
3.2.1 Running the Prerequisite Checker in Standalone Mode (Optional) ........................................ 34
3.2.2 Requirements for a Standard System .................. 35
3.2.3 Requirements for a Distributed System ............... 36
3.2.4 Requirements for a High-Availability System ......... 38
3.2.5 Requirements for the Host Agent as a Separate Installation ................................................ 42
3.3 Preparing User Management for an External ABAP System .................................................. 43
3.4 Checking the Windows File System ....................... 46
3.5 Checking the Windows Domain Structure ................. 46
3.6 Reducing the Size of the File Cache ....................... 47
3.7 Required User Authorization for the Installation ....... 47
3.8 Performing a Domain Installation Without Being a Domain Administrator .......................... 49
3.9 Preparing the SAP System Transport Host ............... 51
3.10 Generating the SAP Solution Manager Key ............. 53
3.11 Preparing the Installation DVDs ........................... 54
Chapter 4

Installation ......................................................... 57
4.1 Running SAPInst .............................................. 58
4.2 SAPInst Installation Options ............................... 62
4.3 Installing Additional Components (Optional) .......... 66
4.4 Installing SAP Memory Analyzer (Optional) ............ 68

Chapter 5

Post-Installation ..................................................... 71
5.1 Logging On to the Application Server ..................... 72
5.2 Installing the SAP License ................................... 73
5.3 Configuring the Transport Management System .......... 73
5.4 Configuring the Remote Connection to SAP Support .... 74
5.5 Applying the Latest Kernel and Support Packages ....... 74
5.6 Installing Administration Tools for MaxDB ............... 75
5.7 Secure Sockets Layer Protocol for Database Server Communication ........................................ 77
5.7.1 Installing the SAP Cryptographic Library ............. 77
5.7.2 Generating the Personal Security Environment ...... 79
5.8 Backing Up the MaxDB Database ......................... 81
5.9 Updating the Database Software to the Current Release ......................................................... 81
5.10 Ensuring User Security ....................................... 82
5.11 Post-Installation Steps for the Host Agent ............. 85
5.12 Checking the SAP Java Documentation .................. 86
5.13 CE-Specific Post-Installation Activities ................. 87
5.14 Performing a Full System Backup ....................... 90

Chapter 6

Updating SAP NetWeaver Composition Environment ........ 91

Chapter 7

Additional Information ............................................. 93
7.1 Transporting Self-Developed Software Component Archives (SCA) into the System ................................... 93
7.2 Troubleshooting — Repairing an Inconsistent MaxDB Installation .......................................... 93
7.3 Restarting the MaxDB Server Manually .................... 94
7.4 Restarting the MS SQL Server Manually .................. 95
7.5 Configuration Templates ...................................... 95
7.6 SAP Directories ................................................ 96
7.7 Additional Information About SAPInst ................. 99
7.7.1 Interrupted Installation with SAPInst ................ 99
7.7.2 Performing a Remote Installation with SAPInst (Optional) ................................................... 101
7.7.3 Starting SAPInst GUI Separately (Optional) ......... 102
7.7.4 Entries in the Services File Created by SAPInst .... 104
7.7.5 How to Avoid Automatic Logoff by SAPInst ........ 104
7.7.6 Troubleshooting with SAPInst .......................... 105
| 7.8 | Starting and Stopping the SAP System | 105 |
| 7.9 | SAP System Security on Windows | 106 |
| 7.10 | Automatic Creation of Accounts and Groups | 108 |
| 7.11 | Uninstalling SAP NetWeaver Composition Environment | 110 |
| 7.12 | Deleting an SAP System | 111 |
| **Chapter 8** | **High Availability with Microsoft Cluster Service** | 113 |
| 8.1 | Planning | 114 |
| 8.1.1 | System Configuration in MSCS | 115 |
| 8.1.1.1 | SAP System Components in an MSCS Configuration | 115 |
| 8.1.1.2 | Enqueue Replication Server in an MSCS Configuration | 118 |
| 8.1.2 | Distribution of SAP System Components to Disks for MSCS | 119 |
| 8.1.3 | Directories in an MSCS Configuration | 121 |
| 8.1.4 | IP Addresses in an MSCS Configuration | 122 |
| 8.1.5 | Obtaining IP Addresses for MSCS | 126 |
| 8.2 | Preparation | 128 |
| 8.2.1 | Assigning Drive Letters for MSCS | 128 |
| 8.2.2 | Mapping Host Names to IP Addresses for MSCS | 129 |
| 8.2.3 | Checking the Mapping of Host Names for MSCS | 130 |
| 8.3 | Installation | 131 |
| 8.3.1 | Moving MSCS Groups | 131 |
| 8.3.2 | Rebooting During the Installation or Conversion for MSCS | 132 |
| 8.3.3 | Installing the Central Services Instance (SCS) | 132 |
| 8.3.4 | Configuring the First MSCS Node | 133 |
| 8.3.5 | Installing the Database on the First Node | 134 |
| 8.3.6 | Configuring the Database on the Additional Node | 134 |
| 8.3.7 | Installing the Database Instance | 135 |
| 8.3.8 | Installing the Host Agent on the Additional MSCS Node | 135 |
| 8.3.9 | Configuring the Additional MSCS Node | 136 |
| 8.3.10 | Installing an Enqueue Replication Server | 137 |
| 8.3.11 | Installing the Primary Application Server Instance | 138 |
| 8.3.12 | Installing the Additional Application Server Instance | 139 |
| 8.4 | Post-Installation | 140 |
| 8.4.1 | Post-Installation Checks for Enqueue Replication Server | 141 |
| 8.4.1.1 | Checking the Status of the Enqueue Replication Server with ENSMON | 141 |
| 8.4.1.2 | Monitoring the Lock Table During Failover with ENQT | 142 |
| 8.4.2 | Starting and Stopping the SAP System in an MSCS Configuration | 143 |
1 Introduction

This document explains how to install an SAP NetWeaver Composition Environment system as productive edition.
For more information about SAP NetWeaver Composition Environment, see SAP Community Network at [http://sdn.sap.com] SAP NetWeaver ➔ Composition Environment ➔.

1.1 New Features

Here you can find the new features in this release.

⚠️ Caution
Make sure that you read the release notes for your SAP system. You can find these on SAP Service Marketplace at [http://service.sap.com/releases].

SAP System Installation

<table>
<thead>
<tr>
<th>Area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAPInst</td>
<td>SAPInst has the following new features:</td>
</tr>
<tr>
<td></td>
<td>- The technical terms used for the instances of an SAP system have changed as follows:</td>
</tr>
<tr>
<td></td>
<td>- “Central instance” (CI) is now called “primary application server instance”.</td>
</tr>
<tr>
<td></td>
<td>- “Dialog instance” (DI) is now called “additional application server instance”.</td>
</tr>
<tr>
<td></td>
<td>📌 Note</td>
</tr>
<tr>
<td></td>
<td>The technical terms “Database instance”, “Java central services instance” (SCS), and</td>
</tr>
<tr>
<td></td>
<td>“ABAP central services instance” (ASCS) remain unchanged.</td>
</tr>
<tr>
<td></td>
<td>- “Central system” – meaning an SAP system running on one single host – is now</td>
</tr>
<tr>
<td></td>
<td>called “standard system”.</td>
</tr>
<tr>
<td></td>
<td>- You can now install the host agent separately with SAPInst. There is a new</td>
</tr>
<tr>
<td></td>
<td>installation option Host Agent available under ➔ Software Life-Cycle Options ➔ Additional Preparations ➔.</td>
</tr>
<tr>
<td></td>
<td>The host agent contains all of the required elements for centrally monitoring</td>
</tr>
<tr>
<td></td>
<td>any host with the Alert Monitor or the SAP NetWeaver Administrator. It is</td>
</tr>
<tr>
<td></td>
<td>automatically installed during the installation of all SAP NetWeaver components,</td>
</tr>
<tr>
<td></td>
<td>except TREX.</td>
</tr>
<tr>
<td></td>
<td>You only need to install the host agent separately in the following cases:</td>
</tr>
<tr>
<td></td>
<td>- You want to centrally monitor a host that does not have an SAP component.</td>
</tr>
<tr>
<td></td>
<td>- You want to perform an upgrade to SAP NetWeaver.</td>
</tr>
</tbody>
</table>
## Area | Description
--- | ---
Software Deployment Manager (SDM) | The Software Deployment Manager (SDM) is no longer part of the primary application server instance of a Java-only system. Therefore, there is no longer any technical difference between the primary application server instance and the additional application server instance of a Java-only system. The SAP system directory of both instances is now called J<instance_number>. J<instance_number> no longer exists.

## Area | Description
--- | ---
Usage type EP Core (EPC) | The usage type Enterprise Portal (EP) is divided into the usage types EP Core (EPC) and Enterprise Portal (EP):
- **EP Core (EPC)**
  This usage type contains the core portal capabilities that were available in the former usage type EP. This new usage type provides more flexibility when implementing a portal where the full enterprise portal capabilities, such as knowledge management and collaboration, are not required. It contains the portal, GP, and UWL.
- **Enterprise Portal (EP)**
  This usage type includes Knowledge management, Collaboration, CAF-Core, Visual Composer, Web Dynpro extension, and .NET PDK. Usage type EPC is a prerequisite for usage type EP. If you want to obtain the full capabilities of the former usage type EP, you need both EP Core and EP. The configuration of EPC comprises only portal configuration steps.

### Note
The standalone implementation of the new usage type EPC without usage type EP is currently limited to certain ERP scenarios, as described in the mySAP ERP Master Guide.

## Area | Description
--- | ---
Installation DVDs | You start the installation from the Installation Master DVD for your database.

## Area | Description
--- | ---
SAP JVM | You no longer have to download and install a Java Development Kit (JDK) or Java Runtime Environment (JRE) from another software vendor. SAP delivers its own Java Virtual Machine (JVM) called SAP JVM. This virtual machine is certified and fully compliant with the J2SE 5.0 standard, offering a strong and reliable foundation for the whole SAP Java stack. SAP JVM is available on the Installation Master DVD. SAPinst extracts and installs it automatically when you start the installation.

## Area | Description
--- | ---
Visual Administrator tool integrated in SAP NetWeaver Administrator | SAP NetWeaver Administrator is a brand new solution for monitoring and administering Java systems and their applications. It is a web-based tool for administration, configuration, and monitoring. The Visual Administrator tool is no longer available as a separate tool. It has been integrated in the SAP NetWeaver Administrator.
SAP NetWeaver Administrator offers most of the functions previously available in Visual Administrator, but redesigned for the task-oriented approach of SAP NetWeaver Administrator.
For more information about SAP NetWeaver Administrator, see the SAP NetWeaver Master Guide and SAP Service Marketplace at [http://service.sap.com/nwa](http://service.sap.com/nwa).
### Operating Systems

<table>
<thead>
<tr>
<th>Area</th>
<th>Description</th>
</tr>
</thead>
</table>

### Documentation

<table>
<thead>
<tr>
<th>Area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP Notes</td>
<td>You can now access SAP Notes directly in SAP Service Marketplace from your PDF. Place the cursor on the SAP Note &quot;&lt;number&gt;&quot; and double-click. A separate browser windows opens and the SAP Note is displayed.</td>
</tr>
</tbody>
</table>
| Links to the Internet | You can use the new links in the PDF files of the guides as follows:  
  - Click on the section headings such as New Features to jump back to the table of contents at the beginning of the guide.  
  - Click on an internet link such as [http://service.sap.com](http://service.sap.com) to jump to the corresponding internet page. |

### 1.2 SAP Notes for the Installation

You **must** read the following SAP Notes **before** you start the installation. These SAP Notes contain the most recent information on the installation, as well as corrections to the installation documentation. Make sure that you have the up-to-date version of each SAP Note which you can find in the SAP Service Marketplace at [http://service.sap.com/notes](http://service.sap.com/notes).

#### SAP Notes for the Installation

<table>
<thead>
<tr>
<th>SAP Note Number</th>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>965569</td>
<td>SAP NetWeaver Installation Based On Kernel 7.08: Windows</td>
<td>Windows-specific information about the SAP system installation and corrections to this documentation.</td>
</tr>
<tr>
<td>73606</td>
<td>Supported Languages and Code Pages</td>
<td>Information on possible languages and language combinations in SAP systems</td>
</tr>
<tr>
<td>953763</td>
<td>Installation of SAP NetWeaver Composition Environment 7.1</td>
<td>CE-specific information about the installation and corrections to this documentation.</td>
</tr>
</tbody>
</table>
1.3 Information Available on SAP Service Marketplace

More information is available as follows on SAP Service Marketplace.

<table>
<thead>
<tr>
<th>Description</th>
<th>Internet Address</th>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maintenance Optimizer</td>
<td><a href="http://service.sap.com/solutionmanager">http://service.sap.com/solutionmanager</a></td>
<td>All corrective software packages, including Support Packages (Stacks) for SAP NetWeaver 7.0 (2004s) and subsequent versions, as well as all applications which are based on this software (including SAP Business Suite 2005), released after April 2, 2007, will be available exclusively through the Maintenance Optimizer in SAP Solution Manager.</td>
</tr>
</tbody>
</table>
### General Quick Links

<table>
<thead>
<tr>
<th>Description</th>
<th>Internet Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP Notes</td>
<td><a href="http://service.sap.com/notes">http://service.sap.com/notes</a></td>
</tr>
<tr>
<td>Released platforms and operating systems</td>
<td><a href="http://service.sap.com/platforms">http://service.sap.com/platforms</a></td>
</tr>
<tr>
<td>Release notes</td>
<td><a href="http://service.sap.com/releasenotes">http://service.sap.com/releasenotes</a></td>
</tr>
<tr>
<td>Unicode SAP systems and their availability</td>
<td><a href="http://service.sap.com/unicode">http://service.sap.com/unicode</a></td>
</tr>
<tr>
<td>System sizing (Quick Sizer tool)</td>
<td><a href="http://service.sap.com/sizing">http://service.sap.com/sizing</a></td>
</tr>
<tr>
<td>High availability</td>
<td><a href="http://service.sap.com/ha">http://service.sap.com/ha</a></td>
</tr>
<tr>
<td>SAP Solution Manager</td>
<td><a href="http://service.sap.com/solutionmanager">http://service.sap.com/solutionmanager</a></td>
</tr>
<tr>
<td>SAP GUI Family</td>
<td><a href="http://service.sap.com/sapgui">http://service.sap.com/sapgui</a></td>
</tr>
<tr>
<td>Maintenance Optimizer</td>
<td><a href="http://service.sap.com/solman-mopz">http://service.sap.com/solman-mopz</a></td>
</tr>
</tbody>
</table>

### 1.4 Naming Conventions

In this documentation, the following naming conventions apply:

**Terminology**

- **SAP system** refers to SAP NetWeaver CE 7.1.

**Variables**

<table>
<thead>
<tr>
<th>Variables</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;SAPSID&gt;</td>
<td>SAP system ID in uppercase letters</td>
</tr>
<tr>
<td>&lt;sapid&gt;</td>
<td>SAP system ID in lowercase letters</td>
</tr>
<tr>
<td>&lt;sid&gt; and &lt;sapsid&gt;</td>
<td>SAP system ID in lowercase letters</td>
</tr>
<tr>
<td>&lt;DBSID&gt;</td>
<td>Database ID in uppercase letters</td>
</tr>
<tr>
<td>&lt;dbsid&gt;</td>
<td>Database ID in lowercase letters</td>
</tr>
</tbody>
</table>
### Naming Conventions

<table>
<thead>
<tr>
<th>Variables</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;host_name&gt;</td>
<td>Name of the corresponding host</td>
</tr>
<tr>
<td>&lt;INSTDIR&gt;</td>
<td>Installation directory for the SAP system</td>
</tr>
<tr>
<td>&lt;DVD_DIR&gt;</td>
<td>Directory on which a DVD is mounted</td>
</tr>
<tr>
<td>&lt;OS&gt;</td>
<td>Operating system name within a path</td>
</tr>
<tr>
<td>&lt;SCHEMAID&gt;</td>
<td>Database schema ID</td>
</tr>
</tbody>
</table>

The following example shows how the variables are used:

**Example**

Log on as user `<sapsid>adm` and change to the directory `\usr\sap\<SAPSID>`. If your SAP system ID is C11, log on as user `c11adm` and change to the directory `\usr\sap\C11`. 
2 Planning

This section provides general planning information.

You must first:

1. Plan your SAP system landscape according to the Master Guide and the Technical Infrastructure Guide available for your product.
2. Decide on your installation option [page 13].

Now continue with the section for your chosen installation option below.

**Standard, Distributed, or High-Availability System**

1. For the database installation, you decide on how to distribute your system components [page 18].
2. You decide on the transport host to use [page 21].
3. If you want to use Adobe Document Services (ADS), you check what you have to do in case your platform is not supported for ADS [page 21].
4. You decide whether you want to install multiple components in one database (MCOD) [page 22].

5. If you want to install a high-availability system with Microsoft Cluster Service (MSCS), see the MSCS-specific planning activities [page 114].

| End of: HA (MSCS) |

6. You can now continue with Preparation [page 25].

**Additional Application Server Instance**

You do not have to perform any planning steps.

You can immediately continue with Preparation [page 25]

**Host Agent as a Separate Installation**

You do not have to perform any planning steps.

You can immediately continue with Preparation [page 25]

### 2.1 Installation Options Covered by this Guide

This section shows the installation options covered by this installation guide. In the SAPinst tool, these comprises installation and software life-cycle options.

- **Standard system** [page 14] (formerly known as central system)
2 Planning
2.1 Installation Options Covered by this Guide

- **Distributed system** [page 15]
  Only valid for: HA (MCS)

- **High-availability system** [page 15]
  End of: HA (MCS)

- You can install one to <n> additional application server instance(s) [page 16] to an existing standard, distributed or high-availability system.
- You can install a standalone host agent [page 17].

### 2.1.1 Standard System

You can install a standard system on a single host.

In a standard system, all main instances run on a single host:

- Central services instance (SCS)
- Database instance (DB)
- Primary application server instance

**Figure 1**: Standard System

![Diagram of Standard System]

SCS = Java central services instance
PAS = Primary application server instance
DB = Database instance

Optionally you can install one to <n> additional application server instances. For more information, see Additional Application Server Instance [page 16].
2. Planning
2.1 Installation Options Covered by this Guide

2.1.2 Distributed System

In a distributed system, every instance can run on a separate host:

- Central services instance (SCS)
- Database instance (DB)
- Primary application server instance

Optionally you can install one to \(<n>\) additional application server instances. For more information, see *Installation of an Additional Application Server Instance* [page 16].

**Figure 2:** Distributed System

SCS = Java central services instance
PAS = Primary application server instance

Only valid for: HA (MSCS)

2.1.3 High Availability System

For more information on the system components you have to install and how to distribute them on the specific hosts, see *System Configuration in MSCS* [page 115].

End of: HA (MSCS)
2.1.4 Additional Application Server Instance

You can install one to \(<n>\) additional application server instance(s) for an existing SAP system. An additional application server instance can run on:

- The host of any instance of the existing SAP system
- On a dedicated host

⚠️ Note

It is not recommended to install additional application server instance(s) on the SAP global host.

**Additional Application Server Instance for a Standard System**

The following figure shows additional application server instances that are running on dedicated hosts.

**Figure 3: Additional Application Server Instance for a Standard System**

![Diagram showing the layout of a Standard System with SCS, PAS, and DB components on a global host and additional application server instance hosts running on dedicated hosts.]

For additional information, see *Standard System* [page 14].

**Additional Application Server Instance for a Distributed System**

The following figure shows additional application server instances that are running on dedicated hosts.
**2.1 Installation Options Covered by this Guide**

**Figure 4:** Additional Application Server Instance for a Distributed System

![Diagram of SAP Global Host with SCS, PAS, AAS, and File System](image)

SCS = Java central services instance
PAS = Primary application server instance
AAS = Additional application server instance

For additional information, see *Distributed System* [page 15].

Only valid for: HA (MCS)

**Additional Application Server Instance for a High-Availability System**

In a high-availability system, you require besides the primary application server instance, at least one additional application server instance. For more information about how to install and distribute the application servers in an MCS configuration, see section *System Configuration in MCS* [page 115].

End of: HA (MCS)

### 2.1.5 Standalone Host Agent

Using the host agent you can centrally monitor any host with the Alert Monitor or the SAP NetWeaver Administrator. It is automatically installed during the installation of all SAP NetWeaver components.

You only need to install a **standalone** host agent in the following cases:

- You want to centrally monitor a host that does not have an SAP component.
- You want to perform an upgrade to SAP NetWeaver.
2.2 Distribution of Components to Disks

When you install the SAP system, the installation tools prompt you to enter drive letters for the main components of the system. This lets you distribute components to disks in the system as required.
How you do this significantly affects system throughput and data security, so you need to plan it carefully.
The best distribution depends on your environment and must reflect factors such as the size of the components involved, security requirements, and the expected workload.
When you work out the assignment of components to disks, you first need to get an overview of the main components and their corresponding directories. On the basis of sample configurations and the recommendations provided in this documentation, you can then choose the best setup for your particular system.
SAP systems are normally installed on RAID arrays to guarantee data redundancy. Therefore, this documentation focuses on RAID subsystems and drives.

**Features**
The following graphic shows how you can distribute the main directories created during the installation to Redundant Arrays of Independent Disks (RAID). The distribution is suitable for an average-sized production system. Keep in mind that this is only an example and that no single solution fits all environments.

**Figure 6:** Directory Distribution for RAID

This configuration is suitable for the main host of a central system or the database server of a standalone database system. You can assign the components on the left to any of the arrays shown. You do not necessarily have to place the transport directory on the central instance host.
### 2.2 Distribution of Components to Disks

| Array 1 | <DRIVE>:\sapdb\<DBSID>\sapdata\DISKD001  
|         | ...  
|         | <DRIVE>:\sapdb\<DBSID>\sapdata\DISKD999 |
| Array 2 | <DRIVE>:\sapdb\<DBSID>\saplog\DISKL001  
|         | <DRIVE>:\sapdb\<DBSID>\saplog\M_DISKL001  
|         | \usr\sap  
|         | <DRIVE>:\sapdb  
|         | <DRIVE>:\sapdb\<DBSID>\sapsys |
| Array 3 | <DRIVE>:\sapdb\<DBSID>\saplog\M_DISKL001  
|         | <DRIVE>:\sapdb\<DBSID>\saplog\DISKL001 |

This setup has the following key features:

- **Security of the Logs**
  The security of the logs is crucial. The logs record all the changes made to the database and so provide the information that is necessary to recover a damaged database. Therefore, it is important that they are stored very securely and are never lost at the same time as the database data. By placing the redo logs on a **different** array to the database data, you can make sure that they are not lost if the array with the database data is severely damaged.

- **Performance**
  You can reduce I/O bottlenecks by placing the original logical log on a different array than the mirrored log. Original and mirrored logs are written in parallel. If they are located on the same array, this results in a high level of write activity that has to be handled by the same controller. By separating original and mirrored logs, you can distribute the write activity to two different arrays, so reducing I/O bottlenecks.

- **RAID**
  By using RAID 1 arrays for the original and mirrored logs, you get high data security and good performance. The data is written to a primary disk and duplicated identically to a second disk. If one disk fails, the data is still intact on the second disk. The use of RAID 5 for the database ensures fault tolerance. The data is striped over all the disks in the array together with parity information. If one disk fails, the parity information is used to automatically reconstruct the data lost on the damaged disk.

- **Number of RAID Arrays**
  In the example above, three RAID 1 arrays are used for the redo logs to achieve optimal performance and security. If you do not need the disk capacity offered by three arrays and can accept reduced performance, consider using a single array. In this case, you can use a single RAID 1 array for the original and mirrored logs.
2.3 SAP System Transport Host

The transport host contains the transport directory that is used by the SAP transport system to store transport data and change information of SAP systems, such as software programs, data dictionary data, or customization data. If you have several SAP systems they are usually organized in transport domains. In most cases, all SAP systems in a transport domain have a common transport directory. For more information, see:

For more information, see:


When you install an SAP system, SAPinst by default creates the transport directory on the primary application server instance host in `\usr\sap\trans`.

Only valid for: HA (MSCS)

Note

In an MSCS configuration, SAPinst by default creates the transport directory on the (ABAP) central services instance host in `\usr\sap\trans`.

End of: HA (MSCS)

If you want to locate the transport directory on another host, or if you want to use an already existing transport host and directory in your SAP system landscape, you have to prepare this host for use by the new SAP system. For more information, see Preparing the SAP System Transport Host [page 51].

More Information

SAP Directories [page 96]

2.4 Running Adobe Document Services on Non-Supported Platforms

Adobe document services (ADS) are currently not supported to run natively on all platforms supported by SAP systems based on SAP NetWeaver, in particular on 64-bit platforms.

Procedure

To use ADS in SAP landscapes on non-supported platforms, install an additional standalone AS Java on a platform supported by ADS.

For more information, see SAP Note 925741.
2.5 Installation of Multiple Components in One Database

You can install multiple SAP systems in a single database. This is called Multiple Components in One Database (MCOD).

MCOD is available with all SAP components. We are releasing this technology on all the major databases for the SAP system, in line with our commitment to deliver platform-independent solutions.

Using this technology is as easy as installing a separate component. No extra effort is required because the MCOD installation is fully integrated into the standard installation procedure. MCOD is not an additional installation option. Instead, it is an option of the database instance installation.

With MCOD we distinguish two scenarios:

- The installation of an SAP system in a new database
- The installation of an additional SAP system in an existing database

Prerequisites

- For more information on MCOD and its availability on different platforms, see the SAP Service Marketplace at [http://service.sap.com/mcod](http://service.sap.com/mcod).
- Since SAP does not support mixed solutions with MCOD, your SAP system must contain Unicode SAP instances only.
- Improved sizing required
  In general, you calculate the CPU usage for an MCOD database by adding up the CPU usage for each individual SAP system. The same applies to memory resources and disk space.
  You can size multiple components in one database by sizing each individual component using the SAP Quick Sizer and then adding the requirements together. For more information on the SAP Quick Sizer, see the SAP Service Marketplace at [http://service.sap.com/sizing](http://service.sap.com/sizing).

Features

- Reduced administration effort
- Consistent system landscape for backup, system copy, administration, and recovery
- Increased security and reduced database failure for multiple SAP systems due to monitoring and administration of only one database
- Independent upgrade
  In an MCOD landscape you can upgrade a single component independently from the other components running in the same database, assuming that the upgraded component runs on the same database version. However, if you need to restore a backup, be aware that all other components are also affected.
**Note**

Special MCOD considerations and differences from the standard procedure are listed where relevant in the installation documentation.

**Constraints**

- **We strongly recommend** that you test MCOD in a test or development system. We recommend that you run MCOD systems in the same context. We do not recommend that you mix test, development, and production systems in the same MCOD.
- In the event of database failure, all SAP systems running on the single database are affected.
- Automated support in an MCOD landscape for the following administrative tasks depends on your operating system and database:
  - Copying a single component from an MCOD landscape to another database at database level.
  - De-installing a single component from an MCOD landscape requires some additional steps. You can use a remote connection to SAP support to request help with these tasks. For more information see [http://service.sap.com/remoteconnection](http://service.sap.com/remoteconnection).
- **You cannot** install a Unicode SAP system with a non-Unicode SAP system in one database.

<table>
<thead>
<tr>
<th>Only valid for:</th>
<th>HA (MSCS)</th>
</tr>
</thead>
</table>

- **MSCS only:** You **cannot** install multiple components in one database with Microsoft Cluster Service (MSCS). For more information on MSCS, see Microsoft Cluster Installation.

<table>
<thead>
<tr>
<th>End of:</th>
<th>HA (MSCS)</th>
</tr>
</thead>
</table>

- For the first SAP system, the database system ID can be different from the SAP system ID.
- For the second SAP system, you must use the same **DBSID** as for the first SAP system.
- If you decide to turn off database logging during the database load phase of the installation, you need to plan downtime for all MCOD systems sharing the database.
This page is intentionally left blank.
3 Preparation

This section includes the preparation steps that you have to perform for the:

- Standard, distributed, or high-availability system
- Additional application server instance
- Host agent

**Standard, Distributed, or High-Availability System**

**Note**

In a standard system, all mandatory instances are installed on one host. Therefore, if you are installing a standard system, you can ignore references to other hosts.

1. You identify basic SAP system parameters [page 26].
2. You check the hardware and software requirements [page 32] on each host.
3. You check the Windows file system [page 46] on each host.
4. You check that all installation hosts belong to the correct Windows domain [page 46].
5. You reduce the size of the file cache [page 47] on each host.
6. You check that you have the required user authorization for the installation [page 47].
7. If required, you perform a domain installation without being a domain administrator [page 49].
8. If required, you prepare the SAP system transport host [page 51] for your SAP system.
9. You make sure that the required installation media [page 54] is available on each host.

[Only valid for: HA (MSCS)]

10. For the installation of a high-availability system with Microsoft Cluster Service (MSCS), you also have to perform MSCS-specific preparation tasks [page 128].

[End of: HA (MSCS)]

11. You can now continue with Installation [page 57].

**Additional Application Server Instance**

You have to perform the following preparations on the host where you install the additional application server instance(s):

1. You check the hardware and software requirements [page 32].
2. You check the Windows file system [page 46].
3. You check that your host belongs to the correct Windows domain [page 46].
4. You reduce the size of the file cache [page 47].
5. You check that you have the required user authorization for the installation [page 47].
6. If required, you perform a domain installation without being a domain administrator [page 49].
7. You make sure that the required installation media [page 54] is available.
8. You can now continue with Installation [page 57].

**Standalone Host Agent**

You have to perform the following preparations on the host where you install the host agent separately:

1. You identify basic SAP system parameters [page 26].
2. You check the hardware and software requirements [page 32].
3. You check the Windows file system [page 46].
4. You reduce the size of the file cache [page 47].
5. You check that you have the required user authorization for the installation [page 47].
6. If required, you perform a domain installation without being a domain administrator [page 49].
7. You make sure that the required installation media [page 54] is available.
8. You can now continue with Installation [page 57].

### 3.1 Basic SAP System Parameters

SAPinst asks whether you want to run the installation in Typical or Custom mode. If you choose Typical, SAPinst provides automatic default settings and you only have to respond to a minimum number of prompts. However, you can still change any of the default settings on the parameter summary screen.

The tables below list the basic system parameters that you always need to specify before installing your SAP system, both in typical and in custom mode.

For all other SAP system parameters, use the [F1] help in the SAPinst dialogs.

**SAP System ID and Database ID**

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP System ID &lt;SAPSID&gt;</td>
<td>The SAP system ID &lt;SAPSID&gt; identifies the entire SAP system. SAPinst prompts you for the &lt;SAPSID&gt; when you execute the first installation option to install a new SAP system. If there are further installation options to be executed, SAPinst prompts you for the profile directory. For more information, see the description of the parameter SAP System Profile Directory.</td>
</tr>
</tbody>
</table>

```
Example
This prompt appears when you install the central services instance, which is the
```
### Parameters Description

First instance to be installed in a distributed system.

**Caution**
Choose your SAP system ID carefully. Renaming is difficult and requires you to reinstall the SAP system.

Make sure that your SAP system ID:
- Is unique throughout your organization
- Consists of exactly three alphanumeric characters
- Contains only uppercase letters
- Has a letter for the first character
- Does not include any of the following, which are reserved IDs:
  
  ADD  ALL  AND  ANY  ASC  COM  CON  DBA  END  EPS  FOR  GID  IBM  INT  KEY  LOG  MON  NIX  NOT  NUL  OFF  ONS  RAW  ROW  SAP  SET  SGA  SHG  SID  SQL  SYS  TMP  UID  USR  VAR

#### Database ID `<DBSID>`

The `<DBSID>` identifies the database instance. SAPinst prompts you for the `<DBSID>` when you are installing the database instance. The `<DBSID>` can be the same as the `<SAPSID>`.

**Caution**
Choose your database ID carefully. Renaming is difficult and requires you to reinstall the SAP system.

- **If you want to install a new database:**
  Make sure that your database ID:
  - Is unique throughout your organization
  - Consists of exactly three alphanumeric characters
  - Contains only uppercase letters
  - Has a letter for the first character
  - Does not include any of the following, which are reserved IDs:
    
    ADD  ALL  AND  ANY  ASC  COM  CON  DBA  END  EPS  FOR  GID  IBM  INT  KEY  LOG  MON  NIX  NOT  NUL  OFF  ONS  RAW  ROW  SAP  SET  SGA  SHG  SID  SQL  SYS  TMP  UID  USR  VAR

- **If you want to use an existing database:**
  Enter exactly the database ID of the existing database to which you want to add the system.
### SAP System Profile Directory

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(&lt;\text{SAPGLOBALHOST}&gt;\text{&lt;sapmnt&gt;\text{&lt;SAPSID&gt;}}\text{SYS}\text{profile})</td>
<td>The installation retrieves the parameters entered earlier from the SAP system profile directory. SAPInst prompts you to enter the location of the profile directory when the installation option that you execute is not the first one belonging to your SAP system installation. See also the description of the parameters SAP System ID and Database ID.</td>
</tr>
</tbody>
</table>

**Note**
If you install an additional application server instance to an existing SAP system, SAPInst also prompts you for the profile directory of the existing SAP system.

### SAP System Instances, Hosts, and Ports

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Instance Number:</strong></td>
<td>Technical identifier that is required for every instance of an SAP system, consisting of a two-digit number from 00 to 97. The instance number must be unique on a host. That is, if more than one SAP instance is running on the same host, these instances must be assigned different numbers. To find out this number, look in the SAP directory &lt;Drive&gt;:\usr\sap&lt;SAPSID&gt;&lt;nn&gt; on the host of the primary application server instance. The value &lt;nn&gt; is the number assigned to the primary application server instance.</td>
</tr>
</tbody>
</table>

**Caution**
Do **not** use 43, 60, 89 for the instance number because:
- 43 is used by MSCS
- 60 is used by iSCSI
- 89 is used by Windows Terminal Server

| Virtual Host Name | For a high-availability (HA) system you need to specify the virtual host name, which is used by the (A)SCS instance.  
- For more information about the use of virtual TCP/IP host names, see SAP Note 962955.  
- For more information about the allowed host name length and characters, see SAP Note 611361. To find out the host name, open a command prompt and enter hostname. |

| Message Server Port | **Caution**  
The message server port number must be unique for the SAP system on all hosts. If there are several message ports number on one host, all must be unique.  
**Port Number of the SAP Message Server:** |
### Parameters

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>If you do not specify a value, the default port number is used. The Java message server is configured in the SCS instance profile. The Java message server port uses the parameter <code>rdisps/msserv_internal</code> with default value <code>39&lt;nn&gt;</code>, where <code>&lt;nn&gt;</code> is the instance number of the SCS message server instance. For more information about the parameters used for message server ports, see SAP Note 821875.</td>
</tr>
</tbody>
</table>

### Parameters for SAP System Drives

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Destination drive</td>
<td>Base directory for the SAP system.</td>
</tr>
<tr>
<td></td>
<td>Note</td>
</tr>
<tr>
<td></td>
<td>If you install a subsequent SAP system, the <code>sap100</code> share already exists and you cannot select the installation drive. SAPInst uses the installation drive where the <code>sap100</code> share points to.</td>
</tr>
</tbody>
</table>

### Master Password

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Master Password</td>
<td>This password is used for all <strong>new</strong> user accounts SAPInst creates and for the secure store key phrase. The length has to be 8 to 14 characters. Depending on your installation scenario there might be more restrictions.</td>
</tr>
<tr>
<td></td>
<td>Caution</td>
</tr>
<tr>
<td></td>
<td>If you do not create the operating system users manually, SAPInst creates them with the common master password. For more information, see the description of the parameter <strong>Operating System Users</strong>. In this case, make sure that the master password meets the requirements of your operating system and of your database.</td>
</tr>
</tbody>
</table>

### Operating System Users of the SAP System

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Password of Operating System Users</td>
<td>SAPInst processes the passwords of operating system users as follows:</td>
</tr>
<tr>
<td></td>
<td>• If the operating system users do <strong>not</strong> exist, SAP creates the following users:</td>
</tr>
<tr>
<td></td>
<td>• <code>&lt;sapsid&gt;adm</code></td>
</tr>
<tr>
<td></td>
<td>This user is the SAP system administrator user and is a member of the local Administrators group.</td>
</tr>
<tr>
<td></td>
<td>• SAPService&lt;SPSID&gt;</td>
</tr>
<tr>
<td></td>
<td>This user is the Windows account to run the SAP system. It is not a member of the local Administrators group.</td>
</tr>
</tbody>
</table>
Using the Java Database:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Java Administrator User</td>
<td>SAPInst sets the user name Administrator and the master password by default. If required, you can choose another user name and password according to your requirements.</td>
</tr>
<tr>
<td>Java Guest User</td>
<td>SAPInst sets the user name Guest and the master password by default. The Guest user is for employees who do not belong to a company or who have registered as company users with pending approval. Guest users belong to the default group Authenticated Users and have read access only.</td>
</tr>
</tbody>
</table>

Using an External ABAP System – Parameters for the ABAP Connection:
### 3.1 Basic SAP System Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Server Instance Number</td>
<td>This is the instance number on the application server of the central ABAP system to which you want to connect the Application Server Java. To find out the number on the host of the primary application server instance, look under the SAP directory <code>usr/sap/&lt;SAPSID&gt;/DVEBMGS&lt;nn&gt;</code>. The value <code>&lt;nn&gt;</code> is the number assigned to the SAP system.</td>
</tr>
<tr>
<td>Application Server Host</td>
<td>This is the host name of the relevant application server instance. To find out the host name, enter <code>hostname</code> at the command prompt of the host running the primary application server instance.</td>
</tr>
<tr>
<td>Communication User</td>
<td>This is the name and password of the existing ABAP communication user. You must have created this user manually on the external ABAP system.</td>
</tr>
</tbody>
</table>

**Using an External ABAP System – Parameters for the Application Server Java Connection:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator User</td>
<td>This is the name and password of the administrator user that you created on the external ABAP system.</td>
</tr>
<tr>
<td>Administrator Role</td>
<td>The role <code>SAP_J2EE_ADMIN</code> must exist on the external ABAP system.</td>
</tr>
<tr>
<td>Guest User</td>
<td>This is the name and password of the guest user that you created on the external ABAP system. The guest user is for employees who do not belong to a company or who have registered as company users with pending approval. Guest users belong to the default group <code>Authenticated Users</code> and have read access only.</td>
</tr>
<tr>
<td>Guest Role</td>
<td>The role <code>SAP_J2EE_GUEST</code> must exist on the external ABAP system.</td>
</tr>
</tbody>
</table>

**Internet Communication Manager (ICM) User Management**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Password of <code>webadm</code></td>
<td>The administration user <code>webadm</code> is created to use the web administration interface for Internet Communication Manager (ICM) and Web Dispatcher. <code>SAPinst</code> sets the master password by default. If required, you can choose another password. The length of the password must be between 5 and 128 characters.</td>
</tr>
</tbody>
</table>

**Host Agent as a Separate Installation**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Password of <code>sapadm</code></td>
<td>The administration user <code>sapadm</code> is created to use central monitoring services. If this user is not already existing, it is created automatically by <code>SAPinst</code>. <code>SAPinst</code> prompts you to enter either the password of the existing user or a new password for the user to be created.</td>
</tr>
</tbody>
</table>
### 3.2 Hardware and Software Requirements

You check the hardware and software requirements for your operating system (OS) and the SAP instances using the Prerequisite Checker tool that provides information about the requirements that you need to meet before you start the installation. For example, it checks the requirements for the different installation options.

**Note**

- The values that are checked by the Prerequisite Checker apply to the installation of development systems or quality assurance systems.
- For the most recent updates to the Prerequisite Checker, always check SAP Note 855498.

You can run the Prerequisite Checker as follows:

- **Standalone (optional):**
  
  To check the hardware and software requirements of the host on which you want to later install an SAP system, you can run the Prerequisite Checker standalone [page 34].

- **Integrated in SAPinst (mandatory):**
  
  SAPinst automatically runs the Prerequisite Checker when you install your SAP system.
Recommendation

We also recommend that you consult the requirements checklists tables, which also provide values for the installation of development systems or quality assurance systems. Depending on the amount of data involved, the requirements might change.

In addition, consider the following information:

- To get precise sizing values for production systems, you choose one of the following options:
  - You use the SAP Quick Sizer tool that is available on SAP Service Marketplace at [http://service.sap.com/sizing](http://service.sap.com/sizing). You enter information about your planned system and the tool calculates the requirements.
  - For more information, see Planning your System Landscape in the Master Guide for your SAP system, which is available on SAP Service Marketplace [page 10].
  - You contact your hardware vendor, who can analyze the load and calculate suitable hardware sizing depending on:
    - The set of applications to be deployed
    - How intensively the applications are to be used
    - The number of users
  - For supported operating system releases, see the Product Availability Matrix on SAP Service Marketplace at [http://service.sap.com/pam](http://service.sap.com/pam).
  - Contact your OS vendor for the latest OS patches.
  - Make sure that the host name meets the requirements listed in SAP Note 611361.

Process Flow

1. If required, you run the Prerequisite Checker standalone [page 34] to check the hardware and software requirements.

   Caution
   
   If you do not fully meet the requirements, you might experience problems when working with the SAP system.

2. In addition, we recommend that you check the hardware and software requirements checklists for the following system variants:
   - Standard system [page 35]
   - Distributed system [page 36]
     - Only valid for: HA (MSCS)
   - High-Availability System with MSCS [page 38]
     - End of: HA (MSCS)
   - Additional application server instance
     - If you want to install an additional application server instance, check the requirements listed for a distributed system [page 36].
3.2 Hardware and Software Requirements

- Application Sharing Server as an Optional Standalone Unit
  If you want to install the Application Sharing Server as a standalone unit, you must meet the same requirements as for a Java standard system [page 35].
- Standalone Host Agent [page 42]

3.2.1 Running the Prerequisite Checker in Standalone Mode (Optional)

Before installing your SAP system, you can run the Prerequisite Checker in standalone mode to check the hardware and software requirements for your operating system (OS) and the SAP instances.

**Recommendation**
We recommend that you use both the Prerequisite Checker and the requirements tables for reference.

**Note**
When installing your SAP system, SAPinst automatically starts the Prerequisite Checker and checks the hardware and software requirements in the background.

**Prerequisites**
- You have prepared the Installation Master DVD on the required installation host [page 54].

**Procedure**
1. You start SAPinst [page 58].
2. On the Welcome screen, choose <SAP System> ➤ Software Life-Cycle Options ➤ Additional Preparation Tasks ➤ Prerequisites Check ➤.
3. Follow the instructions in the SAPinst dialogs and enter the required parameters.

**Note**
For more information about each parameter, position the cursor on the parameter field and choose F1 in SAPinst.

When you have finished, the Parameter Summary screen appears summarizing all parameters you have entered. If you want to make a change, select the relevant parameters and choose Revise.
4. To start the Prerequisite Checker, choose Start.

**Result**
The Prerequisite Check Results screen displays the results found. If required, you can also check the results in file prerequisite_checker_results.html, which you can find in the installation directory.
3.2 Hardware and Software Requirements

3.2.2 Requirements for a Standard System

If you want to install a standard system, where all instances reside on one host, this host must meet the following hardware and software requirements:

Hardware Requirements for a Standard System

<table>
<thead>
<tr>
<th>Hardware Requirement</th>
<th>Requirement</th>
<th>How to Check</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum disk space</td>
<td>- Database Software:</td>
<td>To check disk space:</td>
</tr>
<tr>
<td></td>
<td>Version 7.6: 500 MB</td>
<td>1. Choose Start All Programs Administrative Tools</td>
</tr>
<tr>
<td></td>
<td>- SAP system files (not including paging file):</td>
<td>2. Right-click the drive and choose Properties.</td>
</tr>
<tr>
<td></td>
<td>5 GB (x86_64)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>8 GB (IA64)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- SAP database files (not including paging file), see the following file:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;Export_DVD\DATA_UNITS\EXPORT_1\DB&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The XML table in this file contains a field called fDevSize, which</td>
<td></td>
</tr>
<tr>
<td></td>
<td>contains the size in MB of the element indicated in the previous field,</td>
<td></td>
</tr>
<tr>
<td></td>
<td>fDevName.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>This shows you the size of the data (DBDATADEV) and the log (DBLOGDEV)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>volumes.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Note</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The values listed in DBSIZE.XML are only for guidance.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Distribute the space for the data across at least three physically</td>
<td></td>
</tr>
<tr>
<td></td>
<td>separate disks.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Up to 2 GB for each usage type or software unit you want to install.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- 4.3 GB of temporary disk space for every required installation DVD that</td>
<td></td>
</tr>
<tr>
<td></td>
<td>you have to copy to a local hard disk</td>
<td></td>
</tr>
<tr>
<td>Minimum RAM</td>
<td>1.5 GB</td>
<td>To check RAM:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1. In the Windows Explorer choose Help About</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Windows.</td>
</tr>
</tbody>
</table>

11/05/2007
PUBLIC
35/148
3.2 Hardware and Software Requirements

### Hardware Requirements

<table>
<thead>
<tr>
<th>Hardware Requirement</th>
<th>Requirement</th>
<th>How to Check</th>
</tr>
</thead>
</table>
| Paging file size     | 1 times RAM plus 8 GB | To check paging file size:  
1. Right-click *My Computer* and choose *Properties*.  
2. Choose *Advanced* > *Performance Settings*.  
3. If required, in section *Virtual Memory*, choose *Change*. |
| Suitable backup system | — | |

### Software Requirements for a Standard System

<table>
<thead>
<tr>
<th>Software Requirement</th>
<th>Requirement</th>
<th>How to Check</th>
</tr>
</thead>
</table>
| Windows operating system | ■ **English international 64-bit version** of one of the following:  
- Windows Server 2003 Enterprise Edition  
- Windows Server 2003 Datacenter Edition  
- For any version of Windows Server 2003, you need at least service pack 2.  
■ A suitable Windows Resource Kit is strongly recommended. | To check your Windows version:  
1. Choose *Start* > *All Programs* > *Accessories* > *Command Prompt*.  
2. Enter the command *winver*. |

### 3.2.3 Requirements for a Distributed System

This section provides information about the hardware and software requirements in a distributed system, where the SAP instances can reside on different hosts.

The tables show the requirements for the:

- Central services instance
- Database instance
- Primary application server instance
- Additional application server instance

**Note**

- The listed values only apply for **development systems** or **quality assurance systems**.
- If you install several SAP instances on one host, you need to add up the requirements.
### Hardware Requirements for a Distributed System

<table>
<thead>
<tr>
<th>Hardware Requirement</th>
<th>Requirement</th>
<th>How to Check</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum disk space</td>
<td>- Database Software:&lt;br&gt;Version 7.6: 500 MB&lt;br&gt;Version 7.7: 700 MB&lt;br&gt;- Central services instance (SCS)&lt;br&gt;(not including paging file):&lt;br&gt;5 GB (x86_64)&lt;br&gt;8 GB (IA64)&lt;br&gt;- SAP database files (not including paging file), see the following file: The XML table in this file contains a field called <code>fDevSize</code>, which contains the size in MB of the element indicated in the previous field, <code>fDevName</code>. This shows you the size of the data (DBDATADEV) and the log (DBLOGDEV) volumes.</td>
<td>To check disk space:&lt;br&gt;1. Choose <code>Start</code> <code>All Programs</code> <code>Administrative Tools</code> <code>Computer Management</code> <code>Disk Management</code>. ACING&lt;br&gt;2. Right-click the drive and choose <code>Properties</code>.</td>
</tr>
<tr>
<td></td>
<td>Note&lt;br&gt;The values listed in DBSIZE.XML are only for guidance.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Distribute the space for the data across at least three physically separate disks.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Primary application server instance (not including paging file):&lt;br&gt;5 GB (x86_64)&lt;br&gt;8 GB (IA64)&lt;br&gt;- In addition you require 4 GB (x86_64), or 8 GB (IA64) per additional platform.&lt;br&gt;- Up to 2 GB for each usage type or software unit you want to install.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Additional application server instance (not including paging file):&lt;br&gt;2.5 GB (x86_64)&lt;br&gt;5 GB (IA64)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Temporary disk space for every required installation DVD that you have to copy to a local hard disk:&lt;br&gt;4.3 GB</td>
<td></td>
</tr>
<tr>
<td>Minimum RAM</td>
<td>1 GB</td>
<td>To check RAM:&lt;br&gt;In the Windows Explorer, choose <code>Help</code> <code>About Windows</code>.</td>
</tr>
</tbody>
</table>
3.2 Hardware and Software Requirements

### Hardware Requirements

<table>
<thead>
<tr>
<th>Hardware Requirement</th>
<th>Requirement</th>
<th>How to Check</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paging file size</td>
<td>Central services instance (SCS): 1 times RAM plus 8 GB</td>
<td>To check paging file size: 1. Right-click My Computer and choose Properties.</td>
</tr>
<tr>
<td></td>
<td>Database instance: 1.5 times RAM recommended by Microsoft</td>
<td>2. Choose Advanced &gt; Performance Settings.</td>
</tr>
<tr>
<td></td>
<td>Primary application server instance: 1 times RAM plus 8 GB</td>
<td>3. If required, in section Virtual Memory, choose Change.</td>
</tr>
<tr>
<td>Suitable backup system</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Software Requirements for a Distributed System

<table>
<thead>
<tr>
<th>Software Requirement</th>
<th>Requirement</th>
<th>How to Check</th>
</tr>
</thead>
</table>
| Windows operating system | English international 64-bit version of one of the following:  
  - Windows Server 2003 Enterprise Edition  
  - Windows Server 2003 Datacenter Edition  
  - For any version of Windows Server 2003, you need at least service pack 2.  
  - A suitable Windows Resource Kit is strongly recommended. | To check your Windows version: 1. Choose Start > All Programs > Accessories > Command Prompt. 2. Enter the command `winver`. |

### 3.2.4 Requirements for a High-Availability System

This section provides information about the hardware and software requirements in a high-availability system.

**Only valid for: HA (MSCS)**
Note

1. You must check that your cluster hardware is certified.
   AddOn Technology Center for SAP (Add On TCS) certifies hardware platforms for SAP on
   Microsoft Windows. The cluster must be included in the Microsoft list of certified clusters and its
   components. You can access the lists at the following Internet addresses:
   www.microsoft.com/whdc/hcl/default.mspx
   www.saponwin.com

2. You must make sure that the MSCS nodes of the cluster are connected by a private and public
   network:
   - The public network enables communication from the MSCS nodes of the cluster to other
     resources in the local area network (LAN).
   - The private network enables internal communication between the MSCS nodes. In particular,
     it enables the Cluster Service running on all MSCS nodes to regularly exchange messages on
     the state of the MSCS nodes so that the failure of resources is quickly detected.

3. Each of the MSCS nodes in the cluster must have its own local disks and have access to shared
   disks that can be reached by the MSCS nodes via a shared bus.
   All software — except the Windows operating system, the MaxDB system database, and the MSCS
   software — is stored on the shared disks.
   One of the shared disks must be used exclusively by the quorum (if a single quorum device cluster
   is used) that stores the cluster registry and records information about the state of the cluster.
   You require at least 6 shared disks.
   For more information about the distribution of components to local and shared disk, see
   Distribution of Components to Disks for MSCS [page 119].

Caution

- All disk controllers must be able to support hardware-based RAID.
- You cannot use a host with a domain controller as an MSCS cluster node.

The following tables show the hardware and software requirements for the:
- Central services instance (SCS)
- Database instance
- Enqueue Replication Server instance (ERS)
- Primary application server instance
- Additional application server instance

The listed values only apply for development systems or quality assurance systems.
# Hardware Requirements for a High-Availability System

<table>
<thead>
<tr>
<th>Hardware Requirement</th>
<th>Requirement</th>
<th>How to Check</th>
</tr>
</thead>
</table>
| Minimum disk space   | - Database Software: Version 7.6: 800 MB  
                        Version 7.7: 700 MB  
                        - Central services instance (SCS) (not including paging file): 5 GB (x86_64)  
                        8 GB (IA64)  
                        - SAP database files (not including paging file), see the following file: <Export_DVD>\DATA_UNITS\EXPORT_11\DB\ADA\DBSIZE.XML  
                        The XML table in this file contains a field called fDevSize, which contains the size in MB of the element indicated in the previous field, fDevName. This shows you the size of the data (DBDATADEV) and the log (DBLOGDEV) volumes.  
                        - Note: The values listed in DBSIZE.XML are only for guidance.  
                        - Distribute the space for the data across at least three physically separate disks.  
                        - Enqueue replication server instance (ERS) (not including paging file): 5 GB (x86_64)  
                        8 GB (IA64)  
                        - Primary application server instance (not including paging file): 2.5 GB (x86_64)  
                        5 GB (IA64)  
                        - In addition you require 4 GB (x86_64), or 8 GB (IA64) per additional platform.  
                        - Up to 2 GB for each usage type or software unit you want to install.  
                        - Additional application server instance (not including paging file): 2.5 GB (x86_64)  
                        5 GB (IA64)  
                        - Temporary disk space for every required installation DVD that you have to copy to a local hard disk: 4.3 GB | To check disk space:  
1. Choose Start ➤ All Programs ➤ Administrative Tools ➤ Computer Management ➤ Disk Management.  
2. Right-click the drive and choose Properties.  

To install the SAP software you must have a local hard disk space sufficient for the following files:  
- SAP database files (not including paging file), see the following file: <Export_DVD>\DATA_UNITS\EXPORT_11\DB\ADA\DBSIZE.XML  
- Additional application server instance (not including paging file): 2.5 GB (x86_64)  
5 GB (IA64)  
- Temporary disk space for every required installation DVD that you have to copy to a local hard disk: 4.3 GB  

To check free space on your hard disk:  
1. Choose Start ➤ All Programs ➤ Administrative Tools ➤ Computer Management ➤ Disk Management.  
2. Right-click the drive and choose Properties.
### Hardware Requirements

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Requirement</th>
<th>How to Check</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum RAM</td>
<td>1 GB</td>
<td>To check RAM: In the Windows Explorer, choose Help &gt; About Windows.</td>
</tr>
<tr>
<td>Paging file size</td>
<td></td>
<td>To check paging file size:</td>
</tr>
<tr>
<td></td>
<td>Central services instance (SCS): 1 times RAM plus 8 GB</td>
<td>1. Right-click My Computer and choose Properties.</td>
</tr>
<tr>
<td></td>
<td>1.5 times RAM recommended by Microsoft</td>
<td>3. If required, in section Virtual Memory, choose Change.</td>
</tr>
<tr>
<td></td>
<td>Enqueue replication server instance (ERS): 1 times RAM plus 8 GB</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Primary application server instance: 1 times RAM plus 8 GB</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Additional application server instance: 1 times RAM plus 8 GB</td>
<td></td>
</tr>
<tr>
<td>Suitable backup system</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Software Requirements for a High-Availability System

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Requirement</th>
<th>How to Check</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows operating system</td>
<td>English international 64-bit version of one of the following:</td>
<td>To check your Windows version:</td>
</tr>
<tr>
<td></td>
<td>3. For any version of Windows Server 2003, you need at least service pack 2.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>4. A suitable Windows Resource Kit is strongly recommended.</td>
<td></td>
</tr>
</tbody>
</table>

 Совет: You must set up the MSCS Cluster Service as described in the Microsoft documentation. During this setup you are asked for a Windows Domain Account to run the Cluster Service. We strongly recommend creating an account different from the `<sapsid>adm` user, for example `ClusterServiceuser=sapprdcladm`, where Clustername=sapprdcl.

---

End of HA (MSCS)
3.2.5 Requirements for the Host Agent as a Separate Installation

If you want to install the host agent separately, the installation host has to meet the following hardware and software requirements:

Hardware Requirements for the Host Agent

<table>
<thead>
<tr>
<th>Hardware Requirement</th>
<th>Requirement</th>
<th>How to Check</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum disk space:</td>
<td>Host agent: 80 MB, temporary disk space that you have to copy to a local hard disk: 4.3 GB</td>
<td>To check disk space: 1. Choose Start All Programs Administrative Tools Computer Management Disk Management. 2. Right-click the drive and choose Properties.</td>
</tr>
<tr>
<td>Minimum RAM:</td>
<td>40 MB</td>
<td>To check RAM: In the Windows Explorer choose Help About Windows.</td>
</tr>
<tr>
<td>Paging file size:</td>
<td>500 MB</td>
<td>To check paging file size: 1. Right-click My Computer and choose Properties. 2. Choose Advanced Performance Settings. 3. If required, in section Virtual Memory, choose Change.</td>
</tr>
<tr>
<td>Suitable backup system</td>
<td></td>
<td>—</td>
</tr>
</tbody>
</table>

Software Requirements for the Host Agent

<table>
<thead>
<tr>
<th>Software Requirement</th>
<th>Requirement</th>
<th>How to Check</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database software:</td>
<td></td>
<td>—</td>
</tr>
</tbody>
</table>
3.3 Preparing User Management for an External ABAP System

For a Java system, you can also deploy user management for an external ABAP system. In this case, you configure the User Management Engine (UME) of Application Server Java (AS Java) for the user management of a separate ABAP system.

If you want to connect more than one Java system to the same ABAP system, you need to work out a concept for the communication, administrator, and guest users for each system.

You can take one of the following approaches:

<table>
<thead>
<tr>
<th>Approach</th>
<th>Advantages</th>
<th>Disadvantages</th>
</tr>
</thead>
<tbody>
<tr>
<td>Each Java system uses different users</td>
<td>No interdependencies between the connected engines</td>
<td>Initially more administration to create the users in the ABAP system</td>
</tr>
<tr>
<td>All Java systems use the same configuration</td>
<td>You create the users only once and enter the same information for every Java systems that you install.</td>
<td>Interdependencies between the connected engines:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- If you change the password of any of the users on the ABAP system, this change affects all connected engines.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- If you change the administrator user’s password, you must also change the password in secure storage on all of the connected Java systems</td>
</tr>
</tbody>
</table>

**Recommendation**

For security reasons, we recommend the first approach.

The procedures below assume that you are using the first approach.

**Prerequisites**

- The ABAP system is based on at least SAP Web AS ABAP release 6.20 SP25.
- In transaction PFCG, check that the roles `SAP_BC_JSF_COMMUNICATION` and `SAP_BC_JSF_COMMUNICATION_RO` exist and make sure that their profiles are generated.
- In transaction PFCG, check that the roles `SAP_J2EE_ADMIN`, `SAP_J2EE_GUEST` and `SAP_BC_FP_ICF` exist. Neither role contains any ABAP permissions, so you do not need to generate any profiles.
- In transaction PFCG, create a role named `A0SCallers`. You do not need to maintain authorization data or generate any profiles for that role.
- For more information, see:
Note
For more information about role maintenance, see the SAP Library at

Administration of the ABAP system
Perform the following administration steps in the ABAP system:

1. In transaction SU01 create a new communication user and assign it to the role SAP_BC_JSF_COMMUNICATION_RO.

Recommendation
We recommend that you assign this user the role SAP_BC_JSF_COMMUNICATION_RO for read-only (display) access to user data with Java tools. If you intend to maintain user data (that is, to change, create, or delete users) with Java tools, you need to assign the role SAP_BC_JSF_COMMUNICATION instead.
We recommend that you name the user SAPJSF_<SAPSID_Java_System>.
You can use any password.

In addition, to make sure that this user can only be used for communication connections between systems and not as a dialog user, assign it the type Communications under Logon data.

2. In transaction SU01 create a new dialog user and assign it to role SAP_J2EE_ADMIN. This is your administrator user in AS Java.

Recommendation
We recommend that you name the user J2EE_ADMIN_<SAPSID_Java_System>. You can use any password.

Caution
Log on to the SAP system once with this user to change its initial password. Because the installer of AS Java verifies this password, the installation fails if this password is initial.

3. In transaction SU01 create a new dialog user and assign it to role SAP_J2EE_GUEST. This is your guest user in AS Java.

3.3 Preparing User Management for an External ABAP System
4. In transaction SU01 create the following dialog users:

- Users for Adobe Document Services (ADS) (optional):
  - ADSUSER:
    - In transaction PFCG, assign the role ADSCallers to this user.
  - ADS_AGENT:
    - In transaction PFCG, assign the role SAP_BC_FP_ICF to this user.

- SLD Data supplier user (optional):
  - You only have to create this user if you want to install System Landscape Directory (SLD).
  - The SLD data supplier user name that you enter later on during the Java system installation must be identical to this user.

- SLD ABAP API user (optional):
  - You only have to create this user if you want to install System Landscape Directory (SLD).
  - The SLD ABAP API user name that you enter later on during the Java system installation must be identical to this user.

- Note
  - For more information on SLD users and security roles, see the SLD User Guide at
    - NetWeaver > Software Life Cycle Management > Configuring, Working with and Administering System Landscape Directory > Administering the SLD.
Activities for the Java System

Perform the following steps in the Java system:

1. **Before** the installation of the Java system, make sure that you have the correct user names and passwords of the users listed above for the separate ABAP system.
2. **During** the installation of the Java system, make sure that you enter the correct users and passwords in the corresponding SAPinst dialogs.

3.4 Checking the Windows File System

You need to check that you are using the Windows file system NTFS on hosts where you want to install the SAP system and database. NTFS supports full Windows security and long file names.

![Note]

You must use NTFS for an SAP system installation. Do **not** install the SAP directories on a FAT partition.

Procedure

1. Open the Windows Explorer.
2. Select the root directory.
3. Choose **File > Properties > General**.
   - The system displays the type of file system in use.
4. Check that the file system is NTFS.

3.5 Checking the Windows Domain Structure

![Note]

You do **not** need this step for a local installation.

In Windows, you can implement either of the following domain models for the SAP system:

- **Extra domain**
  - In this model, the SAP system is embedded in its own domain, which is specially defined for SAP. A second domain exists for the user accounts.
  - In Windows, the SAP domain and user domain must be incorporated in a domain tree. In this tree, the user accounts must form the root domain and the SAP domain must be a child domain of this.

- **Single domain**
  - In this model, the SAP system and the user accounts are included in a single domain.
Prerequisites

■ You are performing a domain installation.
■ You are familiar with checking Windows domain structures. For more information, see the Windows documentation.

⚠ Caution
You cannot create local users and groups on the host that is used as domain controller. Therefore, we do not support running an SAP instance (including the database instance) on the host where the domain controller is installed.

Procedure
For a domain installation, we recommend that you check that all SAP system and database hosts are members of a single Windows domain. We recommend this for all SAP system setups.

3.6 Reducing the Size of the File Cache

The Windows file cache competes directly with SAP programs for memory. Therefore, you need to adjust the file cache as described below.

Procedure
1. Choose Start Control Panel Network Connections Local Area Connections.
2. In the Local Area Connection Status dialog box, choose Properties.
3. In the Local Area Connection Properties dialog box, double-click File and Printer Sharing for Microsoft Networks.
4. Select Maximize data throughput for network applications.

⚠ Caution
If you cannot select File and Printer Sharing for Microsoft Networks, this option has not yet been installed. To install it, you need the Windows Server CDs.
5. To confirm your entries, choose OK.

3.7 Required User Authorization for the Installation

Although SAPinst automatically grants the rights required for the installation to the user account used for the installation, you have to check whether this account has the required authorization to perform the installation. The authorization required depends on whether you intend to perform a domain or local installation. If necessary, you have to ask the system administrator to grant the
account the necessary authorization **before** you start the installation. If you attempt the installation with an account that has not the required authorization, the installation aborts.

This section informs you about the authorization required for a domain and a local installation.

⚠️ **Caution**

Do not use the user `<sapsid>adm` for the installation of the SAP system.

**Domain Installation**

For a domain installation the account used for the installation needs to be a member of the local **Administrators** and the domain **Admins** group of the domain involved. All machines in the system must belong to the same domain. In a domain installation, the user information is stored centrally on the domain controller and is accessible to all hosts in the system.

If the SAP system is to be distributed across **more than one** machine, SAP strongly recommends you to perform a domain installation to avoid authorization problems.

⚠️ **Caution**

- If you install a distributed system as a local installation, this can lead to authorization problems for the operating system users `<sapsid>adm` and `SAPService<SAPSID>`. It can also lead to problems with the transport directory, which is usually shared by several SAP systems. Therefore, SAP does not support a local installation for a distributed system and recommends you to install a distributed system as a domain installation.
- If you still want to perform a local installation for a distributed system, make sure that:
  - You use the same password for the `<sapsid>adm` or the `SAPService<SAPSID>` user on all hosts.
  - The password for the `<sapsid>adm` and `SAPService<SAPSID>` user can differ.
  - You use the same master password on all hosts.
  - All hosts belong to the same Windows work group.

  [Only valid for: HA (MSCS)]

- In an **MSCS** configuration, you always have to perform a **domain** installation.

  [End of: HA (MSCS)]

- For performance and security reasons, SAP does not support an SAP system installation on a domain controller.
- If for any reason, the account used for the installation is not a member of the domain **Admins** group, you can perform the installation with a domain user who is a member of the local **Administrators** group. However, the domain administrator has to prepare the system appropriately for you.

  For more information, see **Performing a Domain Installation without being a Domain Administrator** [page 49].

For a domain installation, you need to:

1. Check that the account used for the installation is a member of the domain **Admins** group.
2. If required, obtain these rights by asking the system administrator to enter the account as a member of the domain Admins group.

Local Installation
For a local installation the account used for the installation needs to be a member of the local Administrators group of the machine involved. In a local installation, all Windows account information is stored locally on one host and is not visible to any other hosts in the system. If the SAP system is to run on a single machine, you can perform a local installation.
For a local installation, you need to:
1. Check that the account used for the installation is a member of the local Administrators group.
2. If required, obtain these rights by asking the system administrator to enter the account as a member of the local Administrators group.

3.8 Performing a Domain Installation Without Being a Domain Administrator

If for any reason, the account used for the installation is not a member of the domain Admins group, you can perform the installation with a domain user who is a member of the local Administrators group. In this case, the domain administrator has to prepare the system appropriately for you, as described in this section.

Note
You normally perform a domain installation of the SAP system with an user who is a member of the domain Admins group, as described in Required User Authorization for the Installation [page 47]. The domain administrator has to:
1. Create the new global group SAP_<SAPSID>_GlobalAdmin.
2. Create the two new SAP system users <sapid>adm and SAPService<sapid>.
3. Add the users <sapid>adm and SAPService<sapid> to the newly created group SAP_<SAPSID>_GlobalAdmin.

Prerequisites
You must perform this procedure as a domain administrator.

Creating the New Global Group SAP_<SAPSID>_GlobalAdmin
1. Log on as domain administrator.
2. To start the Active Directory Users and Computers Console, choose:
   - Start ➤ All Programs ➤ Administrative Tools ➤ Active Directory Users and Computers ➤
3.8 Performing a Domain Installation Without Being a Domain Administrator

Note
If you cannot find Active Directory Users and Computers, start it as follows:
   a) Choose Start ➤ Run and enter mmc.
   b) Choose Console ➤ Add/Remove Snap-in... ➤ Add.
   c) Select Active Directory Users and Computers.
   d) Choose Add.
   e) Choose Close ➤ OK.


4. Enter the following:
   Group name: SAP_<SAPSID>_GlobalAdmin

Note
Enter the SAP_<SAPSID>_GlobalAdmin group exactly as specified in the correct uppercase and lowercase.

5. Select the following:
   a) Group scope: Global
   b) Group type: Security

6. Choose OK.

Creating the New SAP System Users <sapid>adm and SAPService<SAPSID>

1. In Active Directory Users and Computers Console, right-click Users in Tree and choose:
   ➤ New ➤ User

2. Enter the following:

   Note
   Enter the <sapid>adm and SAPService<SAPSID> user exactly as specified in the correct uppercase and lowercase.

<table>
<thead>
<tr>
<th>Field</th>
<th>Input for &lt;sapid&gt;adm</th>
<th>Input for SAPService&lt;SAPSID&gt;</th>
</tr>
</thead>
<tbody>
<tr>
<td>First name</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>Initials</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>Last name</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>Full name</td>
<td>&lt;sapid&gt;adm</td>
<td>SAPService&lt;SAPSID&gt;</td>
</tr>
<tr>
<td>User logon name</td>
<td>&lt;sapid&gt;adm</td>
<td>SAPService&lt;SAPSID&gt;</td>
</tr>
</tbody>
</table>

3. Choose Next and enter the following:
   Password: <password>
3.9 Preparing the SAP System Transport Host

 Confirm password: <password>

4. Select Password never expires

 Note
Make sure that no other options are selected.

5. Choose Next Finish.

Adding the <sapsid>adm User to the SAP_<SAPSID>_GlobalAdmin Group

1. In the Users folder, double-click the newly created user account <sapsid>adm in the list on the right.
2. Choose Member Add.
3. Select the new SAP_<SAPSID>_GlobalAdmin group and choose Add to add it to the list.

 Note
By default, the user is also a member of the Domain Users group.

4. Choose OK twice.

Adding the SAPService<SAPSID> User to the SAP_<SAPSID>_GlobalAdmin Group

1. In the Users folder, double-click the newly created user account SAPService<SAPSID> in the list on the right.
2. Choose Member Add.
3. Select the new SAP_<SAPSID>_GlobalAdmin group.
4. Choose Add to add it to the list, and then OK.
5. Choose OK to close SAPService<SAPSID> Properties.

3.9 Preparing the SAP System Transport Host

The transport host has a directory structure that is used by the SAP transport system to store transport data and metadata.
When you install an SAP system, SAPInst by default creates the transport directory on the primary application server instance host in \usr\sap\trans.
3.9 Preparing the SAP System Transport Host

Only valid for: HA (MCS)

Note

In an MCS configuration, SAPinst by default creates the transport directory on the (ABAP) central services instance host in \usr\sap\trans.

End of: HA (MCS)

If you do not intend to use the directory structure of the system you are going to install, but want to use another new transport directory or an already existing transport directory, you need to prepare the transport host you are going to use:

- If the directory structure already exists, you must set up its security to allow the new system to write to it.
- If it does not yet exist, you must create the core directory structure and a share to export it for other computers as well as set the security on it.

Procedure

1. If the transport directory does not yet exist, do the following:
   a) Create the directory \usr\sap\trans on the host to be used as the transport host.
   b) Share the \usr\sap directory on the transport host as SAPMNT and put the security settings for Everyone to Full Control for this share.
      This enables SAPinst to address the transport directory in the standard way as \\SAPTRANSHOST\SAPMNT\trans.

2. Grant Everyone the permission Full Control for the transport directory.

Caution

Remove the Full Control to Everyone permission after you have finished the installation with SAPinst and only grant Full Control on this directory to the SAP_<SAPSID>_GlobalAdmin groups of all the systems that are part of your transport infrastructure. SAPinst assigns the appropriate rights with the help of an additional SAP_LocalAdmin group. For more information, see Automatic Creation of Accounts and Groups [page 108].

Note

If, during the installation with SAPinst, you select the check box SAP System will be under NWDI control on the SAPinst screen SAP System NWDI Landscape, SAPinst copies all SCAs belonging to the usage types or software units that you installed to the global transport directory. For more information, see:

http://help.sap.com\ <your product> \ SAP NetWeaver Library \ Administrator's Guide \ Software Life Cycle Management \ Software Logistics \ SAP NetWeaver Development Infrastructure \ Maintenance of an NWDI-Driven System Landscape
3.10 Generating the SAP Solution Manager Key

The SAP Solution Manager is the strategic application management platform for customers and for collaboration between customers and SAP. You need a SAP Solution Manager to upgrade or install all SAP software.

During the installation of the primary application server instance, you are prompted to enter the SAP Solution Manager Key.

You can generate all needed keys for your entire system landscape — development, quality assurance, and production systems — in one SAP Solution Manager system. Even if you plan to install several solution landscapes (for example in different countries), one SAP Solution Manager is still sufficient.

For more information about SAP Solution Manager, see [http://service.sap.com/solutionmanager](http://service.sap.com/solutionmanager).

Prerequisites

- You require at least SAP Solution Manager 4.0 Support Package Stack (SPS) 9.
- If required, you can install SAP Solution Manager:
  - You order SAP Solution Manager as described in SAP Note [628901](http://service.sap.com/solutionmanager).
  - You install SAP Solution Manager as described in the documentation Installation Guide — SAP Solution Manager 4.0 on <OS>: <Database> on SAP Service Marketplace at:
    - [http://service.sap.com/instguides](http://service.sap.com/instguides)

Procedure

1. In your SAP Solution Manager system, call transaction SMSY (System Landscape Maintenance).
2. To create your SAP system in the system landscape, proceed as follows:
   a) Select the landscape component Systems and choose Create New System from the context menu.
   b) Enter the system ID in the dialog box as the system.
   c) Select the relevant product and the corresponding product version from the input help and choose Save.
   d) Fill in the system data as much as possible.
      - For more information, see the online help at [Help & Application Help](http://service.sap.com/solutionmanager).
   e) Save your entries.
3. To generate the key, choose Other object... from the menu System Landscape.
4. Set the indicator System and choose the system that you want to install from the input help.
   - If you created the system in the SAP Solution Manager in the previous step, choose this system.
5. Choose Generate Installation / Upgrade Key.
6. Enter the requested information.
7. Choose Generate Key.

Result

The system displays the key. Enter this key during the input phase of the installation.
More Information
For more information, see also SAP Notes 805390 and 811923.

3.11 Preparing the Installation DVDs

This section describes how to prepare the installation DVDs, which are available as follows:

- You obtain the installation DVDs as part of the installation package, which is the normal case.
- You download the installation DVDs from SAP Service Marketplace, as described at the end of this section.

The tables below list the installation DVDs that are required for each instance of your SAP system. Depending on your installation type, one or more instances can reside on the same host. You need to keep this in mind when you make the required installation media available on each installation host.

We recommend that you make all required DVDs available in parallel.

Caution
If you perform a local installation and you have only one DVD drive on your installation host, you must copy at least the Installation Master DVD locally on your computer.

Caution
- If you copy the installation DVDs to disk, make sure that the paths to the location of the copied DVDs do not contain any blanks.
- If you use network drives for mounting the Export DVDs, make sure that the <sapsid>adm user has access to the UNC paths of the network drives. If the user does not yet exist, you have to create it manually [page 49] before you install the database instance.

1. Identify the required DVDs for your installation as listed below and keep them separate from the remaining DVDs. This helps you to avoid mixing up DVDs during the installation.

Caution
The media names listed in the tables below are abbreviated.

Note
You can find the Software Component Archives (SCAs) for the installation of SAP NetWeaver usage types on the NetWeaver Java DVD.
The following table shows the required DVDs for the installation of a productive system of SAP NetWeaver Composition Environment:

<table>
<thead>
<tr>
<th>SAP Instance Installation</th>
<th>Required DVDs</th>
</tr>
</thead>
</table>
| Central services instance, primary application server instance, additional application server instance | • Installation Master DVD  
• NetWeaver Java DVD  
• RDBMS Client DVD  
• RDBMS DVD  
• Kernel DVD |
| Database instance | • Installation Master DVD  
• NetWeaver Java DVD  
• Kernel DVD  
• RDBMS DVD |

Host Agent (Standalone)

<table>
<thead>
<tr>
<th>SAP Instance Installation</th>
<th>Required DVDs</th>
</tr>
</thead>
</table>
| Host Agent | • Installation Master DVD  
• Kernel DVD |

2. Use one of the following methods to make DVDs available in parallel:
   - Before the installation:
     - Have sufficient DVD drives
     - Copy DVDs manually to local hard disks
   - During the installation:
     - Use the SAPinst Media Browser dialog. You can check the entered location and then copy the entire DVD to the path you entered in the Copy Package to column.

**Downloading Installation DVDs from SAP Service Marketplace (Optional)**

You normally obtain the installation DVDs as part of the installation package from SAP. However, you can also download installation DVDs from SAP Service Marketplace at:

http://service.sap.com/swdc Downloads > Installations and Upgrades > Entry by Application Group > <your solution> > <release of your solution> > <your operating system> > <your database>.

**Note**

If you download installation DVDs, note that DVDs might be split into several files. In this case, you have to reassemble the required files after the download.
Caution

To extract the downloaded SAR files make sure that you use the latest SAPCAR version, which you can find on SAP Service Marketplace at http://service.sap.com/swdc. You need at least SAPCAR 700 or SAPCAR 640 with patch level 4 or higher because older versions of SAPCAR can no longer unpack current SAR files. For more information, see SAP Note 212876.

1. Create a download directory on the host on which you want to run SAPinst.
2. Identify all download objects that belong to one installation DVD according to one or both of the following:
   - Material number
     All download objects that are part of an installation DVD have the same material number and an individual sequence number:
     \(<material\_number>\_<sequence\_number>\)

     Example
     51031387_1
     51031387_2
     ...

   - Title
     All objects that are part of an installation DVD have the same title, such as
     \(<solution><DVD\_name><OS>\) or \(<database>RDBMS<OS>\) for RDBMS DVDs.

3. Download the objects to the download directory.
4. Extract the individual download objects using SAPCAR, starting with the lowest sequence number – for example 51031387_1, then 51031387_2, and so on.
   During the download SAPCAR sets up the structure of the installation DVD.

   Note
   SAPCAR asks if you want to replace existing files, for example LABELIDX.ASC. Always accept with Yes.
4 Installation

This section includes the installation steps that you have to perform for the:

- Standard system
- Distributed system
  
  Only valid for: HA (MSCS)
- High-availability system
  
  End of: HA (MSCS)
- Additional application server instance
- Host agent

Standard System

1. You install the SAP system with SAPinst [page 58].

   ![Note]
   
   In a standard system all mandatory instances are installed on one host in one installation run.

2. You can now continue with Post-Installation [page 71].

Distributed System

1. On the host where the primary application server instance is to run, you run SAPinst [page 58] to install the central services instance.
2. On the database instance host, you run SAPinst [page 58] to install the database instance.
3. On the primary application server instance host, you run SAPinst [page 58] to install the primary application server instance.
4. If required, on the additional application server instance host(s), you install the additional application server instance(s) (see below).
5. You can now continue with Post-Installation [page 71].

   Only valid for: HA (MSCS)

High-Availability System

If you want to perform a Microsoft Cluster Service (MSCS) installation, see Installation [page 131] in chapter High Availability with Microsoft Cluster Service.

1. You perform the MSCS-specific installation steps [page 131].
2. You can now continue with Post-Installation [page 71].

Additional Application Server Instance(s)
You perform the following steps on each host where you install the additional application server instance(s).

1. You run SAPInst [page 58] to install the additional application server instance(s).

```
Console output:
```

<table>
<thead>
<tr>
<th>Caution</th>
</tr>
</thead>
</table>

In a high-availability system, you must install at least one additional application server instance.

```
End of: HA (MSCS)
```

2. You can now continue with Post-Installation [page 71].

Installation Steps for Additional Components and Tools for SAP NetWeaver CE (Optional)

- You install additional components [page 66] for SAP NetWeaver Composition Environment, such as
  - Composition Tools
  - Adobe Document Services
  - Composite Voice
  - IDE Update Site

Host Agent on a Host without an SAP Component

1. You run SAPInst [page 58] to install the Host Agent.
2. You can now continue with Post-Installation [page 71].

### 4.1 Running SAPInst

This procedure tells you how to install an SAP system with SAPInst. SAPInst includes a SAPInst GUI and a GUI server, which both use Java.

This section describes an installation where SAPInst, SAPInst GUI, and the GUI server are running on the same host. If required, you can instead perform a remote installation with SAPInst [page 101], where SAPInst GUI is running on a separate host from SAPInst and the GUI server.

When you start SAPInst, SAPInst GUI and the GUI server also start. SAPInst GUI connects via a secure SSL connection to the GUI server and the GUI server connects to SAPInst.
Note the following information about SAPInst:

- SAPInst normally creates the installation directory `sapinst_instdir`, where it keeps its log files, and which is located directly in the Program Files directory. If SAPInst is not able to create `sapinst_instdir` there, it tries to create `sapinst_instdir` in the directory defined by the environment variable TEMP.

  **Recommendation**
  
  We recommend that you keep all installation directories until the system is completely and correctly installed.

- SAPInst creates a subdirectory for each installation option called `<sapinst_instdir>\<installation_option_directory>`, which is located in `%ProgramFiles%\`. The SAPInst Self-Extractor extracts the executables to a temporary directory (TEMP, TMP, TMPIR, or SystemRoot). These executables are deleted after SAPInst has stopped running. Directories called `sapinst_exe.xxxxxx.xxxx` sometimes remain in the temporary directory. You can safely delete them. The temporary directory also contains the SAPInst Self-Extractor log file `dev_selfex.out`, which might be useful if an error occurs.

  **Caution**
  
  If SAPInst cannot find a temporary directory, the installation terminates with the error FCO-00058.

- During the installation, the default ports 21200, 21212, and 4239 are used for communication between SAPInst, GUI server, SAPInst GUI, and HTTP server. SAPInst uses port 21200 to communicate with the GUI server. The GUI server uses port 21212 to communicate with SAPInst GUI. 4239 is the port of the HTTP server, which is part of the GUI server. You get an error message if one of these ports is already in use by another service. In this case, open a command prompt and change to the required directory as follows:

  `<DVD drive>:\DATA_UNITS\IM_WINDOWS_<platform>`.

  Enter the following command in a single line:

  ```
  sapinst.exe SAPINST_DIALOG_PORT=<free_port_number_sapinst_to_gui_server>
  GUISERVER_DIALOG_PORT=<free_port_number_gui_server_to_sapinst_gui>
  GUISERVER_HTTP_PORT=<free_port_number_http_server>
  ```

- To get a list of all available SAPInst properties, go to the directory (`%TEMP%\sapinst_exe.xxxxxx.xxxx`), after you have started SAPInst, and enter the following command:

  ```
  sapinst.exe -p
  ```

- If you want to terminate SAPInst and the SAPInst Self-Extractor, choose one of the following options:

  - Right-click the icon for the SAPInst output window located in the Windows tray and choose **Exit**.
• Click the icon for the SAPinst output window located in the Windows tray and choose File → Exit ‣.

Using SAPinst GUI

The following table shows the most important functions that are available in SAPinst GUI:

<table>
<thead>
<tr>
<th>Input Type</th>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Function key</td>
<td>F1</td>
<td>Displays detailed information about each input parameter</td>
</tr>
<tr>
<td>Menu option</td>
<td>‣ File ‣ Exit ‣</td>
<td>Stops the SAPinst GUI, but SAPinst and the GUI server continue running</td>
</tr>
<tr>
<td>Note</td>
<td></td>
<td>If you need to log off during the installation from the host where you control the installation with SAPinst GUI, the installation continues while you are logged off. You can later reconnect to the same SAPinst installation from the same or another host. For more information, see Starting SAPinst GUI Separately [page 102].</td>
</tr>
<tr>
<td>Menu option</td>
<td>‣ SAPinst ‣ Log Viewer ‣</td>
<td>Displays the Log Viewer dialog</td>
</tr>
<tr>
<td></td>
<td></td>
<td>This dialog enables you to access the following log files directly:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Installation log (sapinst_dev.log)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Log files from the SAPinst GUI server</td>
</tr>
<tr>
<td></td>
<td></td>
<td>These log files might help you during troubleshooting with SAPinst [page 105].</td>
</tr>
<tr>
<td>Menu option</td>
<td>‣ SAPinst ‣ Cancel ‣</td>
<td>Cancels the installation with the following options:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Stop</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Stops the installation (SAPinst GUI, SAPinst and the GUI server) without further changing the installation files.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>You can restart and continue the installation later from this point.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Continue</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Continues the installation</td>
</tr>
<tr>
<td>Button</td>
<td>Retry</td>
<td>Performs the installation step again (if an error has occurred)</td>
</tr>
<tr>
<td>Button</td>
<td>Stop</td>
<td>Stops the installation without further changing the installation files.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>You can continue the installation later from this point.</td>
</tr>
<tr>
<td>Button</td>
<td>Continue</td>
<td>Continues with the option you have chosen before</td>
</tr>
</tbody>
</table>
Prerequisites

- You use an account with the required user authorization to install the SAP system with the SAPinst tool [page 47].
- You need at least 130 MB of free space in the installation directory for each Java installation option. In addition, you need 60-200 MB free space for the SAPinst executables.
- Make sure that you have defined the most important SAP system parameters as described in Basic SAP System Parameters [page 26] before you start the installation.
- Check that your installation host(s) meets the requirements for the installation option(s) that you want to install. For more information, see Running the Prerequisite Checker [page 34].
- If you are installing a second or subsequent SAP system in an existing database, make sure that the database is up and running before starting the installation. For more information, see Installation of Multiple Components in One Database [page 22].

Procedure

1. Insert the SAP Installation Master DVD into your DVD drive or mount it locally.
2. Start SAPinst from the SAP Installation Master DVD by double-clicking sapinst.exe from the following path:
   `<DVD drive>\DATA_UNITS\IM_WINDOWS_<platform>`
   SAPinst GUI starts automatically by displaying the Welcome screen. However, if there is only one component to install, SAPinst directly displays the first input dialog without presenting the Welcome screen.
3. In the Welcome screen, choose the required SAPinst installation option [page 62] from the tree structure.

   **Note**
   If you want to use the following installation options listed under Software Life-Cycle Options, you must start them before you start the installation of the SAP system:
   - Operating System Users and Groups
     Choose this option, if the operating system users do not yet exist and you do not want to create them manually.

   **Note**
   Make sure that you have the required user authorization [page 47] for these accounts before you start the installation.

4. If SAPinst prompts you to log off from your system, log off and log on again. SAPinst restarts automatically.
5. Follow the instructions in the SAPinst dialogs and enter the required parameters.
For more information about the input parameters, position the cursor on the required parameter and press \[F1\].

6. To start the installation choose Start.
   SAPinst starts the installation and displays the progress of the installation. When the installation has successfully completed, SAPinst shows the dialog **Execution of <Option_Name> has been completed successfully.**

7. If you want to install an additional application server instance for a standard (central) or distributed system, choose the installation option \[<SAP System> \[Software Life-Cycle Options \[Additional Application Server Instances \[Additional application server instance \[.\]

8. We recommend deleting all files in the directory %userprofile%\sdgui\.

---

**More Information**

- **Interrupted Installation with SAPinst** [page 99]
- **Performing a Remote Installation with SAPinst (Optional)** [page 101]
- **Starting SAPinst GUI Separately (Optional)** [page 102]
- **Entries in the Services File Created by SAPinst** [page 104]
- **How to Avoid Automatic Logoff by SAPinst** [page 104]
- **Troubleshooting with SAPinst** [page 105]

---

### 4.2 SAPinst Installation Options

This section provides information about the following installation options in SAPinst:

- **Installation Options**
- **Software Life-Cycle Options**

**Note**

- Choose the required installation options from the tree structure **exactly** in the order they appear for each system variant.
- If required, install an additional application server instance for a standard system (all instances on one host) or distributed system by choosing \[<SAP System> \[Software Life-Cycle Options \[Additional Application Server Instance \[Additional Application Server Instance \[.
- If required, install additional CE components by choosing \[<SAP System> \[Software Life-Cycle Options \[Additional CE Components \[Additional CE components \[.
- If required, install SAP Memory Analyzer by choosing \[<SAP System> \[Software Life-Cycle Options \[SAP Memory Analyzer \[SAP Memory Analyzer \[.
### Installation Options

You choose *SAP Systems with <your database>* to install a SAP system with usage types or software units. You can install the following system variants:

#### Standard System

**Installation Options for a Standard System**

<table>
<thead>
<tr>
<th>Installation Option</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard System</td>
<td>Installs a complete SAP system including the following instances on one host:</td>
</tr>
<tr>
<td></td>
<td>- Central services instance (SCS)</td>
</tr>
<tr>
<td></td>
<td>- Database instance</td>
</tr>
<tr>
<td></td>
<td>- Primary application server instance</td>
</tr>
<tr>
<td></td>
<td>You can install a standard system in the following parameter modes:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Typical Mode</strong></td>
</tr>
<tr>
<td></td>
<td>If you choose <em>Typical</em>, automatic default settings will be provided. You only have to respond to a small selection of prompts. However, you can change any of the default settings on the parameter summary screen.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Custom Mode</strong></td>
</tr>
<tr>
<td></td>
<td>If you choose <em>Custom</em>, all installation parameter will be</td>
</tr>
<tr>
<td></td>
<td>prompted. In the end, you can still change any of these parameters on the parameter summary screen.</td>
</tr>
</tbody>
</table>

**Note**

You require at least usage type AS Java or AS ABAP. You can choose the usage types or software units on the next screen.

#### Distributed System

**Installation Options for a Distributed System**

<table>
<thead>
<tr>
<th>Installation Options</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central Services Instance (SCS)</td>
<td>Installs a central services instance (SCS) and prepares the SAP global host.</td>
</tr>
<tr>
<td></td>
<td>Mandatory step in installing a distributed SAP system with usage types or software units based on <em>AS Java</em>.</td>
</tr>
</tbody>
</table>
## SAPinst Installation Options

<table>
<thead>
<tr>
<th>Installation Options</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database Instance</td>
<td>Installs a database instance. Mandatory step in installing a distributed SAP system. You must have finished the Central Services Instance (SCS) installation, before you can choose this installation option.</td>
</tr>
<tr>
<td>Primary Application Server Instance</td>
<td>Installs a primary application server instance and enables additional software units. Mandatory step in installing a distributed SAP system on several hosts. You must have finished the database instance installation.</td>
</tr>
</tbody>
</table>

### High-Availability System

#### Installation Options for a High Availability System

<table>
<thead>
<tr>
<th>Installation Options</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central Services Instance (SCS)</td>
<td>Installs a central services instance (SCS)</td>
</tr>
<tr>
<td>First MSCS Node</td>
<td>Performs the following steps on the first Microsoft Cluster Service (MSCS) node:</td>
</tr>
<tr>
<td></td>
<td>- Creates the SAP cluster group</td>
</tr>
<tr>
<td></td>
<td>- Adds the ASCS and SCS instances to the SAP cluster group</td>
</tr>
<tr>
<td></td>
<td>- Adds the SCS instance to the SAP cluster group</td>
</tr>
<tr>
<td></td>
<td>- Adds the ASCS instance to the SAP cluster group</td>
</tr>
<tr>
<td>Database Instance</td>
<td>Installs a database instance</td>
</tr>
<tr>
<td>Host Agent</td>
<td>Installs the host agent</td>
</tr>
<tr>
<td>Additional MSCS Node</td>
<td>Configures an additional Microsoft Cluster Service (MSCS) node to run the SAP cluster group. You must have completed the configuration of the first MSCS node and the database instance installation.</td>
</tr>
<tr>
<td>Enqueue Replication Server Instance</td>
<td>Installs an enqueue replication server, which contains a replica of the lock table (replication server)</td>
</tr>
</tbody>
</table>

*Only valid for: HA (MSCS); HA (UNIX); HA (z/OS)*

*End of: HA (MSCS)*
### Installation Options

<table>
<thead>
<tr>
<th>Primary Application Server Instance</th>
<th>Installs a primary application server instance and enables additional usage types or software units</th>
</tr>
</thead>
<tbody>
<tr>
<td>Additional Application Server Instance</td>
<td>Installs an additional application server instance</td>
</tr>
</tbody>
</table>

**Note**

You require at least one additional application server instance in a high-availability system configured with MCS.

### Software Life-Cycle Options

You use the options located in this folder to perform the following tasks or to install the following components:

<table>
<thead>
<tr>
<th>Installation Option</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Additional Preparations</td>
<td><img src="https://example.com" alt="Host Agent" /> Additional Preparations <img src="https://example.com" alt="Host Agent" /> <img src="https://example.com" alt="Host Agent" /> to install the host agent with the profiles SAPSystem=99 and SAPSystemName=SAP. The host agent contains all of the required elements for centrally monitoring any host. Normally you do not need to install the host agent separately, because it is automatically installed during the installation of all SAP NetWeaver components, except TREX. You only need to install the host agent separately in the following cases: • You want to centrally monitor a host that does not have an SAP component. • You want to perform an upgrade to SAP NetWeaver. For more information, see Host Agent as a Separate Installation [page 17]. <img src="https://example.com" alt="Operating system users and groups" /> Creates all operating system users for your SAP system if they do not yet exist. <img src="https://example.com" alt="Caution" /> Perform this SAPinst option <strong>before</strong> you start the installation of your SAP system. • Make sure that you have the required <strong>user authorization</strong> [page 4] for these accounts before you start the installation. <img src="https://example.com" alt="Prerequisites check" /> Additional Preparations <img src="https://example.com" alt="Prerequisites Check" /> if you want to check your hardware and software requirements <strong>before</strong> you start the installation. Otherwise, SAPinst automatically checks the hardware and software requirements during the installation with the Prerequisite Checker. If any changes are necessary to the SAP system or operating system settings,</td>
</tr>
</tbody>
</table>
### 4.3 Installing Additional Components (Optional)

You can install the following additional components:

- Composition Tools
- Adobe Document Services
- Composite Voice
- IDE Update Site

#### Prerequisites

You need to fulfill the same hardware and software requirements as for your already installed production system plus an additional 2 GB RAM.
4.3 Installing Additional Components (Optional)

Note

- Before installing additional components, you need to stop all application servers manually.
- Before installing additional components and in the case that you made changes to the default template settings, see SAP Note 953763.

Prerequisites for MaxDB

- Make sure that the Application Server Java and its corresponding database is running.
- You can stop and start the system using the shortcuts under Start All Programs SAP NetWeaver Composition Environment 7.1 Application Server Jax<SID>.
- During the installation of additional components, entries are written into the log area of the database. To avoid that the log is running full during the installation, make sure that your backup strategy is already active and an initial data backup was successful.
- When you want to establish your backup strategy after installing additional components, you can turn on the special log mode AutoOverwrite using the Database Manager GUI. This interrupts the existing backup history. You have to run a complete backup to start the history again.

Procedure

Note

When installing from a network share make sure that everyone has read access to this share. The installation routine creates users such as <sid>adm (for example, ce1adm). During the installation SAPInst does a user switch to this user. If the newly created user does not have permissions to the network share where the installation is running from, the installation will fail.

1. Insert the SAP Installation Master DVD into your DVD drive or mount it locally.
2. Run SAPInst [page 58].
3. In the Welcome screen, choose SAP NetWeaver CE Productive System Software Life-Cycle Options Additional CE Components Install Additional Components.
4. Choose whether you want to run the installation in Typical mode or in Custom mode.
   - If you select Typical, the installation wizard provides automatic default settings and you only have to respond to a small selection of prompts. The rest is set by default. If you select Custom, you have to respond to all prompts.

Note

If you want to install the offline documentation for SAP NetWeaver CE, you need to choose Custom mode.

After the installation, you can access the offline documentation by choosing Start All Programs SAP NetWeaver Composition Environment <SID>.

5. Follow the screens and enter the required parameters.
2. Consume the tool, network.

4.4 Procedure

1. Insert the SAP Installation Master DVD into your DVD drive or mount it locally.
2. Run SAPinst [page 58].
3. In the Welcome screen, choose SAP NetWeaver CE Productive System ➤ Software Life-Cycle Options ➤ SAP Memory Analyzer ➤ Install SAP Memory Analyzer.
4. Choose whether you want to run the installation in *Typical* mode or in *Custom* mode.
   If you select *Typical*, the installation wizard provides automatic default settings and you only have to respond to a small selection of prompts. The rest is set by default. If you select *Custom*, you have to respond to all prompts.

   **Note**

   If you want to install the offline documentation for SAP NetWeaver CE, you need to choose *Custom* mode.

   After the installation, you can access the offline documentation by choosing ➤ *Start* ➤ *All Programs* ➤ *SAP NetWeaver Composition Environment* ➤ *<SID>*.

5. Follow the screens and enter the required parameters.

   **Note**

   For more information about the input parameters and information about restrictions for passwords, position the cursor on the required parameter and press **F1**.

   After you have entered all requested input parameters, SAPinst displays the *Parameter Summary* screen. This screen shows both the parameters that you entered and those that SAPinst set by default. If required, you can revise the parameters before starting the installation.

6. To start the installation, choose *Start*. SAPinst starts the installation and displays the progress of the installation. When the installation has successfully been completed, SAPinst shows the dialog *Execution of <Service_Name> has been completed successfully.*
This page is intentionally left blank.
5 Post-Installation

This section includes the post-installation steps that you have to perform for the:

- Standard, distributed or high-availability system
- Additional application server instance
- Host agent as a separate installation

Post-Installation Steps for a Standard, Distributed, or High-Availability System

Note

In a standard system, all mandatory instances are installed on one host. Therefore, if you are installing a standard system, you can ignore references to other hosts.

1. If required, you perform a full system backup [page 90] immediately after the installation has finished.
2. You check whether you can log on to the SAP system [page 72].

Note

In a distributed or high-availability system you check whether your can log on to every instance of the SAP system that you installed.

3. You ensure user security [page 82].
4. You install the SAP license [page 73].
5. You configure the remote connection to SAP support [page 74].
6. If required, you install MaxDB administration tools [page 75].
7. If required, you install Secure Sockets Layer (SSL) for MaxDB [page 77].
8. You back up the MaxDB database [page 81].
9. You update the database software to the current release [page 81].
10. On the primary application server instance host, you apply the latest kernel and Support Packages [page 74].
11. You check the Java manuals [page 86] for information that is relevant for running your Java system.
12. You perform CE-specific post-installation steps [page 87].
13. You perform a full system backup [page 90].

Post-Installation Steps for an Additional Application Server Instance

1. You check whether you can log on to the additional application server instance [page 72].
2. You perform a full system backup [page 90].
Post-Installation Steps for the Host Agent as a Separate Installation
You perform the post-installation steps for the Host Agent [page 85].

5.1 Logging On to the Application Server

You need to check that you can log on to the application server using the following standard users:

Java Standalone Users

<table>
<thead>
<tr>
<th>User</th>
<th>User Name Storage: Database</th>
<th>User Name Storage: External ABAP System</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator</td>
<td>Administrator</td>
<td>You create this user manually during the installation process.</td>
</tr>
</tbody>
</table>

**Recommendation**
We recommend that you call the user J2EE_ADM_<SAPSID_Java_System> The maximum length is 12 characters.

Prerequisites

- The SAP system is up and running.

Logging On to the Java Application Server
You access AS Java with a URL using a Web browser from your client machines. To log on to the Java application server, proceed as follows:

1. Start a Web browser and enter the following URL:

   [http://<hostname_of_Java EE_Engine_Server>:5<Instance_Number>00](http://<hostname_of_Java EE_Engine_Server>:5<Instance_Number>00)

   **Note**
   You must always enter a two-digit number for `<Instance_Number>`. For example, do **not** enter 1 but instead enter 01.

   **Example**
   If you installed the SAP NetWeaver Application Server Java on host saphost06 and the instance number of your SAP NetWeaver Application Server Java is 04, enter the following URL:

   [http://saphost06:50400](http://saphost06:50400)

   The start page of the SAP NetWeaver Application Server Java appears in the Web browser.
2. Log on by pressing the icon of any of the provided applications, for example the SAP NetWeaver Administrator.

### 5.2 Installing the SAP License

You must install a **permanent** SAP license. When you install your SAP system, a **temporary** license is automatically installed. This temporary license allows you to use the system for **only four weeks** from the date of installation.

- **Caution**

  **Before** the temporary license expires, you must apply for a permanent license key from SAP. We recommend that you apply for a permanent license key as soon as possible after installing your system.

- **Procedure**

  For information about the installation procedure for the SAP license, see:


  Only valid for: HA (MSCS)

- **Note**

  The license key is bound to the hardware key of the host where the message server is running. In a high-availability system with MSCS, the message server is part of the (A)SCS instance that can run on different MSCS node. Therefore you must install the SAP license on both nodes. You have to do failover from the first MSCS node where the (A)SCS instance is installed to the second MSCS node. Use the hardware key of the second MSCS node for the installation of the second SAP license.

  End of: HA (MSCS)

- **More Information**

  For more information about SAP license keys and how to obtain them, see SAP Service Marketplace at [http://service.sap.com/licensekey](http://service.sap.com/licensekey).

### 5.3 Configuring the Transport Management System

You have to perform some steps to be able to use the Transport Management System.
Procedure

1. Perform post-installation steps for the transport organizer:
   a) Call transaction SE06.
   b) Select Standard Installation.
   c) Choose Perform Post-Installation Actions.
2. Call transaction STMS in your SAP Solution Manager system to configure the domain controller in the Transport Management System (TMS).
   
   | Only valid for: HA (MSCS) |

3. In a high-availability system with MSCS, you must configure all systems in the TMS landscape. To do this implement SAP Note 943334.
   
   | End of: HA (MSCS) |

Result

You can now perform Java transports in the TMS of your SAP Solution Manager system.

More Information

For more information, see the SAP Library at [http://help.sap.com](http://help.sap.com) <your product> SAP NetWeaver Library SAP NetWeaver Library: Function-Oriented View Application Server ABAP Administration Tools for AS ABAP Change and Transport System

5.4 Configuring the Remote Connection to SAP Support

SAP offers its customers access to support and a number of remote services such as the EarlyWatch Service or the GoingLive Service. Therefore, you have to set up a remote network connection to SAP. For more information, see SAP Service Marketplace at [http://service.sap.com/remoteconnection](http://service.sap.com/remoteconnection).

5.5 Applying the Latest Kernel and Support Packages

You have to apply the latest kernel and Support Packages for your SAP system from SAP Service Marketplace.

Caution

Before you apply support packages, make sure that you read the release notes for your SAP system. You can find these on SAP Service Marketplace at [http://service.sap.com/releasenotes](http://service.sap.com/releasenotes). The release notes might include information about steps you have to perform after you have applied the support packages.
5.6 Installing Administration Tools for MaxDB

Procedure


Note

The file CR_Content.zip contains all available SAP components, and its content grows with time. The extensions contain information about new components (new releases and Support Packages, for example). This content in the SLD has to be updated from time to time. You can download the most up-to-date files from the SAP Service Marketplace. For more information, see SAP Note 669669.

For more information, see also Updating SAP NetWeaver Composition Environment [page 91]

5.6 Installing Administration Tools for MaxDB

This section describes how to install the following administration tools for MaxDB and SAP liveCache on Windows front ends:

- Database Manager GUI
  You can use Database Manager GUI to administer databases, including remote ones.
- SQL Studio (GUI)
  You can use SQL Studio (GUI) to send SQL statements to the database and evaluate the results.

For more information on these tools, see the following documentation:

- Database Manager GUI
- SQL Studio (GUI)

You can find this documentation as well as information about additional MaxDB tools at:


Prerequisites

- You can install these administration tools on any Windows PC in your network, even if your database runs on UNIX. From the PC with the installed administration tool, you can then administer the database or send queries to it.
- Your PC must meet the following minimum operating system requirements:
5 Post-Installation
5.6 Installing Administration Tools for MaxDB

Installing Administration Tools for MaxDB

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows NT</td>
<td>4.0 SP 4</td>
</tr>
<tr>
<td>Windows 2000</td>
<td>Any</td>
</tr>
<tr>
<td>Windows 2003</td>
<td>Any</td>
</tr>
</tbody>
</table>

- Your PC must meet the following minimum hardware requirements:
  - Pentium II
  - 64 MB RAM
  - 100 MB disk space
- You can get the required files from one of the following:
  - The MaxDB RDBMS or SAP liveCache DVD
  - By downloading from SAP Service Marketplace at:
    - [http://service.sap.com/patches](http://service.sap.com/patches) ➤ Entry by Application Group ➤ Additional Components ➤ MaxDB ➤ MaxDB GUI COMPONENTS/TOOLS

**Caution**

If MaxDB or liveCache is installed on the PC, you must **not** install the administration tools in the same directory. You can check the directories used by MaxDB or liveCache as follows:

```bash
dbmcli -d <DBSID> -u <controluser>,<password> dbm_getpath
IndepDataPath
dbmcli -d <DBSID> -u <controluser>,<password> dbm_getpath
IndepProgPath
```

**Procedure**

1. Start the installation as follows:
   - If you are using the MaxDB RDBMS DVD:
     - DBMGUI
       ```bash
       <DVD>:\MaxDB_Windows_<Processor>\SETUPS\DBM76.EXE
       ```
     - SQL Studio
       ```bash
       <DVD>:\MaxDB_Windows_<Processor>\SETUPS\SQLSTD76.EXE
       ```
   - If you are using the liveCache DVD:
     - DBMGUI
       ```bash
       <DVD>:\LC_Windows_<Processor>\SETUPS\DBM76.EXE
       ```
     - SQL Studio
       ```bash
       <DVD>:\LC_Windows_<Processor>\SETUPS\SQLSTD76.EXE
       ```
   - If you are using the files from SAP Service Marketplace, simply execute the downloaded .EXE file.

An installation shield guides you through the installation.
Note
If you already have an older version of the administration tools installed on the PC, the installation shield offers to upgrade it for you.

2. If you are prompted to restart the PC after the installation, make sure that you first bring down any databases that are running as follows:
   
   `dbmcli -d <DBSID> -u <controluser>;<password> db_offline`

### 5.7 Secure Sockets Layer Protocol for Database Server Communication

The MaxDB database server supports the Secure Sockets Layer (SSL) protocol. You can use this protocol to communicate between the database server and its client, here the Application Server (AS). SSL guarantees encrypted data transfer between the MaxDB database server and its client applications. In addition, the server authenticates itself to the client.

Caution
There is a performance cost for SSL since the data has to be encrypted, which requires time and processing power.

To use SSL you need to:

1. Install the SAP cryptographic library [page 77] on the client host and on the server host machines
2. Generate the Personal Security Environment [page 79] (PSE) on the server (SSL Server PSE) and on the client (SSL Client PSE).

### 5.7.1 Installing the SAP Cryptographic Library

The cryptographic functions required to build a database server-client connection using Secure Sockets Layer (SSL) protocol are supplied by the SAP Cryptographic Library. Therefore, you need to install the SAP Cryptographic Library on the host machine of the MaxDB database server and the SAP Application Server (AS).

The installation package `sapcrypto.car` consists of the following:

- SAP Cryptographic Library `sapcrypto.dll`
- License ticket `ticket`
- Configuration tool `sapgenpse.exe`

You use the configuration tool to generate key pairs and PSEs.
Caution
The SAP Cryptographic Library is subject to German export regulations and might not be available to some customers. In addition, the library might be subject to the local regulations of your country. These regulations might further restrict import, use, and export or re-export of cryptographic software.
For more information, contact your local SAP representative.

Prerequisites
Download the appropriate SAP Cryptographic Library installation package for your operating system from SAP Service Marketplace at http://service.sap.com/swcenter.

Procedure
1. Unpack the installation package for the SAP Cryptographic Library using sapcar.exe, which you can find for example on your Installation Master DVD, using the following command:
   
   car -xvf SAPCRYPTO.CAR

   Note
   The remainder of the procedure, as described below, does not apply to client applications such as SQL Studio, which do not recognize an “independent” directory. In this case, you must copy the SAPCRYPTO installation package to the installation directory of the application. In this directory you need to create a directory sec, into which you copy the ticket file.

2. Copy the sapprotoo library to the lib subdirectory of the “independent program” directory.
   You can find the value of the independent program directory by entering the following command:
   
   dbmcli dbm_getpath IndepProgPath

   Example
   The independent program directory might be called the following:
   <drive>:\sapdb\programs\lib

3. Copy the configuration tool sappgenpse.exe to the directory <independent program>\lib.
4. Create a subdirectory called sec under the “independent data” directory and copy the ticket file into it.

   Example
   The result might look like the following:
   <drive>:\sapdb\data\sec\ticket

5. Make sure that only the local system account is allowed to possess access rights to the sec directory and the files it contains— including the ticket file and the SSL Server PSE—and that access is restricted to read&write. Only members of the administrator group can own the files.
Result
The SAP Cryptographic Library is copied to the application server and the environment is correctly configured so that the server can find the library at run time.

5.7.2 Generating the Personal Security Environment

The information required by the database server or client application to communicate using Secure Sockets Layer are stored in the Personal Security Environment (PSE). The required information differs according to whether SSL PSE is for the server or client:

- SSL Server PSE
  This PSE contains the security information from the database server, for example, the public-private cryptographic key pair and certificate chain. To install the SSL Server PSE you need to generate the PSE. You can either do this for a single database server or system-wide. The SSL Server PSE is called SDBSSLs.exe.

- SSL Client PSE
  The client requires an anonymous certificate called SDBSSLA.exe, which contains the list of the public keys of trustworthy database servers.

Procedure
To generate the SSL Server PSE, proceed as follows:

<table>
<thead>
<tr>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>You need to know the naming convention for the distinguished name of the database server. The syntax of the distinguished name, which you enter in the procedure below, depends on the Certification Authority (CA) that you are using.</td>
</tr>
</tbody>
</table>

1. Change to the <independent programs>\lib directory.
2. Set up the following environment variable:
   \SECUDIR=<independent data>\sec
3. Create an SSL Server PSE, SDBSSLs.pse, and generate a certificate request file, certreq, in the directory defined by SECUDIR (see previous step):
   \sapgenpse gen_pse -v -r <SECUDIR>\certreq -p SDBSSLs.pse "<your distinguished name>"
   For each database server that uses a server-specific PSE, you must set up a unique certificate request. If you are using a valid system-wide SSL Server PSE, you only need to set up a single certificate request for all servers.
4. Send the certificate request to the CA for signing. You can either send it to the SAP CA or to another CA.
You must make sure that the CA offers a certificate corresponding to the PKCS#7 certificate chain format. Thawte CA at [www.thawte.com](http://www.thawte.com) offers a suitable certificate, either SSL Chained CA Cert or PKCS#7 certificate chain format.
The CA validates the information contained in the certificate request, according to its own guidelines, and sends a reply containing the public key certificate.

5. After you have received the reply from the CA, make sure that the contents of the certificate request have not been destroyed during download.

For example, if you requested the certificate on a UNIX system and stored it on a Windows front end, the formatting (that is, line indents and line breaks) is affected.

To check the contents, open the certificate request with a text editor (such as Notepad) and repair the line indents and the line breaks.

```
Example
This is an example of a certificate request:
-----BEGIN CERTIFICATE-----
MIIBpzBqIBADAAMIGfMA0GCSqGSIb3DQEBAQUAA4GNADCBiQKBgQD/302IT+/Y
wpignSw7UFwneyWz3W1lOS18aFCyKRo0wCpD8UwcaC4dds4uGT6h12W1J0/F0tUg+EQxonZbaRrk9sTalk1nmqX3YAUe/gEaG
-----END CERTIFICATE REQUEST-----
```

6. Import the reply to the SSL Server PSE:
   a) Copy the text to a temporary file called `srcert`
   b) Enter the following command:

```
sapgenpse import_own_cert -c srcert -p SDBSSLS.pse
```

You have generated the SSL Server PSE. You can now start the XServer as usual (if it is already running, you must stop and restart it).

7. To check whether the SSL functionality is working correctly, view the trace file `niserver_<local computer name>.trace` in the `<independent data>\wrk` directory.

To generate the SSL Client PSE, proceed as follows:

1. Change to the `<independent programs>\11b` directory.
2. Set up the following environment variable:
   ```
   SECU_DIR=<independent data>\sec
   ```
3. Create an anonymous client SSL Client PSE, `SDBSSLA.pse` in the directory defined by `SECU_DIR` (see previous step):
   ```
sapgenpse gen_pse -v -noreq -p SDBSSLA.pse
   ```
   You can leave the distinguished name empty.
   Before you can establish an SSL connection to a database server, the server certificate must be entered in the PK list of the anonymous client certificate.

4. To see the database server certificate, enter the following command:
   ```
   x_ping -n <servermode> -c[apture]
   ```
You can check whether to trust the database server certificate. The client certificate is not affected by this.

5. Start the import with this command:
   `x_ping -n <servermode> -i[import]`

6. To administer the PSE, use the configuration tool sapgenpse. For more information enter the following command:
   `sapgenpse -h`

Note
For applications such as SQL Studio replace the independent data or independent program in the above description with the installation directory.

5.8 Backing Up the MaxDB Database

You need to define backup media and back up the MaxDB database using Database Manager GUI (DBMGUI).

Prerequisites

- You have finished client maintenance.
- You have installed Database Manager GUI [page 75].
- You can find more information on backing up the database at:
  - [http://help.sap.com/nw70](http://help.sap.com/nw70) SAP NetWeaver Library > SAP NetWeaver by Key Capability > Application Platform by Key Capability > Platform-Wide Services > Databases > MaxDB > Tools > Database Manager GUI > Backup

Procedure

1. Define the backup medium as described in Managing the Backup Media in the above documentation.
2. Back up the database as described in Backing Procedures in the above documentation.

5.9 Updating the Database Software to the Current Release

After the installation and before you start production operation, we strongly recommend you to update the database software.

Procedure

1. Download the latest MaxDB patches as follows:
   - [http://service.sap.com/swdc](http://service.sap.com/swdc) > Download > Database Patches > MaxDB
For more information about upgrading to a MaxDB Support Package, see SAP Note 735598.

### 5.10 Ensuring User Security

You need to ensure the security of the users that SAPinst creates during the installation. For security reasons, you also need to copy the installation directory to a separate, secure location — such as a DVD — and then delete the installation directory.

#### Recommendation

In all cases, the user ID and password are only encoded when transported across the network. Therefore, we recommend using encryption at the network layer, either by using the Secure Sockets Layer (SSL) protocol for HTTP connections, or Secure Network Communications (SNC) for the SAP protocols dialog and RFC. For more information, see the SAP Library at:


#### Caution

Make sure that you perform this procedure **before** the newly installed SAP system goes into production.

#### Prerequisites

If you change user passwords, be aware that SAP system users might exist in multiple SAP system clients (for example, if a user was copied as part of the client copy). Therefore, you need to change the passwords in all the relevant SAP system clients.

#### Procedure

For the users listed below, take the precautions described in the relevant SAP security guide, which you can find on SAP Service Marketplace at [http://service.sap.com/securityguide](http://service.sap.com/securityguide):

**Operating System and Database Users**

<table>
<thead>
<tr>
<th>User Type</th>
<th>User</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system user</td>
<td>sqd&lt;dbsid&gt;</td>
<td>MaxDB database administrator (that is, the owner of the database files)</td>
</tr>
</tbody>
</table>
5.0 Post-Installation

5.10 Ensuring User Security

<table>
<thead>
<tr>
<th>User Type</th>
<th>User</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>MaxDB database users</td>
<td>SAP&lt;SAPSID&gt;DB</td>
<td>MaxDB database owner (that is, the owner of the database tables)</td>
</tr>
<tr>
<td></td>
<td>CONTROL</td>
<td>MaxDB database manager operator</td>
</tr>
<tr>
<td></td>
<td>SUPERDBA</td>
<td>MaxDB database system administrator</td>
</tr>
<tr>
<td>Operating system user</td>
<td>&lt;sapid&gt;adm</td>
<td>SAP system administrator</td>
</tr>
</tbody>
</table>

### Host Agent User

<table>
<thead>
<tr>
<th>User</th>
<th>User Name</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system user</td>
<td>sapadm</td>
<td>SAP system administrator</td>
</tr>
<tr>
<td></td>
<td></td>
<td>You do not need to change the password of this user after the installation. This user is for administration purposes only.</td>
</tr>
</tbody>
</table>

**Note**

You can set up Java standalone users with the SAP User Management Engine (UME) in one of the following ways:

- With the users stored in an external ABAP system – see the first table below
- With the users stored in the database – see the second table below

The next two tables show these ways of managing the users.

### SAP System Users Stored in an External ABAP System

<table>
<thead>
<tr>
<th>User</th>
<th>User Name Storage: External ABAP System</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator</td>
<td>You create this user manually in the external ABAP system during the installation process.</td>
<td>This user’s password is stored in secure storage. Therefore, whenever you change the administrator’s password, you must also change the password in secure storage with the Config Tool. For more information, see Checking the SAP Java Documentation [page 86].</td>
</tr>
</tbody>
</table>

**Recommendation**

We recommend that you call the user J2EEADM_<SAPSID_Java_System>.

The maximum length is 12 characters.
<table>
<thead>
<tr>
<th>User</th>
<th>User Name Storage: External ABAP System</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Guest</td>
<td>You create this user manually in the external ABAP system during the installation process.</td>
<td>Lock this user for interactive logon.</td>
</tr>
<tr>
<td>Communication user for Application Server Java</td>
<td>You create this user manually in the external ABAP system during the installation process.</td>
<td>Specify this user as a <em>Communications</em> user and not as a dialog user. This user exists at least in the SAP system client that you specified during the installation.</td>
</tr>
<tr>
<td>Users for Adobe Document Services (ADS)</td>
<td>ADSUSER</td>
<td>User exists at least in the clients 000 and 001 of the external ABAP system. You must have created this user manually in the external ABAP system before you started the installation. For more information, see <em>Preparing User Management for an External ABAP System</em> [page 43].</td>
</tr>
<tr>
<td>Data supplier user for System Landscape Directory (SLD) (optional)</td>
<td>The name that you gave this user when you created it manually [page 43]. The recommended name is SLDDSUSER.</td>
<td>User exists at least in the clients 000 and 001 of the external ABAP system.</td>
</tr>
<tr>
<td>ABAP API user for System Landscape Directory (SLD) (optional)</td>
<td>The name that you gave this user when you created it manually [page 43]. The recommended name is SLDAPIUSER.</td>
<td>User exists at least in the clients 000 and 001 of the external ABAP system.</td>
</tr>
</tbody>
</table>
### SAP System Users Stored in the Database

<table>
<thead>
<tr>
<th>User</th>
<th>User Name Storage: Database</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator</td>
<td>The name that you gave this user during the installation or the default name Administrator</td>
<td>This user’s password is stored in secure storage. Therefore, whenever you change the administrator’s password, you must also change the password in secure storage with the AS Java Config Tool. For more information, see Checking the SAP Java Documentation [page 86].</td>
</tr>
<tr>
<td>Guest</td>
<td>The name that you gave this user during the installation or the default name Guest</td>
<td>Lock this user for interactive logon.</td>
</tr>
<tr>
<td>Users for Adobe Document Services (ADS)</td>
<td>ADSUSER</td>
<td>This user’s password is stored in secure storage. Therefore, whenever you change the administrator’s password, you must also change the password in secure storage with the AS Java Config Tool. For more information, see Checking the SAP Java Documentation [page 86].</td>
</tr>
<tr>
<td></td>
<td>ADS_AGENT</td>
<td>This user’s password is stored in secure storage. Therefore, whenever you change the administrator’s password, you must also change the password in secure storage with the AS Java Config Tool. For more information, see Checking the SAP Java Documentation [page 86].</td>
</tr>
<tr>
<td>Data supplier user for System Landscape Directory (SLD) (optional)</td>
<td>The name that you gave this user during the installation. The recommended name is SLDDSUSER.</td>
<td>Note: SAPinst created this user automatically if you chose Configure local SLD during the installation.</td>
</tr>
</tbody>
</table>

### 5.11 Post-Installation Steps for the Host Agent

You have to perform the following steps on each host where the host agent is installed. This applies whether the host agent is installed on a host within the SAP system or separately on another host.

**Procedure**

1. You check whether the installed services are available as follows:
   a) Log on as user sapadm.
   b) Check whether the following services are available:
      - The control program sapostexec
      - The operating system collector saposcol
The SAP NetWeaver Management agent SAPHostControl (sapstartsrv in host mode)

Note
When the host is booted, the services SAPHostControl and SAPHostExec automatically start
the installed programs

2. You configure the host agent according to your requirements.

More Information
For more information, see the SAP Library at:
View → Application Server ABAP → Administration Tools for AS ABAP → Monitoring in the CCMS → Infrastructure of
the SAP NetWeaver Management Agents →.

5.12 Checking the SAP Java Documentation

Here you can find information in the SAP Library about the configuration of Application Server
Java (AS Java) and about SAP Java technology.

Procedure

1. Go to the following place in the documentation:
   View → Application Server Java →.

2. Check the following documentation for information relevant to running your Java system:

<table>
<thead>
<tr>
<th>Manual</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Architecture Manual</td>
<td>This manual describes the architecture of a Java or ABAP+Java system. It contains information on:</td>
</tr>
<tr>
<td></td>
<td>■ Java cluster architecture including central services, <strong>load balancing</strong>, and <strong>high availability</strong>.</td>
</tr>
<tr>
<td></td>
<td>■ Application Server Java (AS Java) system architecture</td>
</tr>
<tr>
<td></td>
<td>■ SAP NetWeaver <strong>Java development infrastructure</strong>, including SAP NetWeaver Developer Studio</td>
</tr>
</tbody>
</table>

Note
The SAP NetWeaver Developer Studio is the SAP development infrastructure for Java. The Architecture Manual describes the integration of the SAP NetWeaver Developer Studio into the SAP development infrastructure.
<table>
<thead>
<tr>
<th>Manual</th>
<th>Contents</th>
</tr>
</thead>
</table>
| Administration Manual  | This manual describes how to administer the SAP system, focusing on AS Java. It contains information on:  
|                        |  - System landscape administration                                                        |
|                        |  - Software life-cycle management                                                          |
|                        |  ![Note](image)                                                                               |
|                        | This part of the manual contains important information about:                              |
|                        |  - Installation information                                                                  |
|                        |  - System Landscape Directory (SLD)                                                          |
|                        |  - Software Lifecycle Manager (SLM)                                                           |
|                        |  - Java Support Package Manager                                                               |
|                        |  - Administration of SAP NetWeaver Java Development                                           |
|                        |  - Infrastructure (JDI)                                                                      |
|                        |  - AS Java and AS Java security                                                               |
|                        |  - Supportability and performance management                                                  |
|                        |  - Administration and configuration of Web Dynpro runtime environment                        |
|                        |  - Administration of the XML Data Archiving Service (XML DAS)                                |
|                        |  ![Caution](image)                                                                            |
|                        | Make sure that you check the mandatory post-installation procedures listed in the Administration Manual under |  
|                        |  - J2EE Engine > Installation Information > Post-Installation Procedures ▪.                  |
| Java Development Manual| This manual describes the technologies for developing Java-based business applications. It explains how to use the SAP Netweaver Developer Studio, which is the SAP Java development environment. |
| Migration Manual        | This manual contains all the information you need to migrate an application created in J2EE Engine 6.20. |

**More Information**

For troubleshooting AS Java, see the [J2EE Engine Problem Analysis Guide](http://service.sap.com/instguidesw) at:


### 5.13 CE-Specific Post-Installation Activities

This section describes the steps that you have to perform after the installation has finished successfully.
Running the Configuration Wizard (Optional)

**Note**

You can run the configuration wizard only once and only directly after installing and patching your SAP system.

After SAPInst has finished, run the configuration wizard to apply automated configuration tasks to your system.

For SAP NetWeaver CE, you need to run the following configuration tasks, depending on the installed components:

- Configuration of Services Registry Webservice Destinations
- Configuration and Mirroring of local NWDS Update Site
- Initial setup ADS in CE

For more information about how to start the configuration wizard, see the configuration documentation in the SAP Solution Manager.

Enabling Adobe Document Services

If you have installed SAP NetWeaver Composition Environment with the Adobe Document Services add-on a Windows platform, you must complete the following post-installation steps to enable the add-on. In case you have installed an AS Java cluster, apply the procedure to the central host, as well as to all hosts where additional application server instances are running.

1. Using the SAP Management Console, stop the AS Java system.

2. From the Start menu, open Control Panel | Administrative Tools | Computer Management | Services and Applications | Services 4.

3. Select SAP<SID>_<Instance_Number> (for example, SAPCE1_00) and open Properties from the context menu.

4. On the Log On tab page, enable the Local System account indicator.

5. Repeat the above steps for the second SAP<SID>_<Instance_Number> service that you see in the list.

6. Start the AS Java system.

Adobe LiveCycle Designer

For more information about how to install and configure the Adobe LiveCycle Designer see SAP Note 962763.

Enabling Services Registry

You must apply additional configuration steps to enable Services Registry after you have installed an SAP NetWeaver Composition Environment system containing the following components:
Java Application Server and Composition Platform
Java Application Server and Adobe Document Services

To enable Services Registry, you must apply the following configuration template to your system:
CE_Complete_Stack_production_full

Note
For more information about what configuration templates are available, see Configuration Templates [page 95].

See also

Configuring the Portal in SAP NetWeaver CE
After installing the portal in SAP NetWeaver CE, a number of deactivated or irrelevant tools are displayed in the UI. To display the correct portals tools for CE, proceed as follows:

1. Open a browser and log on to your portal as an administrator.
2. In the same browser session, enter the following URL:


   where <host> is the host name of your server and <httpport> is the port number of your server.
3. In the Portal Mode Configuration Tool, choose Activate Development Mode to restore the portal tools and content that are assigned to the development mode.
4. Restart or refresh your browser.
5. In the SAP Management Console, restart the server.

You may then continue with the mandatory and optional configuration steps as described in [http://help.sap.com/nwce](http://help.sap.com/nwce) SAP NetWeaver Composition Environment Library ➤ Administrator’s Guide ➤ Configuration of SAP NetWeaver Composition Environment ➤ Configuration for CE Additional Components ➤ Configuring the Portal ➤.

Changing the Password for the Internet Communication Manager (ICM)
You can monitor and manage the Internet Communication Manager (ICM) from the command line program.

After the installation of your SAP NetWeaver CE system has successfully finished, you need to change the ICM password manually. To do so, proceed as follows:
1. Log on at operating system level to the computer where the ICM is running.
2. Start the program icmon with `icmon -a profile=<instance_profile>` to maintain the authentication file (default: authfile.txt).
3. Choose a to add a user.
4. Choose c to change the password of the existing user.
5. Choose s to save your settings.

**Further Configuration Steps**

After installing your SAP NetWeaver CE system and performing the post-installation steps to get the system up & running, you may need to perform further configuration steps. Refer to the following documentation to proceed with your tasks:

- If you are a **system administrator**, refer to [http://help.sap.com/nwce](http://help.sap.com/nwce) > Administrator’s Guide. It contains information about how to configure and administer your system.
- If you are a **developer**, refer to [http://help.sap.com/nwce](http://help.sap.com/nwce) > Developer’s Guide. It provides guidelines for developing applications using the SAP NetWeaver CE.

![Note](https://example.com)

**Note**

The SAP NetWeaver CE documentation is also available offline as a part of your installation. To access it, choose Start > All Programs > SAP NetWeaver > Composition Environment 1.0 > Documentation.

**5.14 Performing a Full System Backup**

You must perform a full system backup after the configuration of your SAP system. If required, you can also perform a full system backup after the installation (recommended). In addition, we recommend you to regularly back up your database.

**Prerequisites**

- You are logged on as user `<sapsid>adm`.
- You have shut down the SAP system and database.

**Procedure**

Back up your system including the operating system disk, system state, and all other disks.
6 Updating SAP NetWeaver Composition Environment

If you want to apply the latest support packages and patches to your SAP NetWeaver CE system or update your applications, use the update management service of SAP NetWeaver CE.

Before You Start the Update

- During the update process, entries are written to the log areas of the database. To avoid that the log is running full during the update, make sure that you backup scenario is working well or the Automatic LogOverwrite is enabled.
- Before you start the update, apply SAP Note 1088002.
  You need to perform this once on each system.

Updating Your SAP NetWeaver CE System Manually

If you have a system that was installed with SP0 or SP1, proceed as follows:

   Search for SERVERCORE01_0-10004571.SCA SP01 for J2EE ENGINE SERVERCORE 7.05.
   Before deploying the SCA using telnet, change the permissions using the following command:
   ```bash
   chmod 777 SERVERCORE01_0-10004571.SCA
   ```
   For more information, see SAP Note 1073329.

2. Manually deploy the three XI third-party SDAs using telnet.
   For more information, see SAP Note 1088386.

3. Exchange the engine template.

   **Note**
   Before changing the current template, note down the name of the currently active template. You will need it at the end of the update procedure to reactivate the original template again.

   a) Navigate to the configtool subdirectory of your installation directory, for example
      ```bash
      C:\usr\sap\CE1.J01\j2ee\configtool
      ```
   b) Run the file configtool.bat.
   c) Highlight the template and choose 
      File  Change System Template .
   d) Switch from the current template to the instance_development template.
   e) Save your settings and restart the server.
      To do this, open SAP Management Console, select the node and choose the restart option.
Caution

If you are running a cluster system, you need to check that all instances are running the correct template before proceeding to update the main instance.


5. Stop the SAP Management Console.

6. From the download folder from SAP Service Marketplace, run the update tool update<ID>.exe to apply patches and updates to your SAP NetWeaver CE system.

   After running the update tool wait until the engine is fully started.

7. To complete the update process, change back the system template to the original one.

Caution

If you are running a cluster system, make sure that you change back to the original template on all dialog instances.

8. Restart the system.

**Update Management Service**

Update Management Service is intended to help automate the process of downloading and installing the latest Support Package Stack from SAP Service Marketplace. The Update Management tool will connect to SAP Service Marketplace and look for the latest support package stack available for your system. For example, if your system is on SP3 and the latest support package available is SP5, the Update Management Service will download and apply SP5 to your system. If, however, you want to go to an intermediate support package stack, you have to download the stack manually.

**Procedure**

1. Choose Start Programs SAP NetWeaver Composition Environment <SAPSID> Update Management Service.

2. Follow the on-screen instructions and enter the required logon information.

3. The Update Management tool checks the system for installed components and support package stack level.

4. The Update Management tool checks for updates and new support package stacks on SAP Service Marketplace and applies them automatically.

When the update has successfully completed, SAPInst shows the dialog The system is up-to-date.
7 Additional Information

The following section provides additional information about the installation of SAP NetWeaver Composition Environment.

7.1 Transporting Self-Developed Software Component Archives (SCA) into the System

Prerequisites
You have developed your own Software Component Archives (SCA) and want to transport them into your SAP NetWeaver CE system.

Procedure
To transport your SCAs to the SAP NetWeaver CE system, proceed as follows:
1. Run the update tool as described in Updating the SAP NetWeaver CE system [page 91].

Note
If the tool displays descriptions such as Applying Support Packages, you can ignore them.

2. In the dialog screens, specify the directory where your SCAs are located.
3. Follow the on-screen instructions.

7.2 Troubleshooting – Repairing an Inconsistent MaxDB Installation

Prerequisites
During the preinstallation phase, the installation tools checks the Microsoft Windows registry for already installed MaxDB software. If the registry key is found but there is no software on the hard drive, you receive the following message:
The existing MaxDB software is not consistent. Check the file system and registry.
The most common reason for this inconsistency is the manual deletion of the software from the file system without using the specified tools.
**Procedure**

To repair this inconsistency, proceed as follows:

1. Choose \Start\ Control Panel\ Administrative Tools\ Services.
2. Make sure the services SAPDBWWW, SAPDB:* , and XServer are stopped.
3. Choose \Start\ Run and run the command regedit.
4. Go to \My Computer\HKEY_LOCAL_MACHINE\SOFTWARE\SAP\SAP DBTech\ Key IndepPrograms.
   The key contains a path to a folder.
   a) Check if this folder exists on the file system.
   b) Note down the value of Key IndepPrograms for later usage (see step 7).
      If the path does not exist in the file system, delete the key SAP DBTech.
5. Delete the following keys:
   - My Computer\HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\SAP DBTech.*
   - My Computer\HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\SAPDBWWW
   - My Computer\HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\XServer
6. Choose \Start\ Control Panel\ System\ Advanced\ Environment Variables\ System Variables\ Path.
7. Delete the following paths from the variable:
   - <IndepPrograms>/bin
   - <IndepPrograms>/pgm
8. Reboot your computer.

**7.3 Restarting the MaxDB Server Manually**

If, after a reboot, the database server is not running automatically, you need to restart the MaxDB server manually.

**Production Systems**

To restart the MaxDB server manually, proceed as follows:

1. Open a command prompt and enter the following command: net start sapdbwww
   OR
   Choose \Start\ All Programs\ Administrative Tools\ Services. Double-click on SAP DB WWW and choose Start.
2. Open the SAP Management Console and choose \SAP Systems\ <SAPSID>\ <machine name>.
3. Enter the master password and choose Logon.
4. Choose Online. When the database server is online, you can restart the engine.

**Development Systems**

To restart the MaxDB server manually, choose \Start\ All Programs\ SAP NetWeaver Composition Environment CE\ Application Server <SAPSID>\ Start Application Server.
7.4 Restarting the MS SQL Server Manually

If, after a reboot, the database server is not running automatically, you need to restart the MS SQL Server manually.

Procedure

1. Choose Start ➤ All Programs ➤ Administrative Tools ➤ Services ➤.
2. Look for the service named SQL Server <name>, where <name> is MSSQLSERVER for the default instance or <instance name> for a named instance.
3. If the service status is not started, right-click the service and choose Start in the context menu.
4. To insure the service is started automatically after each system restart, right-click it and choose Properties. Select Automatic as the startup type.

7.5 Configuration Templates

Configuration templates contain the predefined instance configuration for specific scenarios. They are automatically applied according to the installation option you have selected. The templates are designed to optimize system performance by applying certain configuration to the Java Virtual Machine and the application server, as well as by applying startup filters to AS Java services and applications to start only those relevant for the selected installation options.

The following table provides information about the available templates with SAP NetWeaver Composition Environment. In the template name, replace the <system_mode> parameter by development (for the templates relevant to systems installed in development mode) or production (for the templates relevant to systems installed in productive mode).

<table>
<thead>
<tr>
<th>Configuration Template</th>
<th>Selected Installation Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>CE_Java_EE_&lt;system_mode&gt;_full</td>
<td>Java Application Server Installation</td>
</tr>
<tr>
<td>CE_Composition_Environment_&lt;system_mode&gt;_full</td>
<td>Java Application Server Installation + Composition Platform Installation</td>
</tr>
<tr>
<td>CE_Adobe_Document_Service_&lt;system_mode&gt;_full</td>
<td>Java Application Server Installation + Adobe Document Services Add-on Installation</td>
</tr>
<tr>
<td>CE_Composite_Voice_&lt;system_mode&gt;_full</td>
<td>Java Application Server Installation + Voice Add-on Installation</td>
</tr>
<tr>
<td>CE_Complete_Stack_&lt;system_mode&gt;_full</td>
<td>Java Application Server Installation + Composition Platform Installation + Adobe Document Services Add-on Installation + Voice Add-on Installation</td>
</tr>
</tbody>
</table>
If your selection cannot be mapped to one of the combinations in the above table, the template CE_Complete_Stack_<system_mode>_full is applied. It starts all applications and services needed to run the complete stack.
You can manually apply a different configuration template if you want to switch to another installation option. For example, by changing from template CE_Complete_Stack_<system_mode>_full to CE_Java_EE_<system_mode>_full, you achieve shorter startup times and less memory consumption, but also less functionality since not all applications and services are running.

**Note**
Make sure that you do not apply a development template to a productive system or vice versa.

### 7.6 SAP Directories

This section describes the SAP directories that SAPinst creates during the installation.

[Only valid for: HA (MCS)]

If you want to install an MCS system, see also: Directories in an MCS Configuration [page 121].

[End of: HA (MCS)]

SAPinst creates the following base directories required for the SAP system:

- `\usr\sap`
  This directory is created on the:
  - **Global** host and **shared** with the network share sapmnt
    The global host is the host where the SCS and primary application server instance is installed.
    On global hosts, the `\usr\sap` directory contains general SAP software, global and local (instance-specific) data.
    For this, the following directories are created in `\usr\sap\<SAPSID>\SYS`:
      - `global` (contains globally shared data)
      - `profile` (contains the profiles for all instances)
      - `exe` (contains executable replication directory for all instances and platforms)
    All instances of an SAP system access this directory on the global host using the Universal Naming Convention (UNC) path.
  - **Local** host and **shared** with the network share saploc.
    On local hosts, the `\usr\sap` directory contains copies of the SAP software and local (instance-specific) data.
    The executables on the local host are replicated from those on the global host each time the local instance is started.
In MSCS this directory is located on a local disk. You have at least two disk drives with a `usr\sap` directory structure.

**Note**
Since SAP traces for the instance are created in a subdirectory of `\usr\sap`, make sure there is sufficient space available in this directory.

- **`\usr\sap\trans`**
The transport directory contains SAP software for the transport of objects between SAP systems. SAPinst by default creates it on the `SAPGLOBALHOST`.
If you want to have it created on another host, or if you want to use an already existing transport host of your SAP system landscape, you can specify another host during the installation. In this case, you have to prepare that host to allow the new SAP system to use it as transport host. For more information, see *Preparing the SAP System Transport Host* [page 51].

**Directory Structure**
The global host has the `SAP\<SAPSID>\SYS` directory structure. The global data is stored in the global directories on the global host and physically exists only once for each SAP system. Other application servers access the global data using the UNC path `\<SAPGLOBALHOST>\sapmnt`. The SAP programs access their instance-specific data with the UNC path `\<SAPLOCALHOST>\saploc`. If the UNC path points to a local directory, the local path (and not the UNC path) is used to access the directory. In a distributed system, the parameters `SAPGLOBALHOST` and `SAPLOCALHOST` have the same values on the global host.

Every time an instance starts, the SAP copy program sapcpe compares the binaries in the `<platform>-directory on the global host and the binaries in the `exe`-directory on the application server. If the binaries in the `exe` directory differ from those in the `<platform>-directory, sapcpe replaces them with the newer version of the global host.
The following figures show how the physical directory `\usr\sap` is shared on the global host in a standard and in a distributed system. In both cases, the UNC paths are used as follows:
- `\<SAPGLOBALHOST>\sapmnt` to access global directories
- `\<SAPLOCALHOST>\saploc` to access local instance-specific data
Figure 7: Directory Structure on the Global Host in a Standard (Central) Java System

Figure 8: Directory Structure for a Distributed Java System
7.7 Additional Information About SAPinst

The following sections provide additional information about SAPinst [page 58]:

- **Interrupted Installation with SAPinst** [page 99]
- **Performing a Remote Installation with SAPinst (Optional)** [page 101]
- **Starting SAPinst GUI Separately (Optional)** [page 102]
- **Entries in the Services File Created by SAPinst** [page 104]
- **How to Avoid Automatic Logoff by SAPinst** [page 104]
- **Troubleshooting with SAPinst** [page 105]

### 7.7.1 Interrupted Installation with SAPinst

The SAP system installation might be interrupted for one of the following reasons:

- An error occurred during the dialog or processing phase:
SAPinst does not abort the installation in error situations. If an error occurs, the installation pauses and a dialog box appears. The dialog box contains a short description about the choices listed in the table below as well as a path to a log file that contains detailed information about the error.

- You interrupted the installation by choosing Exit in the SAPinst menu.

The following table describes the options in the dialog box:

<table>
<thead>
<tr>
<th>Option</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Retry</strong></td>
<td>SAPinst retries the installation from the point of failure without repeating any of the previous steps. This is possible because SAPinst records the installation progress in the keydb.xml file. We recommend that you view the entries in the log files, try to solve the problem and then choose Retry. If the same or a different error occurs again, SAPinst displays the same dialog box again.</td>
</tr>
<tr>
<td><strong>Stop</strong></td>
<td>SAPinst stops the installation, closing the dialog box, the SAPinst GUI, and the GUI server. SAPinst records the installation progress in the keydb.xml file. Therefore, you can continue the installation from the point of failure without repeating any of the previous steps. See the procedure below.</td>
</tr>
<tr>
<td><strong>Continue</strong></td>
<td>SAPinst continues the installation from the current point.</td>
</tr>
</tbody>
</table>

**Procedure**

This procedure describes the steps to restart an installation, which you stopped by choosing Stop, or to continue an interrupted installation after an error situation.

1. Log on to your remote host as a user who is a member of the local administrators group.
2. Mount your Installation Master DVD.
3. Restart SAPinst by double-clicking `sapinst.exe`. You can also start SAPinst by entering the following commands at the Windows command prompt:
   ```
   cd <DVD drive>:\IM_WINDOWS<platform>
   ```
4. From the tree structure in the Welcome screen, select the installation option that you want to continue and choose Next.

**Note**

If there is only one component to install, the Welcome screen does not appear.

The What do you want to do? screen appears.

5. In the What do you want to do? screen, decide between the following alternatives and confirm with OK.
### 7.7.2 Performing a Remote Installation with SAPinst (Optional)

You use this procedure to install your SAP system on a remote host. In this case, SAPinst and the GUI server run on the remote host, and SAPinst GUI runs on the local host. The local host is the host from which you control the installation with SAPinst GUI.

**Prerequisites**

- The remote host meets the prerequisites before starting SAPinst as described in Running SAPinst [page 58].
- Both computers are in the same network and can “ping” each other.
  - To test this:
    - Log on to your remote host and enter the command `ping <local host>.
    - Log on to the local host and enter the command `ping <remote host>.

**Procedure**

1. Log on to your remote host as a user who is a member of the local administrators group.
2. Insert the Installation Master DVD in the DVD drive on your remote host.
3. Enter the following commands:
   ```
   cd <DVD drive>:\DATA_UNITS\IM_WINDOWS_<platform>
   sapinst.exe -nogui
   ```
   For more information, see Running SAPinst [page 58].
   SAPinst now starts and waits for the connection to the SAPinst GUI. You see the following at the command prompt:
   ```
   guiengine: no GUI connected; waiting for a connection on host <host_name>, port <port_number> to continue with the installation
   ```
4. Start SAPinst GUI on your local host, as described in Starting SAPinst GUI Separately [page 102].
7.7.3 Starting SAPinst GUI Separately (Optional)

You use this procedure to start SAPinst GUI separately. You might need to start SAPinst GUI separately in the following cases:

- You have logged off from SAPinst.
  - If you logged off during the installation and you later want to reconnect to the installation while it is still running, you can start SAPinst GUI separately.
- You want to perform a remote installation [page 101].
  - If SAPinst GUI runs on a different host from SAPinst and the GUI server, you have to start SAPinst GUI separately.

**Starting SAPinst GUI on a Windows Platform**

1. Log on as a member of the local administrators group.
2. Insert the SAP Installation Master DVD into your DVD drive.
3. Change to the directory of the sapinst executables:
   `<DVD drive>:\DATA_UNITS\IM_WINDOWS_<platform>_EXEC_DIR`

   **Note**
   If you want to start SAPinst GUI on a Windows 32-bit platform, change to the following directory:
   `<Installation_Master_DVD>\DATA_UNITS\SAPINSTGUI_710 WINDOWS_I386`

4. Start SAPinst GUI by double-clicking `sapinstgui.exe`
   SAPinst GUI starts and tries to connect to the GUI server and SAPinst, using the local host as default.
   - If SAPinst and the GUI server are running on another host, SAPinst GUI cannot connect and the `SAP Installation GUI Connection` dialog appears.
   - In this case, enter the name of the host on which SAPinst is running and choose `Login`.
   - The first dialog of the installation appears and you can perform the remote installation from your local host.

   **Note**
   Optionally you can start `sapinstgui.exe` with the following parameters:
   - `host=<host name>`, where `<host name>` is the host name of the installation host
   - `port=<nr>`, where `<nr>` is the port number for the connection to the GUI server
   - `-accessible` enables the Accessibility mode
   - Example:
     `./sapinstgui.exe host=lsi1209 port=3800 -accessible`
Starting SAPinst GUI on a UNIX Platform

1. Log on as user root.

⚠️ Caution
Make sure that the root user has not set any environment variables for a different SAP system or database.

2. Mount your Installation Master DVD.

👉 Note
Mount the DVD locally. We do not recommend that you use Network File System (NFS).

3. Change to the directory of the sapinst executables:
<Installation_Master_DVD>/DATA_UNITS/IM_<OS>_<DB>

👉 Note
If you want to start SAPinst GUI on a Linux 32-bit platform, change to the following directory:
<Installation_Master_DVD>/DATA_UNITS/SAPINSTGUI_710_LINUX_I386

4. Start SAPinst GUI by executing ./sapinstgui
SAPinst GUI starts and tries to connect to the GUI server and SAPinst, using the local host as default.
If SAPinst and the GUI server are running on another host, SAPinst GUI cannot connect and the SAP Installation GUI Connection dialog appears.
In this case, enter the name of the host on which SAPinst is running and choose Log on.
The first dialog of the installation appears and you can perform the remote installation from your local host.

👉 Note
Optionally you can start sapinstgui with the following parameters:
- host=<host name>, where <host name> is the host name of the installation host
- port=<nr>, where <nr> is the port number for the connection to the GUI server
- - accessible enables accessibility mode
Example:
./sapinstgui host=lsi1209 port=3000 -accessible
7.7.4 Entries in the Services File Created by SAPinst

After the installation has finished successfully, SAPinst has created the following entries for port names in `<drive>\WINDOWS\system32\drivers\etc\services`

- sapdpXX = 32XX/tcp
- sapdbXXs = 47XX/tcp
- sapgwXX = 33XX/tcp
- sapgwXXs = 48XX/tcp

where XX is set from 00 to 99.

Note
If there is more than one entry for the same port number, this is not an error.

7.7.5 How to Avoid Automatic Logoff by SAPinst

When you install the SAP system with SAPinst, the SAPinst installation tool checks whether the user account used for the installation has the required privileges and authorization.

For a domain installation, the account needs to be both a member of the local Administrators and the domain Admins group. For a local installation, the account needs to be a member of the local Administrators group.

In both cases, the user account must be authorized to:

- Act as part of the operating system
- Adjust memory quotas for a process
- Replace a process-level token

If the user account does not have these rights assigned, SAPinst automatically logs the account off to assign them. To avoid SAPinst logging the account off, you can set these rights manually before you start the installation.

Procedure

You perform the following steps to assign these rights to the user account used for the installation.

Caution

Be aware that domain policies override locally defined policies. This means that if you want to grant domain administrator rights for a user who belongs to the local Administrators group, make sure that you have also defined domain administrator rights for this user on domain level.

2. In the `Local Security Settings` window, choose `Local Policies` > `User Rights Assignment`.
3. Double-click the required right under `Policy` and choose `Add User or Group`.

Note
4. In the Select Users and Groups window, choose the required user and choose Add.
The selected user appears in the box below.
5. Confirm your entry and then repeat the steps for each remaining policy that the user requires for the installation.
6. Log off and log on again to apply the changes.

**More Information**

*Required User Authorization for the Installation [page 47]*

### 7.7.6 Troubleshooting with SAPinst

This section tells you how to proceed when errors occur during the installation with SAPinst.
If an error occurs, SAPinst:

- Stops the installation
- Displays a dialog informing you about the error

**Procedure**

1. To view the log file, choose View Logs.
2. If an error occurs during the dialog or processing phase, do one of the following:
   - Try to solve the problem.
   - Abort the installation with Exit.
     For more information, see *Interrupted Installation with SAPinst [page 99]*.
   - Continue the installation by choosing Retry.
3. Check the log and trace files of the GUI server and SAPinst GUI in the directory
   `%userprofile%\sdtgui\` for errors.
4. If GUI server or SAPinst GUI do not start, check the file `sdtstart.err` in the current
   `%userprofile%` directory.
5. If SAPinst GUI aborts during the installation without an error message, restart SAPinst GUI as described in Starting SAPinst GUI Separately.

### 7.8 Starting and Stopping the SAP System

You use this procedure to check that you can start and stop the SAP system after the installation with the SAP Microsoft Management Console (SAP MMC).
With a newly installed MMC you can start or stop installed SAP instances locally on the host that you are logged on to. If the MMC is configured for central system administration, you can start or stop the entire system from a single host.
7.9 SAP System Security on Windows

Prerequisites

- You have logged on to the SAP system host as user <sapsid>adm.
- You have checked the settings for VM parameters as described in SAP Note 723909.

Procedure

1. Start the SAP MMC on the SAP system host by choosing Start > All Programs > SAP Management Console.
2. Right-click the SAP system node and choose Start or Stop.
   All instances listed under the system node, will start or stop in the correct order.
3. If the SAP system is installed on multiple hosts (distributed system), you have the following options to start or stop your system:
   You have the following options to start or stop your system:
   - You start or stop the SAP instances using the MMC on each host.
   - You add the remote instances to the MMC configuration to start or stop all instances from a single MMC.
     To do so, you configure the MMC manually. For more information, see Changing the Configuration of the MMC in the SAP MMC documentation.

Note

You can also start and stop a UNIX system with the MMC.

Note

You can also start and stop an SAP instance on UNIX with the MMC.

7.9 SAP System Security on Windows

In a standard SAP system installation, SAPinst automatically performs all steps relevant for security. Although SAPinst makes sure that the system is protected against unauthorized access, you must still check that no security breaches can occur.

For central and straightforward administration of the SAP system, you have to install distributed SAP systems with multiple application servers in a Windows domain. This section describes the user
accounts and groups that SAPinst creates during a domain installation and shows how these are related to the SAP directories.

**User Accounts**

SAPinst creates the following accounts for SAP system administration:

- `<sapid>adm`
  
  This is the SAP system administrator account that enables interactive administration of the system.

- `SAPService<sapid>`
  
  This is the user account that is required to start the SAP system. It has the local user right to log on as a service.
  
  The advantage of the additional `SAPService<sapid>` account is that it does not allow an interactive logon, which prevents abuse of the account. Therefore, you do not need to set an expiration date for the password and you do not have to set the option `user must change password at next logon`.

- `sapadm`
  
  This is the user for the SAP host agent. It is a member of the local Administrators group.
  
  The host agent contains all of the required elements for centrally monitoring any host with the Alert Monitor or the SAP NetWeaver Administrator.

**Groups**

SAPinst creates the following groups during a domain installation:

- `SAP_<sapid>_GlobalAdmin`
  
  This global group is a domain-level SAP administration group for organizing SAP system administrators. The only function of a global group is to group users at the domain level so that they can be placed in the appropriate local groups.

- `SAP_<sapid>_LocalAdmin`
  
  Only local groups are created and maintained on an application server. A local group can only be given permissions and rights to the system where it is located. The system is part of a particular domain, and the local group can contain users and global groups from this domain.

- `SAP_LocalAdmin`
  
  This group is created on all hosts, but is particularly important for the transport host. Members of the group have full control over the transport directory (`<usr>\sap\trans`) that allows transports to take place between systems.
  
  The `SAP_<sapid>_GlobalAdmin` groups of all the SAP systems that are part of the transport infrastructure are added to the `SAP_LocalAdmin` group. As a consequence, the users `<sapid>adm` and `SAPService<sapid>` of all systems in the transport infrastructure are members of the `SAP_LocalAdmin` group and have the required authorizations necessary to initiate and execute transports.
**SAP Directories**

SAPinst protects the SAP directories under `\usr\sap\<SAPSID>` by only granting the group `SAP_<SAPSID>_LocalAdmin` full control over these directories.

The following graphic illustrates the user accounts and groups created by SAPinst in a system infrastructure consisting of two SAP systems.

**Figure 10:** User Groups and Accounts

![Diagram of user groups and accounts]

---

**Note**

An access control list (ACL) controls access to SAP system objects. For maximum security in the SAP system, only the following are members of all SAP system object ACLs:

- Local group `SAP_<SAPSID>_LocalAdmin`
- Group Administrators
- Account SYSTEM

---

**7.10 Automatic Creation of Accounts and Groups**

SAPinst automatically creates the accounts and groups required for the secure operation of the SAP system with Windows [page 106] during the installation.
Features

The following figures show the steps that SAPinst performs to create the users and groups and assign the required rights to SAP directories.

Figure 11: Creating Users and Groups

<table>
<thead>
<tr>
<th>Creation of Accounts</th>
<th>Creation of SAP user accounts</th>
<th>Creation of SAP Host Agent Account</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP Administrator</td>
<td>SAP Service Account</td>
<td>SAP Host Agent Account</td>
</tr>
<tr>
<td>&lt;sapsid&gt;adm</td>
<td>SAPService&lt;SAPSID&gt;</td>
<td>sapadm</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Creation and Modification of Global Group in the Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creation of global group SAP_&lt;SAPSID&gt;GlobalAdmin</td>
</tr>
<tr>
<td>Addition of &lt;sapsid&gt;adm and SAPService&lt;SAPSID&gt; to group SAP_&lt;SAPSID&gt;_GlobalAdmin</td>
</tr>
<tr>
<td>Addition of &lt;sapsid&gt;adm to the local Administrators group</td>
</tr>
<tr>
<td>Addition of &lt;sapsid&gt;adm to the Windows domain user groups</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Creation and Modification of Local Group on Each Application Server</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creation of the local group SAP_&lt;SAPSID&gt;_LocalAdmin on the application server</td>
</tr>
<tr>
<td>Addition of the global SAP_&lt;SAPSID&gt;<em>GlobalAdmin to the local group SAP</em>&lt;SAPSID&gt;_LocalAdmin</td>
</tr>
<tr>
<td>Creation of the local group SAP_LocalAdmin on the application server</td>
</tr>
<tr>
<td>Addition of the global group SAP_&lt;SAPSID&gt;_GlobalAdmin to the local group SAP_LocalAdmin on the application server</td>
</tr>
<tr>
<td>Addition of the SAP_&lt;SAPSID&gt;_GlobalAdmin group to the local group SAP_LocalAdmin on the transport host</td>
</tr>
</tbody>
</table>
7.11 Uninstalling SAP NetWeaver Composition Environment

You have to uninstall all components of the SAP NetWeaver Composition Environment separately. You can uninstall your SAP NetWeaver CE system in different ways.

**Uninstalling SAP NetWeaver CE**

Choose \(\text{Start} \rightarrow \text{Control Panel} \rightarrow \text{Add/Remove programs} \rightarrow \text{SAP System}<\text{SAPSID}>\).

**Uninstalling SAP NetWeaver CE Using SAPinst**

1. Insert the SAP Installation Master DVD into your DVD drive or mount it locally.
2. Start SAPinst from the SAP Installation Master DVD as described in the section *Installing SAP NetWeaver Composition Environment*.
3. In the *Welcome* screen, choose *Uninstall SAP System or Single Instances* from the tree structure.
4. Follow the on-screen instructions.

**Uninstalling the SAP Management Console**

Since all SAP systems use the SAP Management Console, there is no uninstallation option for the SAP Management Console with SAPinst. If you are sure that you do not need the SAP Management Console any more, you can remove it using \(\text{Start} \rightarrow \text{Control Panel} \rightarrow \text{Add/Remove programs}\).
7.12 Deleting an SAP System

This section describes how to delete a single instance, a standalone engine or a complete SAP system with the Uninstall option of SAPinst.

Caution

- You cannot delete an SAP system remotely.
- If you delete network-wide users, groups or service entries in an environment with Network Information System (NIS), other SAP installations might also be affected. Make sure that the users, groups, and service entries to be deleted are no longer required.

Prerequisites

- This description assumes that you have installed your SAP system with standard SAP tools according to the installation documentation.
- You are logged on with a user account that has the required authorization to run the SAPinst tool and the SAP system. For more information, see Required User Authorization for the Installation [page 47].

Procedure

1. Start SAPinst and on the Welcome screen, choose:
   - <SAP System> ➔ Software Life-Cycle Options ➔ Uninstall ➔ Uninstall — SAP systems or single instances ➔.
2. Follow the instructions in the SAPinst input dialogs.

Note

For more information about the input parameters, place the cursor on the relevant field and press F1 in SAPinst.

SAPinst first asks you which SAP instances you want to delete. Make sure that you delete the SAP instances in the order as described hereinafter.

- If you want to delete a standard system (all instances reside on the same host), you can do this in one SAPinst run.
- If you want to delete a distributed system, you have to run SAPinst to delete the required instances locally on each of the hosts belonging to the SAP system in the following sequence:
  a) Additional application server instance(s), if there are any
b) Database instance

⚠️ Caution
SAPinst only stops local instances automatically. Before you delete the database instance of a distributed system make sure that you stop all remaining instances. You must stop the instance with the message server only after having entered all SAPinst parameters for the deletion of the database instance.

Choose whether you want to drop the entire database or only one or more database schemas. If you drop the entire database, SAPinst also asks whether you want to remove the database software.

c) Primary application server instance

💡 Note
If SAPinst stops responding while trying to delete the primary application server instance, close SAPinst with Cancel and Exit. Log off and log on again. To complete the uninstall process of the primary application server instance, restart SAPinst.

d) Central services instance

3. If required, you can delete the directory `\usr\sap\trans` and its contents manually.

SAPinst does not delete `\usr\sap\trans` because it might be shared.
8 High Availability with Microsoft Cluster Service

You can install a high-availability SAP system with Microsoft Cluster Service (MSCS). For this type of installation, you have to set up the system on at least two clustered hosts (called “MSCS nodes”) and configure it so that it can take advantage of the MSCS software. The MSCS software improves the availability of the system and safeguards it against failure and unplanned downtime, enabling 24-hour operation, 365 days a year.

With high availability you enable critical system components, called Single Points of Failure (SPOFs), to be automatically switched from one machine to the other in the event of hardware or software problems affecting one machine. With the help of this switchover – or failover – the system can continue functioning normally so that unplanned system downtime is avoided.

Apart from enabling failover when hardware problems occur, you can also use MSCS to avoid downtime when you perform essential system maintenance. If you need to maintain one node, you can deliberately switch the cluster resources to another node and temporarily operate it there while maintenance is in progress. When maintenance work is finished you can easily move the resources back to their original node and continue operating them there.

You have the following options to install a high-availability system with MSCS to safeguard it against failure and unplanned downtime:

- You install one SAP system in one MSCS cluster.
- You install one SAP system in two MSCS clusters.

For all MSCS configurations the following restrictions apply:

- The (A)SCS instance must be installed and configured to run on two MSCS nodes in one MSCS cluster.
- If your database supports the installation on several MSCS nodes, you can install the database instance on more than two MSCS nodes in one MSCS cluster.

Note

If you have one of these MSCS configurations and you use SAPIinst to install such an MSCS system, you get SAP support with the installation, configuration, and operation.
Note

- Make sure that you read SAP Note 965569, which contains the most recent information as well as corrections for MSCS. For more information, see the SAP installation notes [page 9] before you begin the installation.
- In this documentation the hosts in an MSCS cluster are referred to as first MSCS node and additional MSCS node(s).
  
  The **first MSCS node** is the MSCS node where you perform the general installation of an SAP system, for example where the database or (A)SCS instance is to be installed.
  
  The **additional MSCS node** is the node where you configure the already installed SAP instances to run in MSCS.

To install a new SAP system with MSCS, you combine general installation steps, described earlier in this documentation, with cluster-specific steps described here:

- Since the cluster hardware has at least two nodes that have access to all local and shared storage devices, you have to install some components on all MSCS nodes and observe special rules for distributing components to local or shared disks.
- Since the correct configuration of network addresses is absolutely essential to enable the cluster to function properly, you have to perform a number of additional steps that are necessary to set up and check addressing.

Note

If you have an existing SAP system and plan to migrate to a cluster with new hardware, you install the SAP system using a **system copy**.

For more information about the system copy, see the System Copy Guide for your SAP system on SAP Service Marketplace at [http://service.sap.com/instguides](http://service.sap.com/instguides) » Release » Installation. The documentation for system copy does **not** include the cluster-specific information, which is described here.

### 8.1 Planning

You have to complete the following planning activities for you SAP system using Microsoft Cluster Service (MSCS):

1. You check the **general planning activities** [page 13] listed in Chapter 2 of this guide.
2. You decide how to **set up your SAP system components in an MSCS configuration** [page 115].
3. You decide how to **distribute components to disks for MSCS** [page 119].
4. You read **Directories in an MSCS Configuration** [page 121].
5. You read **IP Addresses in an MSCS Configuration** [page 122].
6. You **obtain IP addresses for MSCS** [page 126].
8.1.1 System Configuration in MSCS

The following chapters provide information about the configuration of your SAP system configuration in MSCS. It describes the components you have to install for one or more SAP system running in one cluster, and how to distribute them on the specific host. For more information, see:

- SAP System Components in an MSCS Configuration [page 115]
- Enqueue Replication Server in MSCS [page 118]

8.1.1.1 SAP System Components in an MSCS Configuration

In an MSCS configuration you have the following mandatory components for your SAP system:

SAP System Components in an MSCS Configuration

<table>
<thead>
<tr>
<th>Component</th>
<th>Number of Components per SAP System</th>
<th>Single Point of Failure</th>
</tr>
</thead>
<tbody>
<tr>
<td>SCS instance (message services and enqueue services)</td>
<td>1</td>
<td>yes</td>
</tr>
<tr>
<td>Database instance</td>
<td>1</td>
<td>yes</td>
</tr>
<tr>
<td>Application server instance (primary application server, additional application server)</td>
<td>1-n</td>
<td>no</td>
</tr>
</tbody>
</table>

To protect the SPOFs ((A)SCS instance and database instance) you have to use MSCS.

If a hardware or software problem occurs on the first MSCS node, the clustered (A)SCS instance and the clustered database automatically fail over to another node.

If you need to maintain the MSCS node where the (A)SCS instance and database are running you can switch these instances to another node. When maintenance work is finished you move the (A)SCS and database instance back to the original node.

To protect system components that are non-SPOFs, for example application servers, you have to install them as multiple components. In this case you must install at least two application servers (the primary application server instance and one additional application server instance) on two different hosts. You have the following options:

- You install the primary application server and the additional application server instance on the MSCS nodes of an MSCS cluster. You install them on a local disk. Any additional application server instances are installed on hosts outside of the MSCS cluster.
- If you have to maintain an MSCS node, you have to stop the primary application server or the additional application server instance on that node. When you have finished maintenance, you restart the instance(s).
You install the primary application server and all additional application server instances on hosts, which are not part of an MS cluster.

The following figures show examples for the installation of SPOFs and non-SPOFs of an SAP system in an MSCS cluster with two nodes.

The first figure shows an MSCS configuration where the non-SPOFs components (primary application server instance, additional application server instance) are installed locally on the MSCS nodes. Any additional application server instance(s) are installed outside the MSCS cluster on separate hosts.

**Figure 13: Java System**

The following figure shows an MSCS configuration, where the non-SPOFs components (primary application server instance, additional application server instance) are installed on separate hosts that are not part of the MS cluster.
**Figure 14: Java System**

![Diagram of SAP System Components in Two MSCS Clusters](image)

**SAP System Components in Two MSCS Clusters**

Besides installing your SAP system in one MSCS cluster, you can also set up two MSCS clusters and distribute the SPOF system components on these clusters to protect them against system failure. The following figure shows an example where the database instance for the SAP system is installed in one MSCS cluster, and the (A)SCS instance is installed on the second MSCS cluster. The application servers (primary application server instance, additional application server instance) can either be installed on a local disk on the MSCS nodes or on separate hosts that are not part of the MS cluster.
8.1.1.2 Enqueue Replication Server in an MSCS Configuration

The enqueue replication server contains a replica of the lock table (replication table) and is an essential component in a high-availability setup. It is required for a Java system, but also strongly recommended for an ABAP system.

You have to install the enqueue replication server on the two MSCS nodes where the (A)SCS instance is installed and configured to run, even if you have more than two MSCS nodes. In normal operation the replication enqueue server is always active on the host where the (A)SCS instance is not running.

If an enqueue server in an MSCS cluster with two nodes fails on the first MSCS node, the enqueue server on the additional MSCS node is started. It retrieves the data from the replication table on that node and writes it in its lock table. The enqueue replication server on the second MSCS node then becomes inactive. If the first MSCS node is available again, the enqueue replication server on the second MSCS node becomes active again.

The following figure shows the enqueue replication server mechanism in an MSCS configuration with two nodes:
8.1 Planning

Figure 16: Enqueue Replication Server Mechanism in One MSCS Cluster with Two Nodes

8.1.2 Distribution of SAP System Components to Disks for MSCS

One of the central points to keep in mind when planning the MSCS installation is that the cluster hardware has two different sets of disks:

- Local disks that are connected directly to the MSCS node(s)
- Shared disks that can be accessed by all MSCS nodes via a shared interconnect

**Note**

Shared disk is a synonym for the MSCS resource of *Resource type Physical disk.*

You need to install the SAP system components in both the following ways:

- Separately on all MSCS nodes to use the local storage on each node.
- On the shared storage that is used in common by all MSCS nodes.
  
  You install the following on **different** shared disks:
  
  - Database data files
  - SAP system executables
  - Single quorum device, if used

With Windows Server 2003, you can now choose between the following cluster models:
8.1 Planning

- **Single Quorum Device Cluster**
  In this cluster model the quorum resource maintains the cluster configuration data on a single cluster storage device.
  The quorum resource is unique to a cluster installation and is always owned by one of the nodes.
  It has the following main functions in the cluster:
  - It logs changes to the cluster configuration that are entered in the Registry.
  - It arbitrates between competing nodes when the communication between nodes breaks down.
  This means that cluster resources are forced to fail over to the node that owns the quorum resource.

- **Majority Node Set Cluster**
  In this new cluster model, each node maintains its own copy of the cluster configuration data.
  The Majority Node Set resource, acting as the Quorum Resource, ensures that the cluster configuration data is kept consistent across the different nodes.
  You can use majority node set for geographically dispersed cluster configuration.
  SAP supports Majority Node Set Cluster if it is part of a cluster solution offered by your Original Equipment Manufacturer (OEM), or Independent Hardware Vendor (IHV).

The following figure show a cluster configuration, where the (A)SCS and DB instance are installed in the same cluster. It illustrates how to distribute the database data files, the SAP system executables, and the quorum resource (if used) to different disks. Only with this distribution of files to distinct disks is it possible to move the SAP system and database as separate entities in a failover situation.

**Figure 17:**
Note
The following software on the local disks must have the same drive letter and path on both nodes:
- Instance-independent program software
- Instance-dependent software

Distribution of Database Files in a RAID Configuration

Caution
Microsoft does not support a Windows operating system-based RAID configuration (Dynamic Disks).

The following figure shows a secure method to distribute the database directories to different RAID volumes.

Figure 18:

**Database RAID Volumes**

Database Mirroring

- RAID 5
- RAID 0

Hardware Mirroring

- RAID 5
- RAID 1

More Information

*Directories in an MSCS Configuration [page 121]*

### 8.1.3 Directories in an MSCS Configuration

The following tables show the directories where the main software components for the SAP cluster installation are stored:
Directories on Local Disks on MSCS Nodes

<table>
<thead>
<tr>
<th>Component</th>
<th>Default Directory</th>
</tr>
</thead>
<tbody>
<tr>
<td>A supported operating system [page 38]</td>
<td>%windir%</td>
</tr>
<tr>
<td>MSCS software</td>
<td>%windir%\Cluster</td>
</tr>
<tr>
<td>SAP cluster files</td>
<td>%windir%\SAPCluster</td>
</tr>
<tr>
<td>Application server (if installed locally)</td>
<td>&lt;local_drive&gt;:\usr\sap&lt;SAPSID&gt;&lt;Instance&gt;</td>
</tr>
<tr>
<td>MaxDB instance-independent programs</td>
<td>&lt;drive&gt;:\sapdb\program</td>
</tr>
<tr>
<td>MaxDB instance-dependent software</td>
<td>&lt;drive&gt;:\sapdb&lt;DBSID&gt;\db</td>
</tr>
</tbody>
</table>

Directories on Shared Disks

<table>
<thead>
<tr>
<th>Component</th>
<th>Default Directory</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cluster quorum resource (if used)</td>
<td>&lt;drive&gt;:\MSCS</td>
</tr>
<tr>
<td>SAP global and instance directories</td>
<td>&lt;drive&gt;:\usr\sap ...</td>
</tr>
<tr>
<td>MaxDB data volumes</td>
<td>&lt;drive&gt;:\sapdb&lt;SAPSID&gt;\sapdata...</td>
</tr>
<tr>
<td>MaxDB database log volumes</td>
<td>&lt;drive&gt;:\sapdb&lt;SAPSID&gt;\saplog...</td>
</tr>
<tr>
<td>MaxDB mirrored database log volumes</td>
<td>&lt;drive&gt;:\sapdb&lt;SAPSID&gt;\saplog...</td>
</tr>
<tr>
<td>MaxDB instance-independent data</td>
<td>&lt;drive&gt;:\sapdb\data</td>
</tr>
</tbody>
</table>

SapCluster Directory

In an SAP cluster installation, an additional directory – `%WINDIR%\SapCluster` – is created under the system directory.

This contains all the SAP files required by all MSCS cluster nodes, independently of the MSCS node the SAP instance is running on. The files are database tools and program files (executables) used by the operating system monitor (SAPOsCol).

The directory is added to the path variable of the user `<sapid>adm`.

### 8.1.4 IP Addresses in an MSCS Configuration

A part of the installation process that is unique to MSCS is the configuration of host names and IP addresses in the network. This is a particularly important task because the addressing plays a key role in the switchover procedure. Addressing must be set up correctly so that the system can take advantage of the cluster functionality and switch between nodes when hardware problems arise.

This section explains the different types of IP addresses and their function in the switchover mechanism of one MSCS cluster with two MSCS nodes.
Types of IP Addresses
In a correctly configured cluster with two nodes, there are seven IP addresses and corresponding host names for your SAP system.
You have two IP addresses for each MSCS node, one IP address for the cluster, one address for the SAP cluster group and one for the database cluster group.
Some of the addresses are assigned to the network adapters (cards), others are virtual IP addresses that are assigned to the cluster groups.

Physical IP Addresses Assigned to Network Adapters
An MSCS configuration usually has two networks:

- A public network that is used for the communication between the primary application server, additional application servers and the LAN.
- A private network that is used internally for communication between the nodes of the cluster.

Note
For more information on network configuration, see also the Microsoft Knowledge Base Article 259267.

The following figure shows an MSCS cluster with two nodes and illustrates the adapters required for the public and private networks, and their corresponding physical IP addresses. A physical IP address, as opposed to a virtual one, is stationary and permanently mapped to the same adapter.
Host Names Assigned to Network Adapters

Each of the physical IP addresses of the network adapters must have a corresponding host name. For example, on the left-hand node in the figure above, you might assign the IP addresses of the public and private network adapters as follows:

<table>
<thead>
<tr>
<th>Network Adapter</th>
<th>IP Address</th>
<th>Host Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adapter 1 (private network)</td>
<td>10.1.1.1</td>
<td>clusA_priv</td>
</tr>
<tr>
<td>Adapter 3 (public network)</td>
<td>129.20.5.1</td>
<td>clusA</td>
</tr>
</tbody>
</table>

Caution

- The IP address and host name of the public network adapter is also the IP address and name of the machine. In our example, this means that the machine that is the MSCS node on the left in the figure has the name clus1.
- Do not confuse the host name with the computer name. Each node also has a computer name, which is often the same as the host name.

The computer name is displayed in the node column of the Cluster Administrator. However, it is not required for the TCP/IP communication in the cluster. When you configure IP addresses and corresponding names, keep in mind that it is the host names that are important for the
cluster, not the computer names.

**Virtual IP Addresses Assigned to Cluster Groups**

When you have installed the SAP system and fully configured the cluster, the critical system resources are bound together in three different **groups**. Each of these groups requires a virtual IP address and host name that is permanently mapped to the group and not to a particular node. This has the advantage that, whenever a group is moved between nodes, its IP address and host name move together with it.

An MSCS configuration has the following groups:

- SAP cluster group for each clustered SAP system
- Database cluster group for each clustered SAP system
- Cluster group

Each group consists of a set of related resources that work together to offer a service to the system. For example, the database cluster group comprises all the resources that enable the database server to fulfill the requests of a client. When the group is moved from one node to the other, due to node failure, the virtual IP address and host name move with it. Therefore, there is a failover not only of resources, but also of the virtual IP address and host name. As a result, all clients can still reach the database server with the same IP address as before.

The following figure illustrates how the virtual IP addresses of the database group and SAP group can move from one node to the other when failover occurs.

**Figure 20: Failover of Virtual IP Addresses**

![Diagram of Virtual IP Addresses](image-url)
8.1.5 Obtaining IP Addresses for MSCS

You need to correctly configure IP addresses for a cluster system. During the installation procedure you have to assign at least seven IP addresses and host names. You normally obtain these names and addresses from the system administrator.

**Prerequisites**

- If you are installing Windows for the first time on your system, follow the procedure *Obtaining IP Addresses* below.
- If Windows has already been installed on your system, the host names and IP addresses of the network adapters (cards) have already been defined and exist in your system. This means that you can find out the IP addresses for the network adapters using the procedure *Determining Existing IP Addresses* below.
  However, you still need to use the table *Virtual IP Addresses* in the procedure *Obtaining IP Addresses*.

**Obtaining IP Addresses**

Ask the system administrator to give you the addresses and host names listed in the tables below, which shows an example for a configuration with one MSCS cluster with two nodes. You will need to enter the addresses and host names later during the installation process. The column *Defined During* indicates at which stage of the installation the addresses are defined in the system.

![Caution]

Use the names **exactly** as specified by the system administrator, carefully observing uppercase and lowercase letters.

**Physical IP Addresses**

<table>
<thead>
<tr>
<th>Component</th>
<th>Example for Physical IP Address</th>
<th>Example for Physical Host Name</th>
<th>Purpose</th>
<th>Defined During</th>
</tr>
</thead>
<tbody>
<tr>
<td>First MSCS Node: adapter for private network</td>
<td>10.1.1.1</td>
<td>clusA_priv</td>
<td>Address for inter-node communication on the private network</td>
<td>Windows installation</td>
</tr>
<tr>
<td>First MSCS Node: adapter for public network</td>
<td>129.20.5.1</td>
<td>clusA</td>
<td>Address of the first MSCS node for communication with application servers and LAN (this is the same as the address of the first MSCS node)</td>
<td>Windows installation</td>
</tr>
</tbody>
</table>
High Availability with Microsoft Cluster Service

8.1 Planning

### Component Example for Physical IP Address  Example for Physical Host Name  Purpose  Defined During

| Additional MSCS Node: adapter for private network | 10.1.1.2 | clusB_priv | Address for inter-node communication on the private network | Windows installation |
| Additional MSCS Node: adapter for public network | 129.20.5.2 | clusB | Address of the additional MSCS node for communication with application servers and LAN (this is the same as the address of the additional MSCS node) | Windows installation |

### Virtual IP Addresses

| Component  Example for Virtual IP Address  Example for Host Name  Purpose  Defined During |
|-----------|-----------------|-----------------|-----------------|-----------------|
| Cluster group  129.20.5.3  clusgrp | Virtual address and name of the cluster group. It identifies the cluster and is used for administration purposes. | MSCS software installation |
| SAP cluster group  129.20.5.4  sapgrp | Virtual address and name for accessing the group of SAP resources, regardless of the node it is running on | Configuration of SAP system for MSCS with SAPinst on the first node |
| Database cluster group  129.20.5.5  dbgrp | Virtual address and name for accessing the group of database resources, regardless of the node it is running on | Execution of MSCS wizard or database-specific cluster scripts |

### Determining Existing IP Addresses

To find out the existing IP addresses and corresponding host names and addresses, proceed as follows:

1. Choose **Start → Settings → Network and dial-up Connections.**
The *Network and dial-up Connections* window appears
2. Select one of the network cards that are displayed and choose » File » Properties. 
   A dialog box opens.
   The TCP/IP Properties dialog box appears and shows the IP address of the initially selected network card.
4. To find out the host name that is mapped to the IP address, use the `ping` command:
   ```
   ping -a <IP_Address>
   ```
   The system returns the host name assigned to the IP address.
   Do not forget to `ping` your local machine as well.
5. Repeat these steps for the other network cards.

For more information about IP addresses in the cluster environment, see *IP Addresses in an MSCS Configuration* [page 122].

### 8.2 Preparation

For the installation of a high-availability system with Microsoft Cluster Service (MSCS), you have to perform the same general preparations as for a distributed system [page 25]. In addition, you have to perform the following MSCS-specific preparation tasks:

1. **On all MSCS nodes, you manually assign drive letters to the shared disks** [page 128] using the Windows Disk Administrator. All MSCS nodes must access the shared disks with the same drive letters.
2. **You map the IP addresses to host names** [page 129] on the Domain Name System (DNS) Server or in the `hosts` file.
3. **You check the mapping of host names for MSCS** [page 130].
4. Having finished all MSCS-specific preparations, continue with the *installation tasks for MSCS* [page 131].

**Note**

To make sure that all preparation steps have been correctly performed, check that you can move the disk resources from one MSCS node to another so that they are only accessible from a single node at any time.

### 8.2.1 Assigning Drive Letters for MSCS

We recommend that you assign drive letters for MSCS.
In an MSCS cluster, the shared disks that can be accessed by all nodes via a common bus must be addressed by all nodes with the same drive letters.
**Procedure**

2. Select a disk and choose Action > All tasks > Change drive.
3. Enter a new drive letter.

### 8.2.2 Mapping Host Names to IP Addresses for MSCS

To enable correct operation of the failover mechanism, you have to map all IP addresses in the MSCS cluster to host names.

The mapping enables the system to translate host names into IP addresses. Host names are normally used for administrative tasks because they are easier to use than the long, numeric IP addresses. However, the system can only respond to host names if they are translated into IP addresses.

**Prerequisites**

- You have installed the Windows operating system.
- You have the list of IP addresses [page 126].
- You have correctly entered all seven IP addresses required for the MSCS configuration.

⚠️ **Caution**

Missing or incorrect entries for the IP addresses can cause problems later during the installation.

**Procedure**

To map the host names to the IP addresses, do one of the following:

- Map the host names to IP addresses on a Domain Name System (DNS) server.
- Map the IP addresses in the Windows hosts file.
  
  The file is located in the default Windows directory:
  
  ```
  %SystemRoot%\drive\system32\drivers\etc
  ```

⚠️ **Recommendation**

We recommend that you perform the mapping on the DNS server because this only requires a single entry.

If you perform the mapping in the hosts file, you have to maintain the hosts file on all MSCS nodes of the cluster, and on all application servers and front ends, as each host in the system has its own hosts file.
8.2.3 Checking the Mapping of Host Names for MSCS

You need to check the mapping of host names to IP addresses as otherwise you might have serious problems later.

Prerequisites
You have mapped the host names to the IP addresses [page 129] on the DNS Server or in the hosts file.

Procedure
1. For each IP address enter the following commands:
   a) `ping -a <IP_Address>`
      The system returns the host name that is assigned to the IP address.
   b) `ping hostname`
      The system returns the IP address that is assigned to the host name.

   ![Note]
   - When you enter the `ping` command, you do not get a reply if the host does not yet exist.
   - If the address you are checking already exists in the system, you also receive a reply from the host. For example, after the installation of Windows and the configuration of the network, you get a reply when entering the IP addresses of the network adapters.

2. Compare the output with your own record of addresses and host names, and check for the following possible errors:
   - Incorrect output of uppercase and lowercase
     Make sure that you correct the error before you proceed with the installation.
   - Error in the network bindings
     If you enter the name of the public network adapter, which is usually also the name of the local host, and the system returns the IP address of the private network, there is an error in the network bindings.
     To correct the network bindings, do the following on all MSCS nodes:
     a) Choose ![Start] ![Settings] ![Network and Dial-up Connections]
        The Network and Dial-up Connections window appears.
     b) Choose ![Advanced] ![Advanced Settings] ![Adapters and Bindings]
        The network cards of the private and public networks are displayed for the current MSCS node.

   ![Note]
   - The card of the public network must be displayed before that of the private network. If necessary, change the order in which the cards are listed by using the Move Up and Move Down arrows
8.3 Installation

The following sections provide information about how to install the SAP system for MSCS.

Note

- Make sure that you are logged on as domain administrator, unless otherwise specified. If for any reason, you are not granted domain administrators rights, you can perform the installation as a domain user who is a member of the local administrators group. However, the domain administrator has to prepare the system appropriately for you. Do not use the user <<sapsid>>adm unless specified.
- On the first MSCS node, in the Cluster Administrator, make sure that all existing cluster groups are online.
- If you are prompted during the installation process, log off and log on again.
- When you reboot during the installation process [page 132], resources fail over to the other MSCS node(s). Therefore, pause the other MSCS node(s) before the reboot.

You have to perform the following steps:

1. In the Cluster Administrator, you move all disk groups and the cluster group to the first MSCS node [page 131].
2. You install the central services instance (SCS) on the first MSCS node [page 132] of the host where the SCS instance is to run.
3. You configure the first MSCS node [page 133].
4. You install the MaxDB database on the first MSCS node [page 134].
5. You configure the MaxDB database on the additional MSCS node [page 134].
6. You install the database instance on the first MSCS node [page 135] of the host where the database instance is to run.
7. You install the host agent on the additional MSCS node [page 135] of the host where the host agent is to run.
8. You configure the additional MSCS node [page 136].
9. If required, you install an enqueue replication server [page 137] on the host where the enqueue replication server instance is to run.
10. You install the primary application server instance [page 138] on the host where the primary application server instance host is to run.
11. You install at least one additional application server instance [page 139] on the host where the additional application server instance is to run.

8.3.1 Moving MSCS Groups

During the cluster installation you have to move the database, SAP, or disk cluster groups from one MSCS node to the other before you can continue.
3. The groups you want to move are configured and are visible in the Cluster Administrator.
For more information if you need to reboot during the installation, see Rebooting During the Installation or Conversion for MSCS [page 132].

Moving Groups with the Cluster Administrator

1. Start the Cluster Administrator with [Start] [Programs] [Administrative Tools] [Cluster Administrator].
2. In the Cluster Administrator, select the group you want to move and drag it to the required MSCS node on the left-hand pane.
3. Repeat the previous step for each group that you want to move.

8.3.2 Rebooting During the Installation or Conversion for MSCS

You only need to perform this procedure if you have to reboot during the installation or conversion for MSCS. A reboot means that resources fail over to another MSCS node. To avoid this, pause the additional MSCS node in the Cluster Administrator.

Procedure

1. Before the reboot, pause the additional MSCS node(s) in the Cluster Administrator.
2. After the reboot, activate the paused MSCS node(s) in the Cluster Administrator.
3. If you forgot to pause the MSCS node(s) before you reboot, perform the following steps:
   a) After the reboot, in the Cluster Administrator, move all resources back to the original node.
   b) Restart the Windows Server service.

8.3.3 Installing the Central Services Instance (SCS)

1. Run SAPinst [page 58] and choose [Your SAP System] [Installation Options] [High-Availability System] [Based on [technical stack]] [Central Services Instance (SCS)]
2. If you are installing the SCS instance with SAPinst for the first time and SAPinst prompts you to log off, choose OK and log on again.
3. Follow the instructions in the SAPinst dialogs and enter the required parameter values.

Note

For more information about the input parameters, position the cursor on a parameter and press F1 in SAPinst.
Caution

The SCS installation drive must be a shared disk, which belongs to the SAP cluster group.

Note

If you have an MSCS configuration with more than two MSCS nodes in one cluster, you have to install and configure the SCS instance on two nodes only. These are also the nodes where you install the enqueue replication server.

4. Check that the SCS instance is running.

8.3.4 Configuring the First MSCS Node

To configure the first MSCS node so that it functions properly in MSCS, you have to run the cluster configuration option offered by the SAPInst tool. When you run this option it:

- Creates the SAP cluster group
- Copies tools to the SAPCluster directory
- Sets the SAPService to manual

Caution

When you reboot during the conversion to MSCS [page 132], resources fail over to another MSCS node. Therefore, after each reboot you have to return the system to the state it had before the reboot.

Prerequisites

- You are logged on to the first MSCS node as domain administrator or as a local user with domain administration rights. For more information, see Performing a Domain Installation without being a Domain Administrator [page 49].
- The SCS installation drive must be online on the first MSCS node.

Procedure

1. Run SAPInst and choose ▶ <Your SAP System> ▶ Installation Options ▶ High-Availability System ▶ Based on <technical stack> ▶ First MSCS Node ▶.

Note

- If SAPInst prompts you to log off from your system, log off and log on again.

2. Enter the required parameter values.
8.3 Installation

Note
For more information about the input parameters, position the cursor on the parameter and press F1 in SAPinst.

Result
SAPinst converts the SAP instances on the first MSCS node for operation in MSCS.

8.3.5 Installing the Database on the First Node

1. Run SAPinst [page 58] and choose <Your SAP System> > SAP Systems > <Database> > High-Availability System > Based on <technical stack> > MaxDB Database Installation.
2. If you are installing the MaxDB database with SAPinst for the first time and SAPinst prompts you to log off, do the following:
   a) Choose OK and log on again.
   b) Perform step 1 above.
   c) Select Run a new installation and choose OK.
3. Follow the instructions in the SAPinst dialogs and enter the required parameter values.

Note
For more information about the input parameters, position the cursor on a parameter and press F1 in SAPinst.

Caution
Make sure that you distribute the MaxDB software and logs correctly to local and shared disks as described in Directories in an MSCS Configuration [page 121].

8.3.6 Configuring the Database on the Additional Node

Prerequisites
- The SAP database group is Online on the first MSCS node.

Procedure
Perform the following steps on the additional MSCS node.

1. On the additional MSCS node, run SAPinst [page 58] and choose <Your SAP System> > SAP Systems > <Database> > High-Availability System > Based on <technical stack> > MaxDB Database Configuration.
2. Follow the instructions in the SAPinst dialogs and enter the required parameter values.
Caution
Make sure that you distribute the MaxDB software and logs correctly to local and shared disks as described in *Directories in an MSCS Configuration* [page 121].

Note
For more information about the input parameters, position the cursor on a parameter and press the **F1** key in SAPinst.

### 8.3.7 Installing the Database Instance

**Prerequisites**
- The SAP cluster group is *Online* on the first MSCS node.

**Procedure**
Perform the following steps on the first MSCS node.

1. On the first MSCS node, run SAPinst [page 58] and choose ☑ *<Your SAP System>* ☑ *SAP Systems with <Database>* ☑ *Installation Options* ☑ *High-Availability System* ☑ *Based on <technical stack>* ☑ *Database Instance* ☑.
2. Follow the instructions in the SAPinst dialogs and enter the required parameter values.
   a) For the profile directory you have to use the UNC path of the virtual (A)SCS host name, for example:
      \<SAPGLOBALHOST>\sapmnt\<SAPSID>\SYS\profile.
   b) When SAPinst prompts you for the database host, make sure that you enter the virtual database host.

Note
For more information about the input parameters, position the cursor on a parameter and press the **F1** key in SAPinst.

### 8.3.8 Installing the Host Agent on the Additional MSCS Node

You must install the host agent on the additional MSCS node(s). SAPinst installs the host agent with the instance number **99** and the SAP system ID **SAP**.

**Procedure**

1. Run SAPinst [page 58] on the additional MSCS node and choose ☑ *<Your SAP System>* ☑ *Installation Options* ☑ *SAP Systems with <Database>* ☑ *High-Availability System* ☑ *Based on <technical stack>* ☑ *Host Agent* ☑.
2. If SAPinst prompts you to log off, choose **OK** and log on again.
3. Follow the instructions in the SAPinst dialogs and enter the required parameter values.

   Note
   For more information about the input parameters, position the cursor on a parameter and press `F1` in SAPinst.

4. For Destination Drive, select the local drive on the MSCS node.

   Note
   The screen General SAP System Parameters is not displayed if one of the following cases apply:
   - There is only one disk available
   - SAPinst then installs the host agent on the local disk.
   - The `saploc` share already exists
     `saploc` must then point to the correct local disk. If it points to the wrong disk, delete the `saploc` share with the command: `net share saploc /DELETE`

5. Start the installation.

**8.3.9 Configuring the Additional MSCS Node**

To configure the additional MSCS node(s) in the cluster, you have to run the MSCS configuration option for each additional MSCS node offered by the SAPinst tool. When you run this option it:

- Creates users and groups
- Sets the system and user environment
- Enters required port numbers in the Windows services file
- Creates the SAPService

Caution
When you reboot during the conversion to MSCS [page 132], resources fail over to another MSCS node. Therefore, after each reboot you have to return the system to the state it had before the reboot.

**Prerequisites**

- You are logged on to the additional MSCS node as domain administrator or as a local user with domain administration rights. For more information, see Performing ad Domain Installation without being a Domain Administrator [page 49].
- You have already configured the first MSCS node [page 133], which is the primary cluster node.
**Procedure**

1. Run SAPinst and choose \[ <Your SAP System> \] \[ Installation Options \] \[ SAP Systems with <Database> \] \[ High-Availability System \] \[ Based on <technical stack> \] \[ Additional MSCS Node \].

   ![Note]
   If SAPinst prompts you to log off from your system, log off and log on again.

2. Enter the required parameter values.

   ![Note]
   For more information about the input parameters, position the cursor on the parameter and press \[ F1 \] in SAPinst.

   When you have made all required entries, SAPinst begins processing and converts the SAP instances on the other MSCS node for operation in MSCS.

3. When SAPinst has finished, start the SAP cluster group SAP <SAPSID> in the Cluster Administrator with \[ Start \] \[ All Programs \] \[ Administration Tools \] \[ Cluster Administrator \].

**8.3.10 Installing an Enqueue Replication Server**

We strongly recommend to install an enqueue replication server with SAPinst on all MSCS nodes where an SCS instance is running.

![Note]
You have to perform the installation at least two times.

**Prerequisites**

- Your SCS instance is already clustered with MSCS.
- You have to install the enqueue replication server on a local disk.

**Procedure**

1. On the first MSCS node, log on as domain user who is a member of the local administrators group.
2. Run SAPinst [page 58] and choose \[ <Your SAP System> \] \[ Installation Options \] \[ High-Availability System \] \[ Based on <technical stack> \] \[ Enqueue Replication Server \].
3. Follow the instructions in the SAPinst dialogs and enter the required parameters.

   Note the following, when entering the parameters

   - On the SAPinst screen SAP Instance, enter the:
     - SAP system ID <SAPSID> of your SAP system
Instance number of the (A)SCS instance

Virtual instance host name of the (A)SCS instance

On the SAPinst screen Enqueue Replication Server Instance, enter a unique instance number that is not in use by another instance on this host.

Decide if you want to restart the (A)SCS instance and service cluster resources with SAPinst now, or later with the Cluster Administrator.

Note

You only need to do this once for all enqueue replication servers that you install on the MSCS nodes.

After you have entered all required input information, SAPinst starts the installation and displays the progress of the installation. During the process phase, the enqueue server instance is started. SAPinst installs the enqueue replication server instance on a local disk in the following directory:

```
./usr/sap/<SAPSID>/ERS<instance_number>/
```

Note

The profile is replicated from the global host to the local instance profile folder. The enqueue replication server instance uses the profile from the local instance profile folder:

```
./usr/sap/<SAPSID>/ERS<instance_number>/profile/
```

4. On the additional MSCS node, start SAPinst to install the enqueue replication server for the (A)SCS instance as described in step 2 above.

Note

There is no need to move the (A)SCS cluster group to another MSCS node.

5. Enter the required parameter values in the SAPinst dialogs as described above.

### 8.3.11 Installing the Primary Application Server Instance

The following describes how to install the primary application server instance for MSCS.

You have the following options to install the primary application server instance:

- You install the primary application server instance on an MSCS node.
  - In this case, bring the SAP cluster group online on this node, and make sure that the primary application server instance number is different from the (A)SCS instance number.
- You install the primary application server instance on a host outside of MSCS.
  - In this case, you have to install the database client software on this host.
**Procedure**

1. Run SAPInst [page 58] and choose \<Your SAP System> \Installation Options \High-Availability System \Based on \technical stack> \Primary Application Server Instance \.  
2. If SAPInst prompts you to log off, choose OK and log on again.  
3. Follow the instructions in the SAPInst dialogs and enter the required parameter values.  

**Note**

- For more information about the input parameters, position the cursor on a parameter and press F1 in SAPInst.  
- If you install the primary application server instance on an MSCS node, make sure that on the screen General SAP System Parameters for the:  
  - **Profile Directory**, you use the UNC path (not the local path) of the virtual (A)SCS host name, for example:  
    ```
    \:\\<SAPGLOBALHOST>\sapmnt\<SAPSID>\SYS\profile.
    ```  
  - **Destination Drive**, you select the local disk where you want to install the primary application server instance. Do **not** enter the shared disk for the (A)SCS instance.

**Note**

If the destination drive is not shown and you cannot select it, the *saploc* share already exists. Since you already installed the ERS instance on the local drive, and the *saploc* share points to that local drive, SAPInst automatically takes that drive as destination drive.

4. Check that the primary application server instance is running.

### 8.3.12 Installing the Additional Application Server Instance

You have to install at least one additional application server instance for MSCS.  
You have the following options to install the additional application server instance:  

- You install the additional application server instance on an MSCS node.  
  In this case, bring the SAP cluster group online on this node, and make sure that the additional application server instance number is different from the (A)SCS instance number.  
- You install the additional application server instance on a host outside of MSCS.  
  In this case, you have to install the database client software on this host.

**Procedure**

1. Run SAPInst [page 58] and choose \<Your SAP System> \Installation Tasks \SAP Systems with \Database> \High-Availability System \Based on \technical stack> \Additional Application Server Instance \.  
2. If SAPInst prompts you to log off, choose OK and log on again.
3. Follow the instructions in the SAPinst dialogs and enter the required parameter values.

Note
For more information about the input parameters, position the cursor on a parameter and press [F1] in SAPinst.

Caution
- If you install the additional application server instance on an MSCS node, make sure that on the screen General SAP System Parameters for the:
  - Profile Directory, you use the UNC path (not the local path) of the virtual (A)SCS host name, for example:
    \<SAPGLOBALHOST>\sapmnt\<SAPSID>\SYS\profile.
  - Destination Drive, you choose the local disk where you want to install the additional application server instance. Do not enter the shared disk for the (A)SCS instance.

Note
If the destination drive is not shown and you cannot select it, the saploc share already exists. Since you already installed the ERS instance on the local drive, and the saploc share points to that local drive, SAPinst automatically takes that drive as destination drive.

4. If required, install more additional application server instances outside of MSCS.

Caution
Make sure that on the screen General SAP System Parameters for the Profile Directory, you use the UNC path of the virtual (A)SCS host name, for example:
\<SAPGLOBALHOST>\sapmnt\<SAPSID>\SYS\profile.

8.4 Post-Installation

This section describes how to complete and check the installation of the SAP system for an MSCS configuration:

1. You perform the post-installation checks for the enqueue replication server [page 141].
2. You perform the general post-installation steps [page 71] listed in this guide.

Additional Information
Starting and Stopping the SAP system in an MSCS configuration [page 143].
8.4.1 Post-Installation Checks for Enqueue Replication Server

Note
Make sure that you have restarted the (A)SCS instance and service cluster resources SAP <SAPSID> <(A)SCS_instance_number> Instance and SAP <SAPSID> <(A)SCS_instance_number> Service during the installation with SAPinst or with the Cluster Administrator.

The following sections describe the tests you must perform to check whether the installed enqueue replication server works properly. For these tests you use the ENQT and ENSMON command line tools, which allow remote access to the enqueue server statistics. Before you can use these tools you must copy them to the remote host where the Enqueue Replication Server is running and from where you want to start the tests.

You perform the following steps:

1. You copy ENQT.exe and ENSMON.exe from your cluster's binary directory on the sapmnt share\\<host>\sapmnt\<SAPSID>\SYS\exe\<codepage>\<platform> to a directory on the remote host from where you run the tests.
2. You check the status of the enqueue replication server with the ENSMON tool [page 141].
3. You check the fill status and ID of the lock table during failover with the ENQT tool [page 142].

8.4.1.1 Checking the Status of the Enqueue Replication Server with ENSMON

You use the ENSMON tool to check if the enqueue replication server and the enqueue server are properly connected.

Prerequisites
- You have started the (A)SCS instance of your SAP system.
- You run the ENSMON tool from the host where you installed the Enqueue Replication Server.

Procedure
To check the status of the enqueue replication server enter the following command:
ensmon pf=<ERS_instance_profile> 2
where <ERS_instance_profile> is the profile created during the installation of the Enqueue Replication Server.

- If the enqueue replication server and the enqueue server are properly connected, the output is similar to this:
  Try to connect to host <Virtual (A)SCS host> service sapdp01 get replinfo request executed successfully
Replication is enabled in server, repl. server is connected
Replication is active

... If the enqueue replication server and the enqueue server are not properly connected, the output is similar to this:
Try to connect to host <Virtual (A)SCS host> service sapdp01 get replinfo request executed successfully
Replication is enabled in server, but no repl. server is connected

8.4.1.2 Monitoring the Lock Table During Failover with ENQT

With the following tests you monitor and check the lock table’s fill status and the lock table ID using the ENQT tool.

Prerequisites

- You have started the (A)SCS instance of your SAP system.
- You run the ENQT tool from the host where you installed the Enqueue Replication Server.

⚠️ Caution

Only use the ENQT commands stated in this procedure otherwise you might damage the enqueue server’s lock table.

Monitoring the Lock Table Fill Status During Failover with ENQT

1. Use the following command to fill the lock table of the enqueue server with 20 locks:
   
   ```
   enqt pf=<ERS_instance_profile> 11 20
   ```

   where <ERS_instance_profile> is the profile created during the installation of the Enqueue Replication Server.

2. Monitor the fill status of the lock table with the following command:
   
   ```
   enqt pf=<ERS_instance_profile> 20 1 1 9999
   ```

   This command continuously reads the content of the enqueue server’s lock table and returns the number of the table entries to the console.

3. Move the (A)SCS cluster group to another MSCS node to simulate an enqueue server failover while running the ENQT command.

   The output is similar to this:
   
   ```
   Number of selected entries: 20
   Number of selected entries: 20
   Number of selected entries: 20
   ```
4. Make sure that the lock count is **the same** before and after the failover.

**Monitoring the Lock Table ID During Failover with ENQT**

1. Monitor the lock table ID during the failover with the following command:
   ```
   for /l %i in (1,1,100000) do enqt pf=<ERS_instance_profile> 97
   ```
   where `<ERS_instance_profile>` is the profile created during the installation of the Enqueue Replication Server.

2. Move the (A)SCS cluster group to another MSCS node to simulate an enqueue server failover while running the ENQT command.
   The output is similar to this:
   ```
   (Output before failover)
   C:\WORK\HA\ENQU-Tests>enqt pf=BUG_ERS01_PCJ2EEV6 97
   ---REQ----------------------------------------------------------
   EnqId: EnqTabCreaTime/RandomNumber = 25.10.2005 11:15:59 1130231759
         / 9288
   ...
   (Output after failover)
   C:\WORK\HA\ENQU-Tests>enqt pf=BUG_ERS01_PCJ2EEV6 97
   ---REQ----------------------------------------------------------
   EnqId: EnqTabCreaTime/RandomNumber = 25.10.2005 11:15:59 1130231759
         / 9288
   ...
   ```

3. Make sure that the lock table ID (**ENQID**) is **the same** before and after the failover.

**8.4.2 Starting and Stopping the SAP System in an MSCS Configuration**

The following describes how to start or stop the SAP system in an MSCS configuration with the:
SAP MMC

Cluster Administrator

Note
- With the Cluster Administrator you can only start and stop the (A)SCS instance and the database instance.
- You also use the Cluster Administrator for all other administrative tasks like moving instances from one MSCS node to another MSCS node.

Procedure

To start or stop your SAP system with the SAP MMC, see Starting and Stopping the SAP System [page 105].

To start or stop the (A)SCS instance and the database instance with the Cluster Administrator do the following:

1. Start the Cluster Administrator by choosing Start All Programs Administrative Tools Cluster Administrator.
2. To start or stop the (A)SCS instance, right-click the instance SAP <SAPSID> <instance_no> Instance and choose Bring online or Take offline.
3. To start or stop the database instance, right-click the <database_resource> and choose Bring online or Take offline.

End of: HA (MSCS)
Disclaimer

Some components of this product are based on Java™. Any code change in these components may cause unpredictable and severe malfunctions and is therefore expressly prohibited, as is any decompilation of these components. Any Java™ Source Code delivered with this product is only to be used by SAP's Support Services and may not be modified or altered in any way.
Legal Software Terms

Terms for Included Open Source Software

This SAP software contains also the third party open source software products listed below. Note that for these third party products the following special terms and conditions shall apply.

1. This software was developed using ANTLR.

2. SAP License Agreement for STLP
   SAP License Agreement for STLP between
   SAP Aktiengesellschaft
   Systems, Applications, Products in Data Processing
   Dietmar-Hopp-Allee 16
   69190 Walldorf, Germany
   (hereinafter: SAP)
   and
   you
   (hereinafter: Customer)

   a) Subject Matter of the Agreement
      A) SAP grants Customer a non-exclusive, non-transferable, royalty-free license to use the STLPort.org C++ library
         (STLPort) and its documentation without fee.
      B) By downloading, using, or copying STLPort or any portion thereof Customer agrees to abide by the intellectual
         property laws, and to all of the terms and conditions of this Agreement.
      C) The Customer may distribute binaries compiled with STLPort (whether original or modified) without any
         royalties or restrictions.
      D) Customer shall maintain the following copyright and permissions notices on STLPort sources and its
         documentation unchanged: Copyright 2001 SAP AG
      E) The Customer may distribute original or modified STLPort sources, provided that:
         ■ The conditions indicated in the above permissions notice are met;
         ■ The following copyright notices are retained when present, and conditions provided in accompanying
           permission notices are met:
           Copyright 1994 Hewlett-Packard Company
           Copyright 1996, 97 Silicon Graphics Computer Systems Inc.
           Copyright 1997 Moscow Center for SPARC Technology.
           Copyright 1999, 2000 Boris Fomitchev
           Copyright 2001 SAP AG

      Permission to use, copy, modify, distribute and sell this software and its documentation for any purposes is
      hereby granted without fee, provided that the above copyright notice appear in all copies and that both that
      copyright notice and this permission notice appear in supporting documentation. Hewlett-Packard Company
      makes no representations about the suitability of this software for any purpose. It is provided "as is" without
      express or implied warranty.

      Permission to use, copy, modify, distribute and sell this software and its documentation for any purpose is
      hereby granted without fee, provided that the above copyright notice appear in all copies and that both that
      copyright notice and this permission notice appear in supporting documentation. Silicon Graphics makes no
      representations about the suitability of this software for any purpose. It is provided "as is" without express or
      implied warranty.

      Permission to use, copy, modify, distribute and sell this software and its documentation for any purposes is
      hereby granted without fee, provided that the above copyright notice appear in all copies and that both that
      copyright notice and this permission notice appear in supporting documentation. Moscow Center for SPARC


makes no representations about the suitability of this software for any purpose. It is provided “as is” without express or implied warranty.

Boris Fomitchev makes no representations about the suitability of this software for any purpose. This material is provided “as is”, with absolutely no warranty expressed or implied. Any use is at your own risk. Permission to use or copy this software for any purpose is hereby granted without fee, provided the above notices are retained on all copies. Permission to modify the code and to distribute modified code is granted, provided the above notices are retained, and a notice that the code was modified is included with the above copyright notice.

Permission to use, copy, modify, distribute and sell this software and its documentation for any purposes is hereby granted without fee, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting documentation. SAP makes no representations about the suitability of this software for any purpose. It is provided with a limited warranty and liability as set forth in the License Agreement distributed with this copy. SAP offers this liability and warranty obligations only towards its customers and only referring to its modifications.

b) Support and Maintenance

SAP does not provide software maintenance for the STLport. Software maintenance of the STLport therefore shall be not included.

All other services shall be charged according to the rates for services quoted in the SAP List of Prices and Conditions and shall be subject to a separate contract.

c) Exclusion of warranty

As the STLport is transferred to the Customer on a loan basis and free of charge, SAP cannot guarantee that the STLport is error-free, without material defects or suitable for a specific application under third-party rights. Technical data, sales brochures, advertising text and quality descriptions produced by SAP do not indicate any assurance of particular attributes.

d) Limited Liability

A) Irrespective of the legal reasons, SAP shall only be liable for damage, including unauthorized operation, if this (i) can be compensated under the Product Liability Act or (ii) if caused due to gross negligence or intent by SAP or (iii) if based on the failure of a guaranteed attribute.

B) If SAP is liable for gross negligence or intent caused by employees who are neither agents or managerial employees of SAP, the total liability for such damage and a maximum limit on the scope of any such damage shall depend on the extent to which its occurrence ought to have been anticipated by SAP when concluding the contract, due to the circumstances known to it at that point in time representing a typical transfer of the software.

C) In the case of Art. 4.2 above, SAP shall not be liable for indirect damage, consequential damage caused by a defect or lost profit.

D) SAP and the Customer agree that the typical foreseeable extent of damage shall under no circumstances exceed EUR 5,000.

E) The Customer shall take adequate measures for the protection of data and programs, in particular by making backup copies at the minimum intervals recommended by SAP. SAP shall not be liable for the loss of data and its recovery, notwithstanding the other limitations of the present Art. 4 if this loss could have been avoided by observing this obligation.

F) The exclusion or the limitation of claims in accordance with the present Art. 4 includes claims against employees or agents of SAP.

3. Adobe Document Services

Adobe, the Adobe logo, Acrobat, PostScript, and Reader are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries. For information on Third Party software delivered with Adobe document services and Adobe LiveCycle Designer, see SAP Note 854621.

Documentation in the SAP Service Marketplace

You can find this document at the following address: https://service.sap.com/instdguides